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Project Build & Deploy
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Enterprise Architect has been built from the ground up with the Project Manager in mind. Organizational repositories are
valuable corporate assets and must be managed and maintained accordingly. Risk can be modeled and managed in a
variety of locations, and project effort can be determined with built in support for Metrics and Estimation. Tasks can be
created and assigned to Resources performing particular roles, and these can be conveniently viewed in a built-in Gantt
Chart. There is an Audit function that allows changes to be tracked at a fine-grained level, and a Library facility and
Element Reviews and Discussions that allow users to work collaboratively on models.

Each element in Enterprise Architect has a number of default properties that are useful for project management, such as
phase, version, status, author, and creation and modified dates. Using these, coupled with the reporting engine, the
information can be extracted easily even by a novice user. The Project Manager and other users have the ability to create
elegant charts that depict the information in the repository in a compelling visual format. For example, a pie chart could
be created to show the status of stakeholder requirements for a particular phase of the project.

Facilities

Facility Detail

Metrics and Estimation Project estimation is working out how much time and effort is required to build and
deploy a solution.

Enterprise Architect provides the Use Case metrics facility as a means of:
e  Measuring the complexity of a system

e  Getting an indication of the effort required to implement the model

e  Getting an indication of the project timescale

You base these estimates on carefully-calibrated metrics.

Resource Management Resources are the people who work on a project.

You can assign roles to resources and allocate tasks on specific model elements,
which enables tracking of effort and estimation of time to complete.

Project Maintenance During a project you monitor and manage the development and progress of
individual model elements.

You can record problems, changes, issues and tasks that affect these individual
elements as they arise, and document the solution and associated details.

Similarly, Enterprise Architect helps you to manage changes and issues that apply
to the whole system.

Project Tasks and Issues In the course of a project, there are various non-technical tasks that are vital to the
successful management and completion of the project, such as meetings.

Enterprise Architect helps you to record and monitor these, and to manage
non-technical project issues as they arise.

(c) Sparx Systems 2025 Page 4 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

(c) Sparx Systems 2025 Page 5 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

Kanban Boards

Background

Kanban, which literally translates as Visual (Kan) Card (Ban) or billboard, is an operational method used to increase
efficiency. It was originally developed by the industrial engineer Taiichi Ohno while working at Toyota. Ohno analyzed
the way supermarket shelves are stocked and applied the lessons learnt to the factory floor, creating unprecedented
efficiency. The visual card (Kanban) was used to signal the need for more items to upstream suppliers on the production
line. The Kanban method can be applied to any field, including strategic planning, sales and marketing, and human skills
management, but more recently Kanban has been applied to the process of developing software-centric solutions in an
attempt to ensure that value is delivered to the customer as quickly as possible. The information technology industry has
been plagued since its beginning with projects running over schedule and over budget, but more significantly failing to
deliver value to customers in a time frame that enables them to compete and be successful. These endemic issues have
become a critical element of business in an age dominated by digital disruption and unprecedented change.

Principles

Kanban is fundamentally very simple and relies on a small number of principles, the origins of which can be attributed to
the engineers at Toyota:

e Make work visible
Traditional project management methods hide the work items from the people who carry out the work; Kanban
exposes the work to everyone, allowing any team member to contribute to the way work items flow through the
board and ultimately deliver value to the customer

Backlog Queue In Progress (4/6) Test/Review

As a Sale Representative |
want to be able to view
historical leads

As a Customer | want to be As a Warehouse Manager |
able to add new orders to
existing ones if they have not

shipped

As an Administrator | want to
be able to have a
maintenance window to

want to be able to determine
the best product location to

update online web pages and minimize picking errors
content UserStory
Defect UserStory
Jane Ward

] Devel..

Userstory
Yuki Ketabashi

S ] TestA..

Paulene Dean
EF_—— ] Busin..

e  Limit work in progress
Project Managers and team leads have traditionally been under pressure to get products finished or to include more
features, and have responded to this pressure by burdening the team with more work items; this results in lots of
focus switching and inevitably half-finished items and reduced efficiency
Paradoxically, Kanban encourages the number of items in progress to be limited, resulting in greater efficiency and
more finished items; the reduced number of in-progress items allows team members to concentrate on one thing at a
time without having to switch focus

Mame Max [tems Colar Default Unbound
Backlog 0 |:| Default W
Queue 0 |:| Default
{In Progress 5| |:| Default
Test/Review 3 |:| Default
Done 20 |:| Default
Deploy 50 |:| Default
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e Manage the flow of work
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Using traditional project management methods, bottlenecks or blockers are hard to identify and typically only
surface at the time of a post project review, often only after the product is delivered late and missing features

Using Kanban, the visibility of work and the ability to identify stalled processes - whether because of bottlenecks or
lack of work items - allows a flow problem to be identified and rectified quickly

The next diagram shows the way the Kanban facility in Enterprise Architect responds when the number of items in a
lane exceeds the number specified in the max items (Work in Progress or WIP limit) value for that lane; the header
is highlighted in a configurable color and the numbers (number of items/max items) also provide a visual cue that
will prompt the team to respond by swarming (a number of team members focusing) on the lane to reduce the

number of items
Queue

- 3
As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean
1 Busin..

As a Customer | 'want to be
ahle to view the status of my
order

UserStory

Example 1

In Progress (7/6)

iy
As a Sale Representative |
want to be able to view
historical leads

UserStory

lane Ward
""" Devel.

|
As a Reviewer | want to be
able to be able to add and edit
rules in the online grammar
checker

UserStory

Pat Taylor
[— | (++Pr..

Test/Review

k.
As a Warehouse Manager |
want to be able to determine
the best product location to
minimize picking errors

UserStory

Yuki Kotabashi
[—— ] TestA..

L

As a Customer | want to be
ahle to rent an item for a
specified duration

UserStory

Paulene Dean
=" TestA.

A high priority User Story that is at the top of the backlog could be pulled into the 'In Progress' lane and a developer
could immediately commence work on it. The work might entail the coding of business rules, the review of detailed
requirements, changes to a database schema or the addition of an element or attribute to an information schema, and the
creation of a new or updated deployment environment.

In Progress (5/6)

As A Student | want to buy
hooks at Academic Prices

UserStory

Pat Taylor

r &~

— Ca+ Pr_
L "

All of these artifacts can be found inside the same repository without the need to launch other tools or schedule meetings
to locate the needed information. The strategic drivers can be seen in the context of their business owners, architectural
design and principles can be viewed, Business Rules can be visualized in relation to the policies they qualify, a live
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connection can be made to the databases and their schemas analyzed and altered, XML schemas can be inspected and
messages constructed, programming code can be written and deployment targets detailed, and all of this achieved in a

single collaborative platform.

Rules Analyzer

This is a customer built rules engine
used to manage configuration items. It
has been extended to allow rules to be
viewed and updated through a business
web interface.

wtracen

As A Student | want to buy books
at Academic Prices -

Requirement «UserStory»
Version: 1.0 Phase: In Progress
Priority: High

A
I
I
I
wirace»
1

Student Verification E

«column»
ID: NUMBER(8,2)
INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)
STUDENT NUMBER: VARCHAR2(20)

Example 2

(I

«goal»
Provide customers with a
competitive online shopping
experience

(from Goals)

«business rule» l
Any person studying who is under
the age of 27 with student

>

identification is considered a student «enforces»
«tracen
(from SuAess Rules)
I
I
I
I
«tracen
I
I
I
I
REQ117 - The system must provide a
_____ mechanism allowing students to -
«iracen

identify themselves «trace»

(from Take Orders)

@)

This Requirements diagram shows
a User Story thathas beenadded
toa Kanban diagram expressing
the relationships to a number of
business and technical elements.

N~

wtrace»

«policy» (| ]
The book will providi

to students to encourage learning

(from Policies)

Y

* o

a7 1041AM

Name

Institution

A United States
Stanford

Harvard

Student Number

This diagram demonstrates a Backlog diagram in a two or three stage workflow. The entire diagram is used to manage
the backlog and items can be dragged within a lane to define their order in that lane, or between lanes to define their
importance and position in the backlog.
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Backlog

Eakaban Digram: "Badog

Low

As a Customer | want to be
able to read peer reviews for
items before purchasing

UserStory
Proposed
Version: 1.0 Phase: 1.0

Medium

A
Prices for some publishers do
not include internal storage

costs

Defect
Proposed
Version: 1.0 Phase: 1.0

iy
As a Warehouse Manager |
want to be able to find
unallocated space for future
dates

UserStory
Proposed
Version: 1.0 Phase: 1.0

High

.

As a Marking Manager | want
to be have a dashboard that
shows sales by demographics
and regions

UserStory
Proposed
Version: 1.0 Phase: 1.0

&

-
The default purchase date
order should be reversed in all
Product reports

Change
Proposed

2 September, 2025

Critical

As a Customer | want to be
able track my item on a map

UserStory
Proposed
Version: 1.0 Phaze: 1.0

&

As an operation manager |
want to be able find picking
errors caused by system
glitches

UserStory
Proposed
Version: 1.0 Phase: 1.0

Version: 1.0 Phase: 1.0

Flexibility

Enterprise Architect has a flexible and integrated Kanban facility built into the core product, allowing projects of any
size and vertical market to benefit from the profound efficiencies that come with this simple, elegant and lean project
management approach. Regardless of the type of process that is being used, Enterprise Architect’s Kanban features can
be quickly and seamlessly integrated into any method, creating a compelling visual solution and team collaboration
platform that will result in products, services and solutions being delivered to customers with efficiency and in record
time - delighting both product owners and customers alike.

The Kanban features in Enterprise Architect are highly configurable and can be altered to suit any team and process,
including Agile, iterative and incremental, and even waterfall projects. There is a very low barrier to adoption and teams
can commence with Kanban immediately. The most basic Kanban board consists of a diagram divided into a small
number of lanes; a range of work items can be added to the diagram, including Features, User Stories, Defects, Changes,
Use Cases, Requirements and more. Work Items can be drawn with a compelling visual style representing a colored card,
and can be dragged anywhere in the diagram to change order in a given lane, or from lane to lane progressing from left to
right through the board, representing progress towards value for the customer. The lanes are typically bound to the values
of a 'project management aware' property such as status or phase, and as the item is dragged from lane to lane the value
of the bound property is automatically changed. This facility can, however, be switched off for an individual lane by
setting the lane to "Not-Bound', so that the element property is not changed when it moves to that lane. You might set the
lane to 'Not-Bound' if, for example, the lane captures elements that have fallen out of the normal process and need to be
assessed according to the property value when the problem arose.

Resource Allocation

Any number of resources, performing specified roles, can be allocated to work items as they flow through the Kanban
board, and the progress can be visualized as one or more progress bars displayed at the bottom of the card. The allocation
is driven by Enterprise Architect's practical and simple resource allocation facility, which can be used to define the
relationship between resources (team members) and work items (cards). Any number of team members can assign
themselves to a work item, indicating the role they will perform, and the start date, finish date, and the expected time can
be used to record estimates of how long the task will take.
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In Progress (5/6)

-

L.

As a Sales Representative |
want to be able to view

historical leads
UserStory

lane Ward
= ] Devel...
Pat Taylor
— ] C++ Pr...

"

2 September, 2025

Progress can be updated as a percentage of completion, which can be displayed visually on the card. The Kanban board
(like any diagram) can also be displayed as a Gantt chart or a list view, supporting alternative project management

represe

ntations.

Resource Allocation

£ i g A e
M EE X BE @
Resource Raole Resounce: Jane Ward
éJane ‘Ward Dreveloper ) Role or Task: | Developer
Pat Taylor C++ Programmer
Drescription | History
Configuration

The Kanban cards can be configured to display an extensive set of properties, with compelling icons, colors and progress
bars to communicate the important aspects of the work item, resource allocation and work item progress. The properties

include the item name, type, status, version, priority, stereotype, phase, author and more.

In Progress (2/8)

-

As a Stock Control Manager | want to be
able to list stock levels for a selection of

titles.

Userstory
Version: 1.0

Paulene Dean

I — Business A
v

The names, colors and number of lanes can be configured, in addition to a range of other properties such as the overfill
limits, defaults and the definition of sub-lanes. The appearance of the board and the work items can all be configured,
using different colors, fonts and styles including a hand-drawn mode that might appeal to teams more accustomed to
using a physical board with colored notes. It is also possible to set the chart appearance to highlight elements that come

(c) Sparx Systems 2025
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from the same hierarchies.

Enterprise Architect has built-in Kanban diagrams, and a number of workflow Patterns that are pre-built and that can be
used 'As-Is' or configured to suit any project or initiative. The workflow Patterns define one, two or three stage
workflows; for example, the two stage workflow defines a Kanban board solely for managing the prioritization of the
backlog, and items from the backlog are then moved from the backlog Kanban to the first lane of the iteration Kanban. If
necessary, the Product Owner can use Enterprise Architect's security facility to lock the backlog Kanban, ensuring that
the order of items in the backlog is not inadvertently changed.

There are a number of commercial tools that allow Kanban to be used to manage projects visually, but Enterprise
Architect’s Kanban facility is incredibly useful because the tool is also a sophisticated modeling platform for strategic
and business analysis, architecture, design, implementation, testing and deployment. This means that work items on a
Kanban Board can be linked to strategic decisions, business rules, policies, requirements, architecture and design
elements, wireframes and UX models, programming code, database tables, procedures, tests, virtual or physical
deployment nodes, and more. For the first time everyone in the team can collaborate in the same environment using a
toolbox of facilities purpose built for their discipline, while at the same time being able to visualize and manage the value
being delivered to the customer in a visually compelling set of Kanban boards.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that can be used to create expressive charts and dashboards,
which will provide insights into the Kanban process and enable Product Owners and other team members to monitor
performance and determine ways of fine tuning how the team is working. There is a range of built-in charts including
Bar and Pie Charts, Heat Maps and more, but a team is free to create any number of user-defined charts that can be
incorporated into team processes and reviews.

dash Completed Tashks /l

Completed Tasks Last Week

Ali Evans

Alma Cogan

Billy Bunter

Bob Brown

Brett Chambers

Carlos Wallace

Carmen McRag

David Kelly
W Test
Donna Campbell B Rewark
Eric Burns B Review
Ethan Rogers l Proposal

Frank Mclver O Investigate

Josh Morgan | W Implement

Liam Cross

Nigel Moleswaorth
Pat Taylor --
Penny Dark _
Peter Ryan _
[

Philip Marlowe

0 5 10 15 20 25 30 35

Application
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The Kanban project management methodology helps you to develop a dynamic, easy-to-view progress summary of the
stages of development of a project, where the stages are represented as lanes and sub lanes of a diagram - a Kanban
Board. In Enterprise Architect, you can apply a form of this methodology to your project administration diagrams to
monitor and manage the flow of work in a particular area.

The stages of development can be defined by the value of a project management property of an element, such as Phase,
Version or Status, or a user-defined Tagged Value. The elements that represent each task or object of a task are initially
placed in the lanes for the earlier stages of the project, and work on the task is reflected by moving the corresponding
element to a different lane on the diagram. If a diagram is linked to a project management property, dragging an element
from one lane to another automatically changes the value of the property to the value that the lane represents.

In this illustration, the lanes identify what work is being performed in each stage of development.

Backlog Queue In Progress (4/6) Test/Review Done Deploy

s Stock Manager | want to be able to

New tasks will usually begin in the left-most lane, and completed tasks will usually pass through all lanes before coming
to rest in the right-most lane and then being moved off the diagram. A typical workflow is to choose the next task that
you are going to work on by starting in the right-most lane and seeing if it has any tasks that you are able to progress; if
not, move to the next lane and repeat, and so on.
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Kanban Quickstart

Create a Kanban Diagram

A Kanban diagram is a board that allows team members to visualize work items that are represented as colored cards.
The board is divided into a number of lanes and team members move the cards from left to right as work is completed
towards providing value to the customer.

You can create a Kanban diagram by taking an existing diagram and setting its Kanban properties, but it is easier to use
one of the diagram types provided by the Kanban Diagrams UML profile as a starting point and then change its
properties to suit your own project.

Step Action

1 In the Browser window, right-click on the parent Package and select the New Diagram' command. The
'Model Builder' dialog is displayed, showing the 'Diagram Builder' tab page.

2 On the 'Diagram Builder' tab page, use the = icon to select the 'Construction > Kanban' perspective.
Select 'Kanban' in the 'Select From' panel then choose one of the diagram types from the right-hand pane
(Basic, Backlog, Iteration and Complete). Give the new diagram a name in the 'Diagram' field and click
on the button 'Create Diagram'.

Madel Builder x

Package : =]
Diagram : | Project Core Auto Create Diagram Help
Kanban = Diagram Types:
fol
Select From: : :
“E'g Basic i
sl
L : Bz Backiog
(5] Kanban
F “E'g Iteration
o complete

Model Builde: Diagram Builder

3 If you cannot find 'Kanban' in the list, you must enable the Kanban MDG Technology.

Add Elements to a Kanban Diagram

Work items are represented visually on a Kanban diagram but first must be added to the diagram. They can be elements
that already exist in the repository or new elements dragged from the Kanban Toolbox pages and dropped onto the
diagram. Any element type can appear on a Kanban board but the most typical types are Features, User Stories, Defects
and Changes. Use Cases, Scenarios and Requirements are also sometimes added.

When you drop an element onto a Kanban diagram, the lane it is added to depends on whether the diagram has a property
value defined, and also whether it has a default lane. If the Kanban diagram has a property value defined and the new
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element's property matches one of the lanes, then it will be added to that lane. Otherwise, it will be moved into the
default lane, or to the right of the last lane if no default lane has been nominated.

You can define the Default lane on the 'Lanes’ page of the 'Kanban Options' dialog.

The Kanban Toolbox page will open automatically whenever you open a Kanban diagram. The Toolbox page provides a
default set of elements that you can use to represent units of work on your Kanban diagrams, but any type of element can
be added.

Step Action

1 Open your Kanban diagram. The Diagram Toolbox should appear with the Kanban page selected
automatically.

e [fthe Diagram Toolbox doesn't appear, click on the >> button in the top left corner of your diagram

e Ifthe Kanban page isn't automatically selected, click on £

dialog and specify 'Kanban'

to display the 'Find Toolbox Item'

2 Drag elements from the Kanban page onto the Kanban diagram. The page provides these element types:

Toolbox v B x

Search PP =

Elements
ﬁ Change
Defect
0 Feature
User Story

Import a Kanban Workflow Pattern

Each organization or team will typically want to define their own workflow that is appropriate for the initiatives they
work on, and each might have a number of workflows defined for different types of initiative. While this can be done
from scratch it is much easier to use one of the built-in Patterns, either 'As-Is' or as a starting point. A workflow can be
made up of any number of Kanban boards linked together into a single workflow; for example, a three stage workflow
would contain three separate boards. Each board can be configured with any number of lanes and sub-lanes representing
the stages in that part of the workflow. Team members can move Work Items between lanes in a single board and also
between the boards that make up the entire workflow.

Kanban Workflow model Patterns help you to very quickly set up a one-, two- or three-stage workflow, using and
linking the Backlog, Iteration and Complete Kanban diagrams.

Step Action
1 In the Browser window, select the Package under which to create the Workflow Pattern.

2 Click on the Browser window header and select the option 'Model Builder (pattern library)', or press
Ctrl+Shift+M. The Model Builder dialog displays.

3 Click on the Perspective button and select 'Project Management > Kanban'. The panel header changes to
'Kanban Perspective' and the panel shows the three workflow patterns you can select.

e Kanban One Stage Workflow
e Kanban Two Stage Workflow
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e Kanban Three Stage Workflow

When you click on one of the patterns, the right hand panel displays an example diagram and several
sections of useful information on using the pattern.

®5tan:Page ESpecification Manager ?EThE Game Model Wizard X 4 F

Model Patterns | Process Guidance Executable Patterns Application Patterns VEA Examples

4

Kanban Perspective

P Panand Zoom
4 Kanban Workflows The Pan and Zoom facility is one of the tools that can be used to navigate
[E] Kanban One Stage Workflow around a large diagram. Often the resolution of a diagram must be reduced to
[E] Kanban Two Stage Workflow ensure it is wholly visible but by using the Pan and Zoom window you can leave
{ [2] Kanban Three Stage Workflow . the diagram at a readable resolution and pan around to areas of interest
zooming in when necessary. For more details see the Pan and Zoom help
topic.

Diagram Legends

The Diagram Legend facility is useful for manually or automatically changing
the appearance of elements and connectors on a diagram. A legend can be
added from the Common Toolbox and configured to codify the fill and line color
and line thickness. This is a powerful way to add meaning and expression to a
diagram and is particularly expressive when applied automatically based on
element or connector properties. It can be used with a number of specialized
diagrams such as roadmaps to create a powerful visualization. For more

details see the Diagram Legends help topic.

Create Pattern(s) Add To:  Kanban for Manage Users (3| [] Customize Pattern on import

4 If you have the 'Customize Pattern on import' checkbox selected, prompts display to select the Packages to
import in the Patterns. Each Pattern contains one Package, which is automatically selected. Click on the
OK button for each Pattern.

5 Open each of the new diagrams and consider whether they fit with your own workflow preferences. The
diagrams provided can be changed to suit your style of working.

Moving Kanban Items

Work Items flow through Kanban boards typically from left to right as work is performed, moving the item closer to
delivering business value for the customer. In a one-stage workflow, work items will be moved through a series of lanes
through a single board, but in workflows that consist of more than one Kanban board the items will also jump from one
board to the next. For example, in a two stage workflow there is a backlog board and items will be prioritized in the
board based on their priority. The work items that have the highest priority in the Backlog then need to be moved to the
Iteration Board, where implementers will pull them into the In-Progress lanes.

Moving Items in a Kanban Diagram

Moving items within a Kanban diagram is simple and intuitive and can be achieved by dragging and dropping a work
item from one location to another. If an item is moved within the same lane its position is simply changed in that lane. If
an item is dragged to a different lane and the lanes are bound to an element property or user defined Tagged Value the
value of the item's property or tag will also be changed.

Step Action
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1 Select the item in the Kanban diagram.
2 Drag and drop it into a new position either in the same lane or a different lane.
Notes

When an item is moved between lanes and the lanes are bound to a property or Tagged Value, the value of the property
or Tag will be automatically changed.

Example

Backlog Queue

As a Reviewer | want fo be As a Customer | want to be able to delete
ahle to be able to add words items from my order before it is shipped

to the online dictionary
Userstory

Userstory

L A LS A

L z Q) 1

Stock levels on financial <f
reports don't include returned [z Oy
items A

Defect

Moving Items between Kanban Diagrams

Items can be moved between Kanban boards by using a drop zone positioned to the right of the diagram. Each drop zone
has the name of another diagram in the workflow, and elements on the current board can simply be moved by dragging
and dropping them on the appropriate drop zone.

To create a drop zone, simply drag the target Kanban board onto the current Kanban diagram and release the mouse
button. In response to the prompt, select the 'Drop Diagram as Diagram Reference' option. You can have more than one
drop zone, one for each of the other Kanban boards in the work flow. If you generate a set of Kanban workflow diagrams
using the Patterns in the Model Builder, the drop zones are automatically generated on each diagram.

Step Action

1 Select the item in the Kanban diagram.
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2 Drag the item to the right of the Kanban diagram Lanes.
3 Drop the item onto the zone with the name of the diagram you are moving the element(s) to.
4 Select 'Move to' to move the element to the new diagram or 'Create link on diagram' to create a link on the

second diagram without removing the element from the current diagram.

Example

In this diagram a work item representing a defect is being moved from the critical lane of a Backlog Kanban board to the
Iteration board.

High Critical
[ ‘mj
ilteration |
‘ @ | JHUHHUH R, ¢ | |
As a Marking Manager | want % As a Customer | want to be é < ] ]
to be have a dashboard that /’ able track my item on a map /’ oy ! !
shows sales by demographics g g I
and regions Z - z ; |
I I
As a Customer | want to be L J
‘ @ able to add new orders to
As a Warehouse Manager | existing ones if they have not
want to be able to find shipped
unallocated space for future
dates

Paulene Dean
E————————1 Busin..

Search for Kanban Diagrams

A well organized repository will assist in quickly locating specific Kanban diagrams, but in large and complex initiatives
it is common for some team members to need to search for Kanban Boards. Enterprise Architect has an easy-to-use yet
sophisticated search facility with a built-in search to find all Kanban diagrams in the repository. Having located a
diagram the user can continue moving objects from left to right across the board, contributing to the team's effort focused
on providing value to the customer.

Step Action

1 Select the 'Construct > Resource Management > Kanban > Find Kanban Diagram' ribbon option.

The search is immediately executed and the located diagrams are listed in the Find in Project view.

2 Double-click on any Kanban diagram that you want to open.

Layout Filter Panel

A project of any appreciable size will typically have a large number of in-flight work items, and product owners and
team members will often want to filter the selection of items based on a set of conditions, such as high priority
requirements or those applying to particular stakeholders or people. This can be achieved using filters at two levels;
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either the expedient ribbon Filter or the more sophisticated and persistent Diagram Filters facility.

Kanban diagrams with a large number of elements can be quickly filtered in real time using the Layout ribbon Filter
panel.

1. Access the Filter panel.
2. Select the Filter property and the operator (if appropriate), and specify a search term.

Mame / Alias - M

Filter

Elements not matching the specified condition will be obscured in the filtered diagram.

Backlog Queue In Progress (3/6) Test/Review

As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean

B 1 Busin..
Iy

As a Customer | want to be ,—‘_@“ ¥
able to delete items from my As a Customer | want to be As a Customer | want to be
order hefore it is shipped able to view the status of my able to rent an item for a
order specified duration
UserStory
UserStory UserStory
L J Paulene Dean

] TestA..
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Kanban Options

Enterprise Architect provides a number of options for generating a new Kanban diagram or for opening an existing
Kanban diagram. Having opened the diagram, you can define its structure, content and appearance. It is also possible to
configure a diagram of any other type to be a Kanban diagram, by simply adding Kanban properties to it. This useful
design feature means that a diagram containing, for example, a set of User Stories could simply be changed to a Kanban
diagram and the team could immediately begin using this flexible, lean, project management method.

To define the structure, content and appearance of a Kanban diagram, you use the 'Kanban' dialog.

x

Caonfi ti
mnguratien Lze thiz page to bind & K.anban to a property or tagged value [moving elements into a lane will
Sub-lanes change the property] and to create the main lanes for the diagram.
r
ppearance Froperties
Advanced o . .
Filt | Enabled Show Mares in Title Bar Swimlane width locked
ilters
Bind F.anban to: Element, Priority Read-only Bind Fill from binding
Marne rax [terns Color Default Bind to Left  Mot-Bound
Lo 0 |:| Default [«
tediurm 0 l:‘ Default
High 0 [] Defaute
Critical 0 [] Defaute
M e b odify Delate @ @
Carcel Help

When you display the 'Kanban' dialog, it defaults to the 'Configuration' page. You use this page to:

e Setup basic Kanban properties, such as whether Kanban is enabled on the diagram, if the names are shown in the
title bar of the diagram and if the width of each swimlane is locked, and

e (Create, modify and delete the primary lanes on a Kanban diagram; you can:
- Create the lanes manually, or define a property that the lanes bind to, so that the lanes
are generated automatically from that property when you click on the Fill from binding button
- Add lanes that are not bound to the property
For each lane you can define:
- The maximum number of elements that can be placed in the lane before triggering
the 'Overfilled' indicator
- The fill color of the lane
- Whether it is the default lane that new elements are added to

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram) or

(c) Sparx Systems 2025 Page 19 of 186 Created with Enterprise Architect



Project Build & Deploy

Context Menu

Configuration Options

Option
Enabled

Show Names in Title
Bar

Swimlane width locked

Bind Kanban to

Read-only Bind
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Start > Personal > My Kanban (displays personal default Kanban diagram)
Then

Design > Diagram > Manage > Kanban (on an open Kanban diagram)

In the Browser window, right-click on the diagram name | Kanban

On a diagram, right-click on the background | Kanban

Action

Select the checkbox to apply any of the Kanban functionality to the diagram. If the
checkbox is not selected, the diagram will behave as a non-Kanban diagram.

Select this checkbox to display the lane names (but not the sub-lane names) in the
diagram title bar, above the lanes. These will be visible once the lanes are defined.

When you have several elements in a column and scroll down to the lower ones, the
Lane headings disappear from view, so the names in the Title Bar continue to
identify the lane names.

Select this checkbox to prevent the lanes in the diagram from being made narrower
or wider.

Click on the l_l button and select the property to bind lanes to. This will be one
of:

e FElement, or
e Tagged Value (enumeration or string types only), or
e None (makes all lanes unbound).

If you select 'Element', also select one of the properties 'Phase’, 'Version', 'Priority’
(for Requirement-type elements), 'Status' or 'Author’.

If you select 'Tagged Value', also choose to either 'Create' a new tag (and simply
type in the name) or 'Select' an existing one.

In the latter case, the 'Kanban Tagged Value selection' dialog displays, on which
you click on the appropriate radio button to select either from a list of 'Global
Tagged Values', or from a list of 'Tagged Values from a selected element'. Click on
the Select Element button to browse for the element anywhere in the model.

The Global Tagged Values or those from the element are provided to the 'Tagged
Value' field. Click on the drop-down arrow on the right of the field and select the
reference Tagged Value from those listed. Click on the OK button.

The 'Bind Kanban to' field now displays either the element property or the Tagged
Value you have selected.

When you move an element between two 'Bound' lanes, a pop-up prompt displays
for you to confirm the move. Click on the prompt to make the move, or click
elsewhere on the diagram to abort the move. This prevents users from moving
elements between lanes by accident.

Select this checkbox to make the effects of binding Kanban lanes read-only. This
means a user can move elements between lanes and make various element
formatting changes, but the bound property value is not updated and the element
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position is not captured. If another user views the diagram, or the first user closes
the diagram and it is subsequently re-opened, the moved elements are in their
original positions.

Fill from binding
If you have chosen an element property to bind the Kanban lanes to, click on the

Fill from binding button to fill the lane list with existing values of that property.
This will delete all old lanes before creating a new lane for each of the new values.
Once the lanes have been created in this way, they can be renamed, reordered and
added to.

Name
The name of each lane can be filled automatically using the Fill from binding

button. You can overtype the names; these do not have to be unique but they cannot
be blank.

Max Items
You can set the maximum number of elements that can be placed in each lane. If

someone tries to move an element into a lane that has reached or exceeded its
maximum number, the heading of the lane will be displayed in the 'Overfilled' color
you define and enable on the 'Appearance' page. This gives a visual indication that
action might have to be taken to clear what appears to be a bottleneck in the
workflow process.

Color
Several or all of the lanes can have the same fill color, or you can set a different

color for each lane independent of the other lanes. Either:

e Leave the 'Color' value set to 'Default’ (set on the 'Preferences' dialog,
'Gradients and Background' page), or

e  Opvertype 'Default' with the hex code number for the required color, or
e  Click on the drop-down arrow and select a color from the displayed palette
The actual color is shown in the box at the left of the field.

Default
You can nominate one of your lanes as the default; that is, the lane does not assign

a bound property value to the lane title, and therefore can be filled with varied
elements such as those added to the chart by a Kanban search. So if you had three
lanes bound on the status values 'In Testing', 'Pass' and 'Fail', for instance, with the
'In Testing' lane being the default lane, and you added an element that had the status
of Not Run', it would be placed into the 'In Testing' lane instead of being placed out
on the right hand edge of the diagram past all the lanes.

You can only select one 'Default' checkbox; clicking on one checkbox clears any
previously-selected checkbox.

Bind to Left
The 'Bind to Left' property essentially makes a primary lane the same as a sub-lane.

Moving an element into a 'Bind to Left' lane will set the element's bound property
to the left-most bound lane. Consider a 'Phase' Kanban diagram with these lanes, in
order:

e To Do (Default, Not Bound)
e Implement (Bound)

e To Do (Bind to Left)

e Review (Bound)

e To Do (Bind to Left)

e Deploy (Bound)

Newly added elements will be added to the left-most "To Do' lane with whatever
priority value they previously had. Moving them to the 'Implement' lane will then
set the phase to 'Tmplement'. When the implementation is complete, the element can
be moved to the 'To Do’ lane before 'Review' without updating the element's phase
until it is moved into the 'Review' lane.
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Not-Bound
Select the checkbox to set the property binding to 'Not Bound' for the lane, so that
the element property is not changed when the element moves into that lane. You
might set the lane to 'Not-Bound' if, for example, the lane captures elements that
have fallen out of the normal process and need to be assessed according to the
property value when the problem arose. The lane has a property value, but it is not
applied to the element.

Click on this button to define a new lane on the Kanban diagram.

Modify
Click on a line in the 'Lanes' list and click on this button to position the cursor in
the 'Name' field in update mode, and to highlight the lane you are modifying to
make it easier to focus on the fields you might change.

Delete
Click on a line in the 'Lanes' list and click on this button to delete the lane.

Click on an entry in the 'Lanes' list and click on this button to move the entry one
line up in the list, and one lane to the left on the diagram.

=

Click on an entry in the 'Lanes' list and click on this button to move the entry one
line down in the list, and one lane to the right on the diagram.

=

Notes

e The elements in a Kanban diagram individually represent work in progress; you cannot create connectors between
elements on the diagram

e Ifyou apply a Kanban definition to a current diagram, all connectors on the diagram are hidden; when you
de-activate the definition, the connectors are shown again

e When you first set up a Kanban diagram, any element on the diagram that does not have one of the defined property
values is moved to the right-hand side of the diagram

e Moving an element into a lane automatically sets the appropriate property of that element to the value represented by
the lane; for a Tagged Value, if the element does not have that tag, adding the element to the lane adds the tag and
sets it to the lane value

e FElements on a Kanban diagram are automatically adjusted to match the width of the lane they are in, both when the
element is moved into a lane and when the lane width is changed

e  Certain types of element are automatically excluded from a Kanban diagram search; these are:
- Constraint
- Port
- ProvidedInterface
- RequiredInterface
- Boundary
- Hyperlink
- State Node (such as Choice and Junction)
- Text
- Win32
- Wireframing
- Package
- Diagram Frame
- Activity Region
- Sequence Element
- Note
- Standard Chart
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- Model View
- Time Series Chart
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Kanban Options - Sub-Lanes

Sub-lanes are a useful device for defining another level in the workflow; for example, you might want to divide the
'In-Progress' lane into a number of sub-lanes representing the individual developers, or any lane into 'In-Progress' and
'Complete'. The 'Sub-lanes' page helps you to quickly and easily create any number of new sub-lanes for a Kanban
diagram.

E Kanban

Use this page to create sub-lanes for the diagram.
Sub-lanes can be added to the parent lanes once created by checking the appropriate
checkbox.
Check all Uncheck all
Name To Do In Progress Review Done
Bruce L
Selina hal
New Modify Delete A B
Access
Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram) or
Start > Personal > My Kanban (displays personal default Kanban diagram)
Then
Design > Diagram > Manage > Kanban > Sub-lanes (on an open Kanban diagram)
Context Menu In the Browser window, right-click on the diagram name | Kanban >Sub-lanes, or
On a Kanban diagram, either:
e Double-click on a lane > Sub-lanes
e Right-click on background | Kanban > Sub-lanes

Creating Sub-Lanes
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You add sub-lanes simply by clicking on the New button and, in the 'Name' column, typing the sub-lane name.
Alternatively, you can leave the default string '<anonymous>' to create an un-named sub-lane, which can be useful for
organizing lanes that have lots of elements. The names of the lanes on the diagram are then automatically added across
the panel.

Once you have created sub-lanes, you apply each one to one or more parent lanes, by selecting the checkbox under the
name of each lane that is to contain the sub-lane. To assign every sub-lane to every lane, you can click on the Check all
button, and to clear this total assignment click on the Uncheck all button. You can also change the order of the sub-lanes
across all their parent lanes in the Kanban diagram, by clicking on the sub-lane names and on the up-hand and
down-hand buttons.

Within a specific parent lane column you can apply custom sorting to the sub-lanes, so that the sub-lanes in that lane are
in a different sequence to the same sub-lanes in a different lane. For a column that has assigned sub-lanes (that is, it
contains selected checkboxes) right-click on the header and select the 'Set lane order' option. A small dialog displays, in
which you click on the sub-lane names and use the up-hand and down-hand buttons to put them in the required sequence.
Click on the OK button to clear the dialog and apply the sub-lane. If a sub-lane order has been customized, you can
return it to the 'across-the-board' order by right-clicking the header again and selecting the 'Reset lane order' option.

Notes

e  Sub-lanes are not backwards compatible with earlier releases of Enterprise Architect; if you open a Kanban diagram
containing sub-lanes in a release of the system earlier than Release 12.1, the sub-lanes will be permanently deleted
from the diagram

e Elements on a Kanban diagram are automatically adjusted to match the width of the sub-lane they are in, both when
the element is moved into a sub-lane and when the sub-lane width is changed
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Kanban Options - Appearance

Using the 'Appearance' page, you can set the Kanban diagram appearance options, such as the line and font colors and
use of the Hand Drawn mode.

i+ Configuration
Sub-lanes
i~ Advanced Line Color: 1~ Hide Names
- Filters
Font Color: I - || A Bold Font
Title Color: O Default - Hand Drawn
Overfilled Color: |0 Default = Enable Overfill Highlight
Underfill Color: O Default - Enable Underfill Highli...
Line Width: 1 - Highlight Hierarc...
Vertical Spacing:  Medijum -
+| Use Kanban drawing style Native Element Draw Sty...
L Type Stereotype
Status Phase
Version il Author
Pricrity Truncate name
Bold name b Icon
Notes Checkboxes
Capitalize Name Tagged Values
hs Shadows

Objects on a Kanban diagram are, by default, drawn using the Info View style.

g [T
Location 1 NPC design

Task
Version: 1.0

\. o

This style displays an icon on the top right corner of the element, representing the element type, with a triangular icon to
the left of it representing the priority - red for High priority, and yellow for Medium priority. No icon shows for Low
priority. The Priority, as for various other element properties, is also represented by a line of text in the body of the
element. You can specify which properties are shown by selecting the appropriate checkbox from the list at the bottom of
the 'Appearance’ page.

Access

Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram) or

Start > Personal > My Kanban (displays personal default Kanban diagram)
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Appearance Options

Option

Line Color

Font Color

Title Color

Overfilled Color

Underfill Color
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Then

Design > Diagram > Manage > Kanban > Appearance (on an open Kanban
diagram)

In the Browser window, right-click on the diagram name | Kanban > Appearance,
or

On a Kanban diagram, either:
e Double-click on a lane > Appearance

e Right-click on background | Kanban > Appearance

Action

Click on the drop-down arrow and select the color in which to display lane borders.
This color does not apply to sub lane borders, which are automatically set to a pale
or dark color to contrast with the lane fill color.

If the color you require is not shown, click on the More colors button and either
select from a wider range of standard colors or define a custom color.

The border style is automatically set to the 'chiseled' effect to give the appearance
of 3D blocks on a background, the color of the background being the line color. The
effect is more obvious if you set the line to a pale color and not black.

Click on the drop-down arrow and select the color in which to display the text in
the Kanban lane and sub lane headings.

If the color you require is not shown, click on the More Colors button and either
select from a wider range of standard colors or define a custom color.

Click on this button to display the 'Font' dialog, through which you define the font
and the style, size and effects of the text in the Kanban lane and sub lane headings.

If you also change the text color here, it overrides the setting of the 'Font Color’
field.

Click on the drop-down arrow and select the color to use across the lane heading
cells (separate from the fill colors you can apply individually to each of the lanes
themselves).

If the color you require is not shown, click on the More Colors button and either
select from a wider range of standard colors or define a custom color.

Click on the drop-down arrow and select the color with which to fill a lane heading
cell if the lane contains more than the maximum number of elements. You set the
maximum number of elements when you define the lanes to work with, in the
'Lanes' page.

If the color you require is not shown, click on the More colors button and either
select from a wider range of standard colors or define a custom color.

Click on the drop-down arrow and select the color with which to fill a lane heading
cell if the column contains fewer than the maximum number of elements, in other
words there is available capacity. You set the maximum number of elements when
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Vertical Spacing

Hide Names

Bold Font

Hand Drawn

Enable Overfill Highlight

Enable Underfill Highlight

Highlight Hierarchies

Use Kanban drawing style
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you define the lanes to work with, in the 'Lanes' page.

If the color you require is not shown, click on the More Colors button and either
select from a wider range of standard colors or define a custom color.

Click on the drop-down arrow and select the line width of the Kanban lane borders
- either 1 (thinnest), 2 or 3 (thickest).

Set this to 'Small', 'Medium' or 'Large' to define the degree of vertical separation
between elements in a Kanban lane.

Select this checkbox to hide the lane names and the column heading cells.

Select this checkbox to display the lane headings in bold (if their font definition
does not already set them to bold).

Select this checkbox to display the Kanban lanes and the elements on the diagram
in 'Hand-drawn' mode.

Select this checkbox to apply the 'overfilled' color to the lane header cell if it
contains more elements than the defined maximum number (see New).

Select this checkbox to apply the 'underfilled' color to the lane header cell if the
lane contains fewer elements than the defined maximum number; that is, if it has
any spare capacity.

Select this checkbox to highlight elements on the Kanban diagram that are part of
the same hierarchy, by drawing a colored rectangle behind each element. If there
are elements from two or more hierarchies on the same diagram, each hierarchy is
represented by background rectangles of a different color to the others. In this
illustration, Class 1 and Class 2 are both in one hierarchy, and Class 5 and Class 6
are both in a second hierarchy.

Approved Implemented

Classi Class1

Approved Implemented

Class2 Class5

Approved Implemented

Select this option if you want to apply the Kanban style to the elements on this
Kanban diagram. Also, select the checkbox against each element property or
characteristic to be shown in the elements:

e Type - displays the element type
e  Status - displays the element status

e  Version - displays the element version
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e  Priority - displays the element priority

e Bold name - displays the element name in bold

e Notes - displays element notes in the elements on the Kanban diagram

e (Capitalize Name - displays element names in capitals on the Kanban diagram

e Shadows - displays a shadow on the right and bottom edges of each element on
the diagram; this effect is not affected by the 'Element Shadows On' option on
the 'Preferences' dialog

e Stereotype - displays the element stereotype
e  Phase - displays the element phase
e  Author - displays the name of the element's author

e Truncate name - cuts off the element name as it approaches the element border,
instead of allowing it to wrap around

e Icon - selected by default; deselecting this checkbox hides the Type and
Priority icons in the top right corner of the element

e Checkboxes - when Checklist elements are displayed on the Kanban diagram,
shows the Checklist checkboxes and items; Checklist Artifacts can be bound to
Priority on a Kanban diagram, and this option makes it easy to view any
Checklists organized by Priority

e Tagged Values - shows the Tagged Values of each element on the diagram, in
an element compartment

The property checkboxes are directly linked to the 'Use Kanban drawing style'
option. If you do not select the option, the element on the Kanban diagram has a
more basic appearance with no properties shown other than the author and element

names.
Alfred
Location 1 NPC design
Native Element drawing Select this option to render the elements on the Kanban diagram in their native,
style rectangular notation style, displaying any compartments the elements might have.

The Resources compartment is particularly useful for Kanban elements, if
compartments are to be shown. This compartment lists allocated resources,
including those that are 100% complete.

Note that the element width is limited by the width of the lane the element is in, so
features in compartments might be shown truncated.

Notes

e  All elements added to a Kanban diagram initially have the same height and spacing, but the height can change as
displayable information is added to an element

e In a Kanban diagram, the normal element appearance option is not operational; only the Kanban appearance options
take effect
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Kanban Options - Advanced

If you do not want to manually add elements to a Kanban diagram, you can use the 'Advanced' page to set up either
Package searches or SQL searches to automatically fill the diagram. It is not possible to use both a Package search and a
custom SQL search at the same time; if both are specified, the Package search is ignored.

Configuration
i Sub-lanes

Select how you would like to fill this Kanban diagram (leave blank to manually add Synch with search
-~ Appearance elements)

- Advanced Auto fill

Filters Select Auto fill to automatically fill the diagram when loaded. You can also select

Synch with search to remove elements from the diagram that no longer meet the
search criteria. Run Search

Package Custom SOL

Remaove Add

Source Details Include Child Packages

0K Cancel Help

The dialog automatically opens at the 'Package' tab. If you want to create a SQL Search, click on the 'Custom SQL' tab.

Access
Ribbon Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram) or
Start > Personal > My Kanban (displays personal default Kanban diagram)
Then
Design > Diagram > Manage > Kanban > Advanced (on an open Kanban diagram)
Context Menu In the Browser window, click on the diagram name | Kanban > Advanced, or

On a Kanban diagram, either:
e Double-click on a lane > Advanced

e Right-click on the diagram background | Kanban > Advanced

Kanban Options - Advanced

To fill a diagram based on a Package, simply click on the Add button and the 'Add Package' option, then select the
required Package or Packages from the 'Select a Package' browser.

If you want to include elements from child Packages, select the 'Include Child Packages' checkbox against each Package
in the list. Click on the Run Search button. This will automatically add elements, based on the search. The search is

additive (unless 'Synch with search' is selected) and will only add elements not currently on the diagram. You can refine
the Package search by creating it on the 'Filters' page and adding filters (see the Kanban Diagram Options - Filters Help
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topic).

To fill the diagram from the results of a custom SQL search, click on the 'Custom SQL' tab and type or paste the

appropriate SQL. In order for the diagram to be filled, you must include in the SQL Select statement:
Object ID as Element_ID

For example:

Select Object ID as Element ID From t_object Where Object Type = 'Requirement’

Option Action

Add On the 'Package' tab, if you are using a search or filter (from the 'Filters' page of the
dialog) you must define a Package or Packages for the search or filter to work on.
You do this by clicking the Add button and choosing either 'Add Package' to
browse to a selected Package, or 'Search Model' to search or filter from all elements
in the current model.

Remove If you want to clear a Package from the list (or the whole-model selection) click on
the item line and click on this button.

Include Child Packages If you have selected a Package with a child structure, select this checkbox to also
include the elements from the structure in the Kanban diagram, or clear the
checkbox to include elements from the selected Package only.

Auto fill When you select this option, the search configured for the Kanban diagram will
automatically run whenever the diagram is opened or reloaded.

Synch with search Selecting this option will synchronize the diagram with the current search when it is
run. That is:

e New elements that match the search but are not currently on the diagram will
be added and

e Elements on the diagram that now do not match the search will be removed

Run Search When you have set up either a Package search or a custom SQL search, click on the
Run Search button to fill the diagram. All elements found by the SQL search are
added to the diagram.

If you have not applied a filter to a Package Search, all elements from the selected
Packages are added to the diagram. If you have used a filter, only those elements
that meet the filter criteria are added.

A "Progress' dialog displays during the search. If the search is taking a long time or
is finding too many elements, click on the Cancel button; any objects already added
to the diagram are removed.
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Kanban Options - Filters

The 'Filters' page can be used in conjunction with the Package search defined on the 'Advanced' page, should you want to
apply additional filtering.

¢+ Configuration
i Sub-lanes

- Appearance
- Advanced

i Filters

Narrow the Kanban results to elements matching these conditions.
Element Filter

Import Search + Add Filter Edit Filter Remove Filter

Search In Condition Look For Required
There are noitems to show in this view.

Element Features

*) Optional Required

It is possible to import a Model Search that has already been created, or to create new filters here exactly as you would
for any other Model Search.

When adding any of these searches or filters, you must also select at least one Package for the search or filter to work in;
you do this on the 'Advanced' page of the 'Kanban' dialog.

Access

Ribbon

Construct > Resource Management > Kanban > (options to generate and/or open a
Kanban diagram) or

Start > Personal > My Kanban (displays personal default Kanban diagram)
Then

Design > Diagram > Manage > Kanban > Filters (on an open Kanban diagram)

Context Menu

In the Browser window, right-click on the diagram name | Kanban > Filters, or
On a Kanban diagram, either:

e Double-click on a lane > Filters

e Right-click on the diagram background | Kanban > Filters
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Filter Options
Option Action

Import Search Click on this button to import a search from either an external XML file ('From
File') or from the current model ('From EA").

Add Filter Click on this button to define the properties of elements that you want to be added
automatically to your Kanban diagram during a search. Note that not all element
types can be added to Kanban diagrams; the excluded types are listed in the Notes
section.

Edit Filter Click on this button to edit the currently selected filter in the list.

Optional / Required Optional - Select this when at least one filter needs to be matched
Required - Select this if all filters need to be matched

Remove Filter Click on this button to delete the currently selected filter from the list.

Notes

e These element types are not included in Kanban diagrams when running a search:
- ActionPin
- Boundary
- Chart
- Constraint
- Diagram Legend
- ExpansionRegion
- GUIElement
- Hyperlink
- InterruptibleActivityRegion
- ModelView
- Note
- Package
- Port
- ProvidedInterface
- RequiredInterface
- Screen
- Sequence
- StateNode
- Text
- TimeSeriesChart
- UMLDiagram
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Kanban Patterns

Kanban provides diagram types and patterns that underpin the creation of diagrams. Whilst it is possible to create
Kanban diagrams from most UML diagram types and design the workflows on them from scratch, these diagram types
and patterns help you to generate a Kanban that matches your requirements and then adjust the settings to suit, thus
saving time and effort.

Access

On the 'MDG Technologies' dialog, in the 'Technology' panel, select 'Kanban' then click on the 'Enabled' checkbox and
on the OK button.

Ribbon Specialize > Technologies > Manage Technology

Kanban Diagram Types

The Kanban Technology has four kinds of pre-defined Kanban diagram, as described here. To create one of these
diagrams, open the 'New Diagram' dialog, use the 'Select From' header to select the 'Software Construction > Kanban
Perspective' in the left-hand pane and choose one of the diagram types from the right-hand pane.

Diagram Type Description
Basic The Basic Kanban diagram contains these lanes:
e Backlog
e Queue

e In Progress
e Done

The Basic Kanban diagram doesn't have a lane binding to any element property.

Backlog The Backlog Kanban diagram contains these lanes:
e Low
e Medium
e High
e (ritical

The lanes are bound to the element Priority, so that moving elements between lanes
will automatically update their Priority to the name of the lane.

Iteration The Iteration Kanban diagram contains these lanes:
®  Queue
e In Progress
e  Test/Review
e Done

The lanes are bound to the element Phase, so that moving elements between lanes
will automatically update their Phase to the name of the lane.

Complete The Complete Kanban diagram contains these lanes:
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e Ready for Release
e Staging

e  Production

e Done

The lanes are bound to the element Phase, so that moving elements between lanes
will automatically update their Phase to the name of the lane.

Kanban Workflow Patterns

Kanban Workflow model Patterns help you to very quickly set up a one, two or three stage workflow, using and linking
the Backlog, Iteration and Complete Kanban diagrams.

Workflow Pattern

1-stage Workflow Pattern

2-stage Workflow Pattern

3-stage Workflow Pattern

(c) Sparx Systems 2025

Description

The 1-stage Workflow Pattern consists of a single Kanban diagram with the
Backlog, Queue, In Progress, Test/Review, Done, and Deploy lanes. These lanes
are linked to the Phase property of elements, so that moving elements between
lanes will automatically update their Phase to the name of the lane.

The 2-stage Workflow Pattern consists of two related Kanban diagrams:

e A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked
to the Priority property of elements, so that moving elements between lanes
will automatically update the Priority to the name of the lane, and

e  An [teration Kanban diagram with Queue, In Progress, Test/Review, Done and
Deploy lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between

diagrams. Simply drag the elements onto the appropriate zone (having the name of

the diagram to move elements to) and select either 'Move to' to move the element to
the new diagram, or 'Create link on diagram' to create a link on the second diagram

without removing it from the current diagram.

The 3-stage Workflow Pattern consists of three related Kanban diagrams:

e A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked
to the Priority property of elements, so that moving elements between lanes
will automatically update the Priority to the name of the lane

e  An [teration Kanban diagram with Queue, In Progress, Test/Review, and Done
lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane,
and

e A Complete Kanban diagram with Ready for Release, Staging and Production
lanes linked to the Phase property of elements, so that moving elements
between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between

diagrams. Simply drag the elements onto the appropriate zone (having the name of

the diagram to move elements to) and select either 'Move to' to move the element to
the new diagram, or 'Create link on diagram' to create a link on the second diagram

without removing it from the current diagram.
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Resources & Work Items

Enterprise Architect not only helps you to define the work items for a Kanban diagram or workflow but also acts as a
sophisticated platform for the allocation and management of resources and the flow of items through the board. This
functionality uses both Kanban diagrams and the Resource Allocation features.

Resources are the people who work on a project; they can be assigned roles and allocated tasks, and these roles and tasks
can be visualized on a Kanban diagram.

In Progress (5/6) Test/Review

s k@_\ i Q,_.\

As a Sales Representative | As a Warehouse Manager |
want to be able to view want to be able to determine
historical leads the best product location to
minimize picking errors
UserStory
Validated UserStory
Medium Proposed
Low
Adam Goodchild
[(— |  Soluti.. Yuki Kotabashi
lane Ward LIil Test 4. .. )
[ ] Devel...
Pat Taylor - L]
— | C++Pr.. As aCustomer lwant to be ab g
. - to rent an item for a specified

This example shows a number of Kanban work items, one with three resources allocated to it. The tasks performed by
the resources are at varying stages of completion, represented by the green progress bars that show the percentage of the
work completed.

When a resource allocation is set to 100% complete, it will no longer be displayed in the Kanban object. When all tasks
have been set to 100%, it might be time to move the task to the next Kanban lane, changing its status so that the next
resources can be allocated. In this example, that might be resources with a 'Review' or 'Testing' role.

Resource Allocation

To allocate a resource to a Kanban object, you must first open the Resource Allocation window (‘Construct > Resource
Management > Resources'). You then select the object on the Kanban diagram or in the Browser window and click on
the 'New' icon in the Resource Allocation window. Add these details as necessary:

e Resource

e Role or Task

e  Start Date

e End Date

e Complete %

e  Expected Time
e Allocated Time

e Time Expended
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e Description
e History

Click on the Save icon to create the resource allocation - a progress indicator will instantly appear on the work item in
the Kanban diagram. This is an important visual cue to show that a resource has been assigned to work on this task or has
chosen it themselves. Other team members will immediately be able to see the allocation on the Kanban diagram and
make decisions about what work items they will work on. Therefore, it is important not to allocate resources too early as
this could slow down the workflow.

The resource allocations for the Kanban Work Item in the previous diagram are shown in this example:

Resource Allocation O x
."; i . A: g

HEHEX: &> BE @

Resource Rale Allocated Time Expended Time % Completed Start End

Jane Ward Developer 14 2 15 15-Jun-1& 20-Jun-16&
Pat Taylor C++ Programmer 7 3 50 16-Jun-1& 22-lun-16
Adam Goodchild Solution Architect & 3 80 14-Jun-1& 18-Jun-16
Completed Tasks

Once you have completed a task, you set its 'Complete %' value to 100. This has the effect of preventing the task's
progress bar from being drawn in the object in the Kanban diagram. As well as setting the completion percentage on the
task, you might also want to fill in other information, such as the end date and time expended. It might also be time to
move the object into the next Kanban lane.

Resource Tracking

The Kanban features in Enterprise Architect can be used with any project management method. How the features are
used will depend largely on what works best for individual teams; the teams might be self organizing without any formal
project management controls and other teams might work with a more formal structure. Either way Enterprise Architect
provides a number of facilities that will assist with visualizing resources and their allocations to work items.

Enterprise Architect provides searches to allow you to track resources. You can get a list of tasks that each resource is
working on, overdue tasks, recently completed tasks, summaries, and more. A team or individual can also write their
own custom searches to retrieve any required information from the repository.

Access

Ribbon Construct > Resource Management > Active
Construct > Resource Management > Completed

Construct > Resource Management > Summary

Resource Tracking Searches
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®5tartPagE Finu:lin Project X

Resource Tracking

Drag a column header here to group by that

L] Object

Search

Active Tasks

Tasks Ending Today

Tasks Starting Today

Overdue Tasks

Recently Completed

All Completed
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= 30 Day Resources - <Search Term=

Resources
Tasks Overdue

|Active Tasks Scope

Type

Tasks Completed

Recently Finished Tasks

Tasks Ending Today

Tasks Starting Today

Authors with no Active Tasks

30 Day Task Summary (Simplified)

30 Day Task Summary (Full)

30 Day Resources h_
30 Day Roles

Description

Searches the project for elements with assigned resources, where the end date is in
the future and the percentage completion is less than 100.

The output lists all elements with currently active tasks, and shows the details of the
resource allocation to each task.

Searches the project for elements with assigned resources, where the task end date
is today.

The output lists all elements with tasks ending today, whether the task is complete
or not, and shows the details of the resource allocation to each task.

Searches the project for elements with assigned resources, where the task start date
is today.

The output lists all elements with tasks starting today, and shows the details of the
resource allocation to each task.

Searches the project for elements with assigned resources, where the end date is in
the past and the percentage completion is less than 100.

The output lists all elements with overdue tasks, and shows the details of the
resource allocation to each task.

Searches the project for elements with assigned resources, where the end date is in
the recent past and the percentage completion is 100. In the 'Search Term' field,
specify the number of days over which to check back.

The output lists all elements with tasks completed within the specified period, and
shows the details of the resource allocation to that task. The output does not include
tasks that have already been finished in advance of a future completion date.

Searches the project for elements with assigned resources, where the percentage
completion is 100.

The output lists all elements with completed tasks, and shows the details of the
resource allocation to each task.
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30 Day Task Summary Provides a brief summary of the tasks performed by resources over the previous
(Brief) month.

The output groups tasks with similar project role and calculates for each resource:
the count, the sum of expected time, and the sum of expended time for all tasks that
have started in the last 30 days. To look at or change the master list of project roles
that this search uses for grouping tasks, select 'Settings > Reference Data > Model
Types > People > Project Roles'. Grouping by similar project role means that, for
example, 'Review 1' and 'Review 2' would be grouped together under 'Review' if
and only if the current project's list of project roles includes one called 'Review'.

30 Day Task Summary Provides a full summary of the tasks performed by resources over the previous
(Full) month.

The output groups tasks by project role and resource, and lists the count, sum of
expected time, and sum of expended time for all tasks that have started in the last
30 days.

30 Day Resources Searches the project for tasks that have started in the last 30 days where the
resource name matches (fully or partially) the text in the <Search Term>.

30 Day Roles Searches the project for tasks that have started in the last 30 days where the role
name matches (fully or partially) the text in the <Search Term>.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that allows a wide range of charts to be created, through which
you can visualize and analyze repository information. This is particularly useful with Kanban diagrams and resource
allocations, and provides an alternative view of the Kanban cards, allowing a Product Owner, Project Manager or other
team member to get a visual image of things such as the Number of Active Tasks by developer, the Phases the Work
Items are in by developer, the Number of Work Items at each stage of a Kanban Board and much more. The charts can
provide information that will help improve the teams performance and ultimately result in high value product or service
features being available to customers in the shortest possible time frame. Any number of charts can be created from
built-in Patterns, but a team is also free to create user defined charts, dashboards and reports.

Example - Active Work Items by Team Member

This Bar Chart shows the number of active tasks by team member. The names of the team members are listed on the
vertical axis and the Number of Tasks on the horizontal axis. A small numerical value indicates the number of active
tasks allocated to each team member.
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dash Active Tasks

Active Tasks

Ali Evans
Anna Howe
Buck Gold
Carlos Wallace
Carmen McRae
Elinor Dashwood
Eric Burns
Leon Major
Liam Cross
Penny Dark

Peter Ryan

Example - Completed Work Items by Team Member

This compelling Bar Chart shows the number of work items completed by the members of a team in a particular phase of
the process. The team members are represented on the vertical axis and the number of completed work items on the
horizontal axis. Color has been used to help visualize the work items completed in a given phase; a Diagram Legend lists
the relationship between color and phase. A small numeric indicator indicates the number of items completed in each
phase for each team member.
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dash Completed Tasks /l

Ali Evans
Alma Cogan
Billy Bunter

Bob Brown

Brett Chambers

Carlos Wallace
Carmen McRae
David Kelly
Donna Campbell
Eric Burns
Ethan Rogers

Frank Mclver

Completed Tasks Last Week

Josh Morgan |
Liam Cross _

Nigel Maleswaorth -
Pat Taylor _

Penny Dark 1

W Test

[ Rework

W Review

W Proposal
[ Investigate
B Implement

Peter Ryan _
Philip Marlowe | 1]7 2]
T T T T 1
o 5 10 15 20

35

Example - Weekly Work Item Summary by Phase

This expressive Bar Chart provides a weekly summary of the number of Work Items completed by phase. The Phases are
represented on the vertical axis and the Number of Work Items on the horizontal axis. The Chart can provide information

that will help improve the team's performance.
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dash Task Summary

Task Summary (1 Week)

Implement

Investigate

Proposal
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Kanban in Context

There is a wide range of tools that allow teams to create Kanban diagrams, but Enterprise Architect stands on its own as
a tool that not only allows a team to use the Kanban features but is also a sophisticated platform for managing the work
products of every discipline working on Enterprise, Business or Technology initiatives. This means that instead of
having to access other tools or out-of-date documentation or schedule meetings the information related to a work items is
immediately available inside the same repository. An analyst, developer, tester or other team member working on a User
Story, Feature, or Defect can locate the related Requirements, Business Rules Policies, Standard Operating Procedures,
Strategies, Drivers, Goals, Stakeholders Requirements, Architectural designs, Principles, Programming Code, Database
and Information Schemas, XML definitions, Messages, Test Cases, Applications, Deployment Targets and Specifications
and more.

«goal (.

Provide customers with a
competitive online shopping

experience :
I
I
(from Goals) <c1rape»
I
I
I
I
I
I
I
Rules Analyzer «business rule» 1 «policy» D
Any person studying who is under The book will provide di:
the age of 27 with student = |-=-=—=--=-—-=--= to students to encourage learning
-3 «enforces»

identification is considered a student
«irace»

This is a customer built rules engine
used to manage configuration items. It (from Eu&e&s Rules) (from Policies)
has been extended to allow rules to be I
viewed and updated through a business :
web interface. I

; «irace»
H I

. I
wtrace» |
I

As A Student | want to buy books REQ117 - The system must provide a ° o
at Academic Prices || || _____ _= mechanism allowing studentste | _~ |
Requirement «UserStory» «tracen identify themselves «trace» il f§ 1UALAM
Version: 1.0 Phase: In Progress Name
e (rem Toke crder] I
Institution
A A United States
|
[ Stanford
[
<<1ralce» Harvard
|
1
! Student Number
s vertcon O ]
This Requirements diagram shows
«column» a User Story that has beenadded
1D: NUMBER(S,2) toa Kanban diagram expressing
INSTITUTION NAME: NVARCHAR(50) the relationships to a number of
YEAR: NUMBER(4,2) business and technical elements.

Relating Model Elements

Enterprise Architect allows a user to create any number of connections between model elements, using the connectors
that form part of the chosen modeling language. Any item that appears in a Kanban diagram can be dragged onto any
other diagram and then connections can be added. For example, a User Story that is coming to the top of a backlog or is
in a Queue lane in a Kanban diagram could be added to a Business or Stakeholder Requirements diagram, and Trace
relationships could be added between the User Story and the Requirements, indicating which requirements relate to the
Story.
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The work items in a Kanban board can be related to any other elements in the model, allowing a graph to be defined.
While it is possible to add your own connections, quite typically other team members working in related disciplines and
parts of the repository will have already added relationships to other model elements, which in turn will be related to still

other elements and so on.

These connections can all be visualized in existing diagrams, but a modeler can create a new diagram and place the work
item in the center of the diagram, choosing the Insert Related Elements feature to insert the graph of related elements that
can be configured to draw an expressive diagram reaching out to the very corners of the repository.

This diagram shows the result of using the Insert Related Elements feature to find the important information needed
when working on a User Story.

Rules Analyzer

This is a customer built rules engine
used to manage configuration items. It
has been extended to allow rules to ke
viewed and updated through a business
web interface.

wtrace»

As A Student | want to buy books
at Academic Prices
Requirement «UserStory»

Version: 1.0 Phase: In Progress
Priority: High

I
I
[
|
wtrace»
1

Student Verification E

acolumn»
ID: NUMBER(8,2)
INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)
STUDENT NUMBER: VARCHAR2(20)
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«goal»
Provide customers with a
competitive online shopping
experience

(from Goals)

«business rulex 1
Any person studying who is under
the age of 27 with student

identification is considered a student
«trace»

(from SuAess Rules)
I
I
I
I

wtrace»
I

REQ117 - The system must provide a
mechanism allowing students to
identify themselves

«trace» «trace»

(from Take Orders)

@)

This Requirements diagram shows
a User Story that has been added
toa Kanban diagram expressing
the relationships to a number of
business and technical elements.
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The Backlog

The Backlog (or Product Backlog, as it is called by some Agile methods such as Scrum) is an ordered list of items that
will deliver business value to the customer. It can consist of a heterogeneous list of item types ranging from Features,
User Stories and Requirements (including Non-functional Requirements) to Defects, Changes and more. In fact, in
Enterprise Architect any element can be placed onto a Backlog; the ones that are listed and those that appear in the
Toolbox are simply the most common. The Backlog is an ordered list based on the business value, with the higher value
items percolating to the top of the list. The list is owned and managed by the Product Owner or their equivalent; that is,
someone acting as a surrogate for the customer.

Ordering Items in a Backlog Lane

When working with a one-stage workflow, the Backlog items will typically be contained in the first lane of the Kanban
and can be dragged to a new location in the lane to change the order of items in the backlog.

Step Action
1 Select the Item to be moved in the Backlog diagram.

2 Drag-and-drop it into a new location in the backlog lane.

Prioritizing a Backlog

Typically, the order of the items in the Backlog is carefully and thoughtfully determined by the Product Owner and
reflects the business value - the items promising high business value are located at the top. The prioritization of the
Backlog is the Product Owner's responsibility, but it is not decided in isolation from other team members and the Product
Owner relies on access to important information from a range of stakeholders, from senior executive level stakeholders,
business and operation managers, requirements analysts and business analysts, through to implementation teams.

A range of strategic diagrams and materials provides a source for many of the prioritization decisions. These include:
Strategy Maps, Business Drivers, Goals and Objectives, and Roadmap diagrams that describe the time-based sequencing
of packages of work. The example Roadmap diagram could be used by the Product Owner as an input to what is of high
priority to the Business, or what has been planned by the Enterprise or Business Architecture teams. The diagram will
prove useful in discussions with both the business stakeholders and the implementers, who can gain a business context
for the work they are completing.
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Unit: Quarterly Product Architecture

Q3'16 Q4'l6e Qi1'l7 Q217 Q317 Q4'l17 Ql1'i18 Q2'18
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Academic Titles

Item Real-Time Tracking

sales and Marketing Dashboards

Warehouse Optimization

Logistics Rationalization

D Implementation
[:] Production

Comments provided by Implementers and other stakeholders will also provide a valuable source of information and input
into the prioritization of the backlog. Enterprise Architect has a Discuss & Review window, which is a highly
collaborative facility through which any team member can enter discussion posts against an element and other users can
reply and join the discussion. This can create a rich and useful tapestry of knowledge that will not only help the Product
Owner in deciding the item's position in the backlog list but will also assist implementers when they are ready to
implement the item.

M4 kM ElementDiscussinns\kwlndel Chat

As a Stock Manager | want to be able to predict product demand -

= %% Paulene Dean 16-Jun-16 4:35 PM

(1) I= this related to peak demand times like the beginning
of the Academic Year or is it more general?

£ Greg Michols 16-Jun-16 4:38 PM

It is being driven by the upcoming Academic Titles
launch but it applies more generally as well.

Another critical piece of information that will help the Product Owner is the item estimates completed by implementers,
who make their best estimation of how long the item is likely to take. Agile teams using User Stories tend to use Story
Points, but any unit of measure can be used as long as the team agrees upon a standard. Some teams will use actual times
based on units such as number of hours, whilst others will use effort-based estimates. Enterprise Architect has a flexible
and integrated resource allocation facility where team members can add estimates, allowed time, actual times,
completion percentages and more. This will be invaluable for the Product Owner, who might have a broad idea of the
time required to complete an item but who would rely heavily on the details supplied by the team. The time estimate can
be entered in the 'Expected Time' field of the Resource Allocation window.
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Expected Time: [
AMlocated Time: 8
Time Expended: 2

This diagram shows how a backlog can be defined in a one-stage workflow, allowing items to be dragged and dropped in
a single column to define the order of the items in the backlog.

Backlog

-

L

A0

AsaCustomerlwant tobe able
to viewthestatusof my order

UserStory
Validated
High

-

-

L

AP
AsaReviewer lwantto beable
to beableto addwords to the
online dictionary

UserStory
Proposed
Medium

.

-

L

L

Prices for some publishers do
not include internal storage
costs

Defect
Proposed
Low

Ordering Items in a Backlog Diagram

When working with two or three stage workflows the Backlog items are contained in a Kanban board representing the
entire Backlog, allowing them to be moved between lanes from low to medium, high or critical or using any user defined
lane names or bound property.

Step

Action
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1 Ensure the Backlog Kanban diagram is open.
2 Select the work item to be prioritized in the diagram.
3 Drag and drop the item into a new location, either in the containing lane or in another lane.

Securing a Backlog

The Backlog is a communication tool that insulates the implementers from the need to decide what they should be
working on. It is owned and managed by the Product Owner, who ultimately decides what should be on the Backlog and
the order of the items it contains. It therefore must be secured from inadvertent changes. The implementation team
should have access to the Backlog, but for the purposes of pulling items from a work queue to the In-Progress lane,
which could be continuous flow-based (Kanban) or time-boxed (such as a Sprint). The development team also need to
provide time estimates for the items in the Backlog, which will help the Product Owner decide upon the order of items,
particularly when two or more items have comparable business value. The item with the lowest completion estimate will
typically be given a higher position. Developers are also expected and encouraged to comment on the items in the
Backlog so that the Product Owner can understand any issues or have access to learning from prior initiatives or insights.

Enterprise Architect's security system can be used to lock the Backlog while still allowing people to make the necessary
contributions of time estimates and comments in the form of discussions.

With the Security System enabled and either a group for Product Owners or individual users who are Product Owners
added, a Backlog diagram can be locked by the individual Product Owner user or a member of the Product Owner group.
This example shows the Backlog being locked by the Product Owner group, but for a repository that is accessed by a
number of Product Owners it could be more expedient to lock the diagram to an individual.

Lock Diagram >

Lock Type

"1 Mo lock, general editing allowed

3 Full lock, no-one may edi

) User lock, locking user may still edit
@ Group lock, locking group may still edit

GrouplD: | Product Owners ~

When the Backlog diagram has been locked by the Product Owner, other team members will be able to view the diagram
but a small red marker to the left of the diagram name in the Browser window will indicate that it is locked. The Project
Manager will see a blue marker indicating that they have access to edit the diagram.
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Securing a Backlog Diagram

Secure a Backlog diagram, remembering that it can be locked at a user or a group level.

Step Action
1 Locate and select the Backlog diagram in the Browser window.
2 Right-click on the diagram name and select the 'Lock Diagram' option. The '"Lock Diagram' dialog
displays.
3 Select the 'User Lock' or 'Group Lock' option from the 'Lock Type' list.
4 Select the User, or the Group from the 'Group ID' drop-down list.
5 Click on the OK button to save the changes.
Notes

e  The model must have user security enabled in order to lock the backlog Kanban diagram

e To secure a Backlog a two or three stage workflow is required where the Backlog is a separate Kanban diagram
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During the process of prioritizing the Backlog, and as work items move closer to the top of the Backlog or onto the work
Queue, the work items must be prepared for the In-Progress stages of the workflow - in traditional methods, this process
is termed 'elaboration', but is known as 'grooming' in Agile methods. Enterprise Architect has a number of facilities that
can assist with the grooming of work items, so that when they are pulled onto an In-Progress lane the right information is

available for an implementer to immediately start work.

Enterprise Architect has a form of requirement that is internal to an element and allows supplementary and more specific
requirements to be added to a Work Item. These requirements are created in addition to the business, stakeholder,

functional and non functional requirements that might exist for the work item.

[&f' UserStory : As A Student | want to buy books at Academic Prices *
(- Properties Requirement:
- General An item needs to be idertified as an academic title
E| Rules
i . Requirements
Constraints
Scenarios B/U E e éE st %, % = Req
(- Related Status Proposed
Students should not be permitted to buy any titles that are not D"fﬁc_”h' MEdf“m
marked as academic so a new property must be added to the item Prority Medium
. . . . Stability Moderate
information model and related tables to categorize these titles. )
Type Functional
Last Updated 17un-169:...
New Save Delete
Requirement Type Extemal
An item needs to be identified as an academic title: Functional
Student numbers need to be verfied Functional
The Academic Price discount needs to be configurable at rurtime Functional
Cancel Apply Help

There is also a wide range of information that can be entered as Change Management Items for a selected Kanban Work
Item. These items include Features, Changes, Documents, Issues, Defects and Tasks, and add rich additional information
that will assist all team members, including the Product Owner and the Implementation team.

DEHEX!e EE @

Issue Priarity Name: The database environments are locked down while the Linux upgrades are being done Auto

The percentage for the academic pr.. Medium Raised by: Greg Nichals + | Raised: 15062016 - Status: |New -

iThe database environments are loc... High Completed by: -] Completed: [ - Prorty: |Hich -
Version / |D: 16065 3CEEISS Copy ID

Description | Histary

B 7 U&M-[Z:=|x*%@

4

There is a Linux Operating system project in progress for the next couple of
weeks and all non critical database changes have been frozen during this
period. This will mean that the addition of the Student Verification table and
associated stored procedures will have to be delayed. A replica environment
will he huilt on another server to allow develonment to continue.

»

;fs’ Defects :g’& Changes ,g,& Events qfs’ Decisions pg*&’lssues

Enterprise Architect also has the 'Details' tab of the Inspector window, which is a convenient tool for viewing all the
related information about an element in a single place. The 'Details' tab can be kept open in the Inspector window and
items can be selected in a Kanban diagram, List, or Gantt chart, and the Work Item's specific information will be

displayed.
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Inspector o x
llia

Details Trace Summary

Az 4 Student [want to buy books at Acadernic Prices
4 8 Relationships
n"n Abstraction:Student Verification [Class]
q"h ShstractioniRules Analyzer [Component]
"o Bbstraction:REQTIT - The systern must provide a mechanism allowing students to identify thernselves [Requirernent]
q"n Motelink: [Mote]
B Discussions
4 B Requirerments
The Acadernic Price discount needs to be configurable at runtirme
Student numbers need to be verified
A itern needs to be identified as an acadernic title
4 B Constraints
The solution must use existing stored procedures where applicable
B Scenarios
B Linked Features
4 B Files
M ErProjects\Online BookStore\RequirermentshList of Academic Institutions. =l
B Testing
4 B baintenance
PRE Changes
Ea [ Mew ] Academic Institutions need to register for discount
4 [T Issues
B [ Mew ] The database erviranments are lacked down while the Linux upgrades are being done
BD [ Werified ] The percentage for the academic price discount has not been set by the product tearn
4 B Project
4 [ Decisions
Ed [ Werified ] Mo need to cite orwvalidate a student card
4 B Resources
FNE Fat Taylor: C++ Programmer

B Integration
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Default Kanban Diagrams

A default Kanban diagram can be set for the entire repository, and each individual user can also set their own default
Kanban diagram; in both cases there are specific options to locate and open the diagrams. These defaults help you to
quickly and easily get access to a Kanban board and immediately start contributing to work items that will deliver value
to the customer.

To track your own work, you can select:

e  The 'Start > Personal > My Kanban' ribbon option, or

e  The 'Construct > Resource Management > Kanban > Open My Kanban' ribbon option, or
e  The 'User Default Kanban' menu option from the diagram Caption Bar

To track the team's work, you can select:

e  The 'Construct > Resource Management > Kanban > Open Project Kanban' option or

e  The 'Model Default Kanban' menu option from the diagram Caption Bar

v *| Toolhox > 1
@ Show 5tart Page

User Default Diagram
User Default Kanban
Maodel Default Diagram
Model Default Kanban

'Eg Backlog
'Eg Specification Manager

Set the Model Default Kanban

A default model Kanban diagram can help you to visually track a range of work items and their current stage of
development through an initiative. This feature ensures that all team members can visualize the important work items in
a consistent way and allows them to track the work items as they move from an idea in the backlog through to
completion ultimately delivering business value to the customer.

Step Action

1 Ensure the preferred Kanban diagram is open in the main view.

2 Select the 'Construct> Resource Management > Kanban > Model Places - Manage > Set Current as
Default' ribbon option.

Set My Default Kanban

In a shared security-enabled model environment it is possible to set a user-specific default Kanban diagram. A
personalized Kanban diagram can help each member of a team to visually keep track of a range of elements of particular
relevance to them, and their current stage of development.

Step Action
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1 Ensure your preferred Kanban diagram is open in the main view.

2 Select the 'Construct > Resource Management > Kanban > My Places - Manage > Set Current as Default'
ribbon option.

Notes

e  The model must have user security enabled in order to define a user default Kanban diagram
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Alternative Views

Enterprise Architect is a modeling platform that can be used by any number of stakeholders, ranging from high level
executives to implementation teams, providing a variety of communication devices suitable for each stakeholder group.
There are four other views of a Kanban diagram that will be appealing to many stakeholders, particularly project
managers, schedulers, development managers and product owners; these can be viewed by simply toggling from view to
view:

e  Gantt View
This view provides a visualization of the work items and the assigned resources in a Gantt Chart, which is
particularly useful for people who might be more familiar with this more traditional representation or who want to
get an overview of the schedule of tasks

e List View
This view is a spreadsheet representation, where the work items are the rows and the properties and Tagged Values
are the columns

e  Specification Manager View
This view lists the work items with the contents of each element's Notes field

e Traceability Window
This view helps a team member to quickly review dependencies and other relationships between work items to any
depth, and to locate the items in other diagrams

Switching between Views
A Kanban diagram, like all diagrams, can be switched to an alternative view and, once in this view, can be switched to
any other view without affecting the underlying layout of the diagram.

Step Action

1 Ensure the diagram is the active tab or has focus.

2 Ribbon: Design > Diagram > Views > <view type>

Context Menu (open diagram): Open Diagram in | <view type>

List View

The List View provides a spreadsheet-like visualization of the work items and their properties and Tagged Values. It
allows properties to be viewed and compared across the entire corpus of work items that make up the diagram and allows
properties such as status to be edited inline using drop-down lists of values where they apply. It also has a clever
mechanism that allows the list to be grouped by property down to any number of levels and a filter that is useful when
wanting to restrict the view of work items with a particular property or name - for example, all work items relating to the
Warehouse Manager.
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?g Kanban Diagram: "1 stage workflow"

B E X E A - NEENC)

Priority =

¥ Mame ¥  Priority ¥ | Phase * Status ¥ Type ¥  Modified A

P » pe P o P

|=| Priority: Critical
As a Customer | want to be able to add new orders to existing ones if they hav... Critical In Progress Proposed — Defect 17-Jun-16
|| Priority: High
As an Administrator | want to be able to have a maintenance window to updat... High In Progress Validated Requirement 17-Jun-16 =
As 3 Customer | want to be able to view the status of my order High Backlog Validated Reguirement 17-Jun-16
; As A Student | want to buy books at Academic Prices High E] InProgress Proposed Requirement  17-Jun-16
=) prioity: Medium :Hmfﬁmnl
The Online Shop web site country drop down list is missing a number of small ... !_ow Daone Proposed  Defect 14-Jun-16
As a Reviewer | want to be able to be able to add and edit rules in the online ...  Medium In Progress Proposed  Requirement  17-Jun-16
As 3 Sales Representative | want to be able to view historical leads Medium InProgress Proposed Requirement  17-Jun-16
As a Customer | want to be able to delete items from my order before it is ship... Medium Queue Approved Requirement  17-Jun-16
Az a Reviewer | want to be able to be able to add words to the online dictionary Medium Backlog Proposed Requirement 17-Jun-16 -

Access

Ribbon Design > Diagram > Views > List View

Context Menu Right-click on diagram background | Open Diagram in | List View

Gantt View

The Project Gantt View provides a traditional Gantt Chart in the form of bar chart representing the scheduling of the
work items including: their start and finish times and the percentage complete. It is a graph that provides a time oriented
view of the work items and is useful for project managers and project schedulers or other team members who want to
view all the work items in a single view.

3 By 1stage workflow, Kanban Diagram > x
@ start Page (S Specification Manager | Ta 1 stage workflow a v
Element Role or Task start End Complete | December 2020
06 o7 o 1) 10 1 12
As a Customer | want to be able to view the status of my order 47122020 51272020
As a Stock Manager | want to be able to predict product demand 47122020 5/12/2020
Stock levels on financial reports don't include returned items 41272020 114272020 1
# Theresa Moranti Java Programmer 4/12/2020 11/12/2020 159 1
As a Customer | want to be able to delete items from my order before it is ship... 47122020 5/12/2020
As 3 Sales Representative | want to be able to view historical leads 471272020 19/12/2020
# Adam Goodchild Solution Architect  4/12/2020 10/12/2020 505  — )
# Pat Taylor C++ Programmer  4/12/2020 15/12/2020 S0 | —
# Jane Ward Developer 4/12/2020 19/12/2020 15%
The Online Shop web site country drop down list is missing a number of small... 47122020 1112/2020 1
£ Benjamin Hutton C-= Programmer  4/12/2020 11/12/2020 06 o | .\
As a Reviewer | want to be able to be able ta add and edit rules in the online .. 47122020 5/12/2020

Access

Ribbon Design > Diagram > Views > Gantt View

Context Menu Right-click on diagram background | Open Diagram in | Gantt View
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Specification Manager View

The Specification Manager is a simple document-based interface to a selected diagram (or Package) in the model,
providing the means of creating and reviewing elements as text representations of objects in the model, using a process
that is familiar to all users including business professionals and management, who might not have expertise in model
development.

The Specification Manager is also an interactive reporting tool for displaying, in icon form, the status of various other
features against each entry and providing access to edit each feature.

Access
Ribbon Design > Diagram > Views > Specification View
Context Menu Right-click on diagram background | Open Diagram in | Specification Manager

Traceability View

The Traceability Window provides an insightful view of how a work item is connected to other elements in the model
including other work items and how these connected elements are themselves connected down to any level. It is a general
purpose mechanism and so can be used with any type of element but is particularly useful when working with Kanban
boards and for product owners and other team members who need to understand the dependenies between work items
and to find the related information that will help with the analysis, grooming, testing and implementation of a work item.

Traceability O x

¢ B & - @

A As A Student | want to buy books at Academic Prices -
A -+ needed by

A Student Verification
[ --+ dependson
4 2l Rules Analyzer
4 -+ depends on
A Arty person studying who is under the age of 27 with student identification is considered a student
A -+ needed by
[ REQ117 - The system must provide a mechanism allowing students to identify themselves
[» & Rules Analyzer
4 -+ dependson

A The bookstore will provide discounts to students to encourage leaming
4 -V needed by
Ary person studying who is under the age of 27 with student identfication is considered a student
4 -+ depends on
A Provide customers with a competitive online shopping experience
A -+ needed by
[ REQ014 - Shopping Basket
[ The bookstore will provide discounts to students to encourage leaming
[ REQ012 - Provide Online Sales -
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Access

Ensure a Work Item is selected in a diagram or other view.

Ribbon Design > Element > Trace
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Other Methods

Kanban is not a process in traditional classification but more of a way of visualizing work items, and a method for
creating efficiencies and ensuring customer value is delivered as soon as possible. Kanban can be used in isolation or in
combination with any existing processes, including Scrum, Iterative and Incremental and Waterfall Processes. Each of
these processes has their place and can be used with Kanban even though much of the literature about process is
currently focused on iterative families of processes such as Agile.

The compelling thing about Kanban is that it provides a visualization of the flow of Work Items from the ideas stage
through to delivering demonstrable value to the customer transparently to every team member.

Scrumban

Scrumban is a hybrid methodology combing aspects of Scrum and Kanban. Scrum teams can typically work with the
same process they have always used, including Sprints, Standups, Retrospectives and Demos, but incorporate Kanban as
a way of visualizing the Work Items, allowing just-in-time planning and benefiting from being able to set
Work-In-Progress (WIP) Limits. The work items that have been selected for the Sprint or Iteration can be pulled from a
Backlog Kanban board onto the Queue lane of an Iteration Kanban board.

Using Scrumban overcomes limitations or issues that some Scrum teams experience such as: excessive time required in
Sprint planning, a loss of focus due to implementers working concurrently on too many User Stories, Defects or other
items and information being forgotten over the period of the Sprint. The built-in one, two or three stage workflows would
all be suitable for Scrumban but a team is free to define their own workflow, create their own Kanban boards and define
their own lanes and sub-lanes.

In Progress

Pat Taylor Benjamin Hutton Theresa Moranti

i e i 2

As a Sales Representative | want to be able
to view historical leads

UserStory
Version: 1.0
Medium

Pat Taylor
e 1 C++Progra..

As A Student | want to buy books at
Academic Prices

UserStory
Version: 1.0
High

Pat Taylor
] C++Progra...

Iterative Methods

The Online Shop web site country drop
down list is missing a number of small
countries

Defect
Version: 1.1
Medium

Benjamin Hutton
i | [++= Progra...

As a Customer | want to be able to delete
items from my order before it is shipped

UserStory
Version: 1.0
High

Benjamin Hutton
e 1 Applicatio...

As a Reviewer | want to be able to be able
to add and edit rules in the online grammar
checker

UserStory
Version: 1.0
Medium

Theresa Moranti
1 s+ Progra..

Stock levels on financial reports don't
include returned items

Defect
Wersion: 1.1
Low

Theresa Moranti
=1 lavaProgra...

Iterative and incremental methods have been in use since the mid nineteen seventies and have been incorporated into a
number of waterfall processes as well as being used in isolation These processes can all benefit from the use of Kanban
diagrams as a way of visualizing the work items in an iteration and any number of Kanban diagrams can be created to
manage concurrent iterations.
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Project Browser v 1 x
Poe =

Project Browser Context Browser

4 £ Multi Iteration Workflow —
F= Backlog
:E'E Iteration One
:E'E Iteration Two
ElEackIDg
T IIteration One
FlIteration Two
[+ 7 Defects
[+ (£ User Stories

Waterfall

Waterfall or modified methods have been in use since the mid nineteen-seventies and have been baked into a number of
standards, particularly in industries such as the military, aviation, travel and finance, where outcomes typically need to be
determined in advance of a development cycle. Waterfall methods are often used when requirements are locked down
and scope is determined in advance, the product is stable and the technology platforms are well known and understood.
These processes can all benefit from the use of Kanban diagrams as a way of visualizing the work items as they flow
from phase to phase.
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Tasks & Resources

In the life cycle of a project, there are various non-technical tasks that are vital to the successful management and
completion of the project, such as allocation of resources and allocation of time to the tasks and to meetings. Enterprise
Architect helps you as a project manager or as a team member to record and monitor such tasks.

Facilities

Enterprise Architect provides a range of project management facilities as described in this table.

Facility

Manage Project Resources

The Project Gantt View

Project Task Allocation

Review Personal Tasks

Project Management
Windows

Notes

Description

Resources are the people who work on a project. You can assign roles and allocate
tasks to them, which helps you to track effort and estimate time to complete tasks.
You can also define the effort, risks and metrics to support resource management.
You add, modify and delete resources using the Resource Allocation window.

In Enterprise Architect, you can visualize elements and assigned project resources
easily in a Gantt Chart format, to review the breakdown of work for a specific
project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that
you as Project Manager can quickly see the current project status using the
percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted
and identified. You can also access specialized versions of the Project Gantt View
from diagrams, Packages and the Personal Tasks list.

A particular feature of the Project Gantt View is the facility to review the allocation
of work to elements in the project, focusing on either the elements that require
work, or the resources required to perform the work.

Using the Personal Tasks view, each team member can record, review and manage
their personal work within the project.

Enterprise Architect provides five specialized tabs in the Project Tools window to
help you to define each of the management quantities associated with an element in
the model, namely:

e Decisions - the choice made on a requirement of the element
e Events - the action taken on a requirement of the element

e  Effort - the effort expended in work on the element

e Risks - the risks associated with the element, and

e  Metrics - the metrics measured for an element

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if User Security is enabled, you must have
'Manage Project Settings' permission to perform Resource Allocation
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Project Resources

Resources are the people who work on a project. They can be assigned roles and allocated tasks, which enables tracking
of effort and estimation of time to complete. You also define the effort, risks, metrics, events and decisions to support
resource management.

You can also review and delete listed allocated resources using the Resource Allocation window.

Access
Ribbon Construct > Resource Management > Resources
Keyboard Shortcuts Select a Resource item on a diagram or on the Details' tab of the Inspector window,
then press Shift+Enter
Uses
Use to

Allocate a resource to an element.

Record additional project management information for an element.
Obtain a report of resource allocation details.

Show Project Management information on elements in a diagram.

Configure Project Management data and populate the drop-down lists used on the tabs of the Project Tools window.

Notes

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if User Security is enabled, you must have
'Manage Project Settings' permission to perform Resource Allocation and to update and manage project resources,
effort, metrics, risks, decisions and events
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Resource Allocation

In developing a model, people (or resources) in a number of roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements (including Packages) in the model, planning and monitoring the
work that they do within the timeframe you have allocated for that work to be completed. You can do this using the
Project Gantt View and/or Construct facilities.

The Resource Allocation window, displays a Gantt chart that shows all of the resources assigned to a particular model
element. As you select different model elements, the Gantt chart updates to show the resources assigned to the selected
element. As you select an individual resource on the Gantt chart, the Properties window and the Notes window (if
visible) will update to show the details for the selected resource.

Access

Ribbon Construct > Resource Management > Resources, or

Start > All Windows > Construct > Resources > Resource Allocation

Create Resource Allocations

New resource allocations are made using the 'Assign Resources' dialog. To access the dialog, first select a model
element for which you wish to create resource allocations and then, either:

e  (Click on the button in the Resource Allocation window toolbar, or

e Right-click on the Gantt Chart and choose the context menu option 'Assign Resource...".

Assign Resources Dialog

The initial details for a resource allocation are entered using the 'Assign Resources' dialog.

. 4
Assigned Resources

Resource: o

Role or Task: =

Gtart Date: | 2021-10-22 - End Date: 20211022 -
Close Help

This table describes the fields appearing on the dialog.

Field Action
Resource

Click on the drop-down arrow and click on the name of the resource to assign to
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work associated with the element.

To assign multiple resources at once, click on the browse button, then select the
resources to assign from the 'Select Resources' dialog.

(You can type the name of the resource into the 'Resource' field, as long as the
name is one of those defined in the system; if it is not, the assignment will not
validate. As you type, the field auto-fills with names matching the characters that
you have typed.)

Role or Task
Click on the drop-down arrow and click on the required role of the resource in this
task. You cannot type a role into the field.

The field initially defaults to the first role in the defined list; in subsequent
assignment entries, the role defaults to the one posted for the immediately previous
assignment to this or any other element.

Start Date
This field defaults to today's date.

If you want to assign a different start date for the task:
1. Click on the drop-down arrow.

2. Ifnecessary, click on the Left or Right Arrow to select the previous or next
month.

3. Click on the appropriate day of the month as the start date.
The field immediately changes to the selected date.

End Date
This field defaults to today's date.

If you want to assign a different end date for the task:

1. Click on the drop-down arrow.

2. Ifnecessary, click on the Right Arrow to select the next month.
3. Click on the appropriate day of the month as the end date.

The field immediately changes to the selected date.

Save / Save & Close

To save the resource allocation you have defined, click on one of the 'Save' buttons.

If you intend to define further resource allocations for the same model element,
click the Save button - the dialog will remain open, ready for you to create another
allocation.

When you have finished creating allocations for the selected model element, click
'Save & Close' (or 'Close'), to close the dialog.

Modify Existing Resource Allocations

Existing resource allocations can be modified directly on the Gantt chart, by dragging the start or end dates to a new
position on the time line, or by dragging the entire task to a new position.
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Resource Allocation
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The percentage completed can also be updated by clicking on the value and dragging a slider (or using the left and right

arrow keys) to select a new value.

Resource Allocation

B X EH o@
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If the Properties window is visible, the resource allocation's properties can be updated there, by simply entering new
values. Similarly, if the Notes window is visible, entries for Description and History can be updated directly in the Notes

window.

Enterprise Architect 0 x
Browser ~ % Inspector v %
oWt L= FH

Project Context Diagram Resour., Defails Trace Summary  Status

B Maintenance - 1] View Basket - add: alter quantity aga

4 B1 Phase b B Relationships
4 B3 Changes B Discussions
= B Requirements
Te Changes B Constraints
B Changes B Scenarios
7 «Functionals Creat =l Linked Features
i «Functionals View B Files
i3 «Functionals View 4 '8 Testing
4 £ lssues 4 [0 unit
= B [ Mot Run ] Alter Quant
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Enterprise Architect
Resource Allocation
nX H a@

Resource Complete

19

A AlmaCogan 60
4
Properties -
=-#)
Resource Allocation
Resource Alma Cogan
Role or Task Use Case Modeller
Start Date 2021-10-20
End Date 2021-10-25
Complete % 60
Expected Time 0

Allocated Time
Time Expended

0
o

October 2021

20 21 22 3

( I

% Notes

B

¢ % & El
Description

Use Case for altering and updating the quantity of line items in the
Shopping Basket.

History
2021-10-22 1:17:10 PM
Determine workflow for updating Quantities of items in Basket.

Use '+' and "' buttons, allow gyertyping of value and provide ‘Remove’
butten.

Novem
01

Alternatively, you can use a dialog designed specifically for this purpose.

To use the dialog, first select the model element for which to modify resource allocations; then, in the Resource
Allocation window, double-click the allocation to be modified, or right-click and choose the menu option 'Modify

Resource'.

Modify Resource Allocations Dialog
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The "Modify Resource Allocations' dialog, is used to update the details of existing Resource Allocations.

. X
Assigned Resources

Detail

Resource: Alma Cogan

Description | History
B Il EE

Start Date: 2021-10-20
Resaolve

End Date: 2021-10-25

Milestone

Wt ng D

pse Case for altering and updating the quantity of line items in the Shopping Basket.

Expected Time: 1] Allocated Time: 1]

Complete %: 80 Time Expended: 0

New

Role or Task: | Use Case Modeller

Close Help

This table presents a detailed description of each field on the 'Modify Resource Allocations' dialog and how it is intended

to be used.

Field

Action

Resource

Click on the drop-down arrow and click on the name of the resource to assign to
work associated with the element.

To assign multiple resources at once, click on the browse button, then select the
resources to assign from the 'Assign Resource' dialog.

(You can type the name of the resource into the 'Resource’, as long as the name is
one of those defined in the system; if it is not, the assignment will not validate. As
you type, the field auto-fills with names matching the characters that you have

typed.)

Role or Task

Click on the drop-down arrow and click on the required role of the resource in this
task. You cannot type a role into the field.

The field initially defaults to the first role in the defined list; in subsequent
assignment entries, the role defaults to the one posted for the immediately previous
assignment to this or any other element.

Description

Type (and, if you prefer, format) a description of the work being done by the
resources.

History

As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task.

Expected Time

Type in the number of time units the task is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.
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Allocated Time
Type in the number of time units the task can be spread over. (The value must be an

integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

Complete %
If the task is already in progress, type in the current percentage completion.

Time Expended
(When the task is eventually 100% complete, you will type in the number of time

units it actually took. The value must be an integer, so you cannot record part
units. )

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Start Date
This field defaults to today's date.

If you want to assign a different start date for the task:
1. Click on the drop-down arrow.

2. Ifnecessary, click on the Left or Right Arrow to select the previous or next
month.

3. Click on the appropriate day of the month as the start date.
The field immediately changes to the selected date.

End Date
This field defaults to today's date.

If you want to assign a different end date for the task:

1. Click on the drop-down arrow.

2. Ifnecessary, click on the Right Arrow to select the next month.
3. Click on the appropriate day of the month as the end date.

The field immediately changes to the selected date.

Notes

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if User Security is enabled, you must have
'Manage Project Settings' permission to perform Resource Allocation

e Ifyou allocate resources to Use Cases, the information you enter contributes to the Use Case Estimation calculation
for estimating the project size in terms of time, resources and cost

e To edit existing Resource Allocation items for this element, display the allocation in the 'Assigned Resources' dialog
by either:
- Clicking on the 'Construct > Resource Management > Resources' ribbon option, right-clicking on the required
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item in the Resource
Allocation window and selecting the '"Modify Selected' option
- Double-clicking on the item in the Resources list in the 'Details' tab of the Inspector window or
- Clicking on the item in the 'Element View' tab of the Project Gantt Chart

®  You can also edit an existing Resource Allocation using the Properties window for that selected item; the fields
behave in the same way as those described in this topic

e To delete existing Resource Allocation items for an element, click on the item in the Resource Allocation window

and click on X in the window toolbar
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Assign Multiple Resources

When you have a large unit of work associated with an element - such as a Package element - you might want to assign
several resources to that element to perform that unit of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of them together in one operation, using the 'Assigned Resources
dialog.

Al

This dialog is also used to edit Resource Allocations entered previously through either the same dialog or the Resource
Allocation window.

. x
Assigned Resources

Dretail
Resource: - Fole ar Task:

Description | History

B I U A - i v

Start D ate:; 19/07/2021 - Expected Time; 0 Allocated Time:
Resolve
Erd D ate: 19072021 - Complete % s Time Expended: a
Mileztone
Mew Cloze Help
Access

First, select an element, then:

Ribbon Construct > Resource Management > Gantt > Element View > right-click on
element > Assign Resource

Other On the Resource Allocation window, right-click on a resource assignment and click
on the 'Modify Selected' option

Assign Multiple Resources to an Element

Option Action

Resource (To assign a single resource, simply type in the name or click on the drop-down
arrow and select the name from the list. In Project Management, it is simpler to
assign single resources directly through the Resource Allocation window.)
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For multiple resources, on the 'Assigned Resources' dialog, click on the l_l button
on the 'Resource' field to display the 'Assign Resource' dialog.

1. Select the checkbox against each resource to assign to the element; to select all
resources listed, click on the Select All button.

2. Click on the OK button to close the dialog and to add the selected resources to
the 'Resource’' field.

The 'Resource' field now shows the selected resources, but grayed out. The
drop-down arrow also is not active. To change the resources in the field, click on

the l_l button again and select/clear the appropriate checkboxes.

Role or Task Either:
e Type in the role name or task that is common to all the selected resources, or

e  (Click on the drop-down arrow and click on the role that is common to all the

resources

Description Type (and, if you prefer, format) a description of the work being done by the
resources.

History As the task progresses, you add text to this tab to record the activities, progress,

problems and outcomes of the task.

Start Date This field defaults to today's date.
If you want to assign a different start date for the task:
1. Click on the drop-down arrow.

2. Ifnecessary, click on the Left or Right Arrow to select the previous or next
month.

3. Click on the appropriate day of the month as the start date.
The field immediately changes to the selected date.

Expected Time Type in the number of time units the task is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.

Allocated Time Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

End Date This field defaults to today's date.
If you want to assign a different end date for the task:
1. Click on the drop-down arrow.
2. Ifnecessary, click on the Right Arrow to select the next month.

3. Click on the appropriate day of the month as the end date.
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The field immediately changes to the selected date.

Complete % If the task is already in progress, type in the current percentage completion.

Time Expended (When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)

The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of

hours or a number of days; use the smallest practical unit that you can record as a
whole number.

Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Milestone This checkbox and drop-down list allow linking the end date to the date of a
Milestone element that is no more than seven days old.

(Milestone elements form part of the structures developed using the Project
Management Technology, which you can activate by selecting the 'Start > All
Windows > Perspective > Construct > Project Management' ribbon option.)

Click on the checkbox to activate the field, then click on the drop-down arrow and
select the Milestone element from the list.

Previous Click on this button to display the previous resource record in the sequence.
Next Click on this button to display the next resource record in the sequence.
New Click on this button to clear the fields on the dialog so that you can define a new

resource allocation.

Apply Click on this button to apply the changes to the currently-displayed element on a
diagram, without closing the dialog.

OK Click on this button to save the data you have entered, and close the dialog.
Close Click on this button to discard the data you have entered, and close the dialog.
Help Click on this button to display this Help topic.

Notes

e  When the resource details are displayed on the Project Gantt Chart or Resource Allocation window, each resource
has their own record containing, initially, the same data; however, each resource can be monitored and their progress
recorded separately

e Ifyou assign resources that are already in a multiple resource assignment to the selected element, a prompt displays
for you to confirm that you are updating the assignment of that resource, or now omitting that resource from the
existing assignment
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Effort Management

In Enterprise Architect, the Project Manager can allocate effort (as time) to work on a given model element. To select the
element to which to allocate effort, click on the required element in the Browser window or a diagram.

Access
Ribbon Construct > Project Management > Effort : right-click | Add New
Keyboard Shortcuts Select an Effort item on a diagram or on the 'Details' tab of the Inspector window,

then press Shift+Enter

Enter effort allocation details for an element

Effort
Type the name or a brief description of the effort.

Type
Type in the effort type or click on the drop-down arrow and select the type. The
selection list is drawn from the global Effort Type list, but any new efforts you type
in this field are not added to the list.

Time
Type in the amount of time the effort is expected to expend.

Notes
Type in any additional notes or description of this effort.

OK

Click on this icon to save the data you have entered and to add the entry to the
'Effort' list in the Effort window and the 'Details' tab of the Inspector window, and
close the dialog.

Cancel
Click on this button to discard the data you have entered, and close the dialog.

Notes

e To edit existing Effort items for this element, display the record in the Project Tools window by either:
- Clicking on the 'Construct > Project Management > Effort' ribbon option and on the required item in the 'Effort'
tab of the window, or
- Double-clicking on the item in the Project > Effort list in the 'Details' tab of the Inspector window

e To delete existing Effort items for an element, right-click on the item in the 'Effort' tab of the Project Tools window
and click on the 'Delete' option

e  Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on effort information you enter
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Risk Management

In Enterprise Architect, the Project Manager can allocate the possible weighting of defined risks that might impact work
on a given model element.

To select the element to which to allocate risk weightings, click on that element in the Browser window or a diagram.

Access
Ribbon Construct > Project Management > Risks: right-click | Add New
Keyboard shortcut Select a risk item on a diagram or Element tab of the browser then use Shift+Enter

Enter risk details for an element

Risk
Type the name or a brief description of the risk.

Type
Type in the risk type or click on the drop-down arrow and select the type.
The selection list is drawn from the global Risk Type list, but any new risks you
type in this field are not added to the list. If there are no global risk types defined,
the drop-down arrow is not displayed.

Weight
Defaults to the weighting for the defined type. You can change this weighting if
necessary.

Notes
Type in any additional notes or description of this risk. You can use the Notes
Toolbar at the top of the field to format the text, if you prefer.

OK

Click on this icon to save the data you have entered and to add the entry to the Risk
list in the Risk window and the 'Details' tab of the Inspector window, and close the
dialog.

Cancel
Click on this button to discard the data you have entered, and close the dialog.

Notes

e  The risks described here are not the same as those represented by Risk elements; the risks are properties of a single
element, whilst the Risk element represents something that can impact a range of other elements

e Ifyou select a global risk type from the "Type' drop-down list and the associated "Weight' field is empty, the default
Weight value is allocated to the 'Weight' field on the 'Risks' tab

e To edit existing Risk items for this element, display the record in the 'Risks' dialog by either:
- Clicking on the 'Construct > Project Management > Risks' ribbon option and on the required item in the 'Risks'
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tab of the Project Tools window, or
- Double-clicking on the item in the Project > Risk list in the 'Details' tab of the Inspector window

e To delete existing Risk items for an element, right-click on the item in the 'Risk’ tab of the Project Tools window and
click on the 'Delete' option

e  Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on risk information you enter
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Metrics

The Project Manager can allocate the possible weighting of defined metrics to work on a given model element.

To select the element to which to allocate a metric weighting, click on the required element in the Browser window.

Access
Ribbon Construct > Project Management > Metrics : right-click | Add New
Keyboard shortcut Select a metric item on a diagram or the 'Details' tab of the Inspector window, and

press Shift+Enter

Enter metric details for an element

Field/Icon Description

Metric
Type the name or a brief description of the metric.

Type
Type in the metric type or click on the drop-down arrow and select the type.
The selection list is drawn from the global Metric Type list, but any new metrics
you type in this field are not added to the list. If there are no global metric types
defined, the drop-down arrow is not displayed.

Weight
Defaults to the weighting for the defined type. You can change this weighting if
necessary.

Notes
Type in any additional notes or description of this metric.
You can use the Notes Toolbar at the top of the field to format the text, if you
prefer.

OK

Click on this button to save the data you have entered and to add the entry to the
'Metrics' list in the Metrics window and the 'Details' tab of the Inspector window,
and close the dialog.

Cancel
Click on this button to discard the data you have entered, and close the dialog.

Notes

e Ifyou select a global metric type from the 'Type' drop-down list and the associated 'Weight' field is empty, you can
allocate the default Weight value in the "Weight' field in the 'Metrics' dialog

e To edit existing Metric items for this element, display the record in the 'Metrics' dialog by either:
- Clicking on the 'Construct > Project Management > Metric' ribbon option and on the required item in the
Project Tools window, or
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- Double-clicking on the item in the Project > Metrics list in the 'Details' tab of the Inspector window

e To delete existing Metric items for an element, right-click on the item in the Project Tools window or the 'Details'
tab and select the 'Delete’ option

e Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on metric information you enter
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Show Project Items in a Diagram

When you have created a Project item (Decision, Event, Effort, Risk, Metric), it is useful to make the record visible on its
parent element. You can do this by displaying the record within a "Project' compartment on the element as it displays in a
diagram. Any element that is capable of displaying a compartment, and that has Project items assigned to it, can show the
items in a diagram.

Note that:
e An Event records the action taken for the current model element

o A Decision records the choice taken for the current model element

Show Project Items in Project Compartment

Step Action
1 Open a diagram containing the element for which Project Items exist.
2 Double-click on the diagram background to display the diagram properties dialog.

Click on the 'Elements' tab.
3 In the 'Show Compartments' panel, click on the 'Project' checkbox.

4 Click on the OK button.

Each Project Item now appears in the Project compartment of the element on the
diagram. Items of each type are grouped together so that, for example, all Effort
items on the element are grouped under the heading 'Effort', and all Risk items on
the element are grouped under the heading 'Risk'.
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Effort Types

When setting up the project management parameters for monitoring work on elements, you can create types of effort to
add to the global list of effort types that can be assigned to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays in the 'Type' drop-down list on the 'Effort' page of the Project
Indicators window.

Access

Open the 'Project Indicators' dialog using one of the methods outlined here, then select the "Effort' tab.
Ribbon Settings > Reference Data > Model Types > Project Indicators : Effort

Keyboard shortcut Select an Effort item on a diagram or the 'Details' tab of the Inspector window, then
press Shift+Enter

Add a new effort type to the global list

Click the 'New' button to define a new Effort type

Option Action

Effort Type the name of the effort type. (Or, to edit an existing effort type, click on the
effort name in the Defined Effort Types panel.)

Description Type a short description of the effort type.

Weight Type the default weighting to apply to the effort type.

<note> Type any additional information on the effort type.

Save Click on this button to save the changes that you have made to the dialog.
New Click on this button to clear the data fields ready to define a new effort type.
Delete Click on an entry in the Defined Effort Types panel, and click on this button to

immediately delete the effort type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

e  Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on effort information you enter
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e You can transport effort types between models, using the 'Settings > Model > Transfer > Export Reference Data' and
'Import Reference Data' ribbon options
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Metric Types

Enterprise Architect enables you to add a metric type to the global list of metric types that can be assigned to any
element in the model. The global list of metric types displays in the 'Type' field drop-down list on the Metrics window.

Access

Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Metric' tab.

Ribbon Settings > Reference Data > Model Types > Project Indicators : Metric

Add a new metric type to the global list
Click the 'New' button to define a new Metric
Option Action

Metric Type Type the name of the metric type. (Or, to edit an existing metric type, click on the
metric name in the Defined Metrics panel.)

Description Type a short description of the metric type.

Weight Type the default weighting to apply to the metric type.

<note> Type any additional information on the metric type.

Save Click on this button to save the changes that you have made to the dialog.
New Click on this button to clear the data fields ready to define a new metric type.
Delete Click on an entry in the Defined Metrics panel, and click on this button to

immediately delete the metric type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

e Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on metric information you enter

e You can transport metric types between models, using the 'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Risk Types

Using Enterprise Architect you can add a risk type to the global list of risk types that can be assigned to any element in
the model. The global list of risk types displays in the "Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access

Open the Project Indicators window using one of the methods outlined here, then select the Risk' page.

Ribbon Settings > Reference Data > Model Types > Project Indicators : Risk

Add a new risk type to the global list
Click on the New button to define a new Risk
Option Action

Risk Type Type the name of the risk type. (Or, to edit an existing risk type, click on the risk
name in the 'Defined Risks' panel.)

Description Type a short description of the risk type.

Weight Type the default weighting to apply to the risk type.

<note> Type any additional information on the risk type.

Save Click on this button to save the changes that you have made to the dialog.
New Click on this button to clear the data fields ready to define a new risk type.
Delete Click on an entry in the 'Defined Risks' panel, and click on this button to

immediately delete the risk type.

Close Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes

e  Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on risk information you enter

e You can transport risk types between models, using the 'Settings > Model > Transfer > Export Reference Data' and
'Tmport Reference Data' ribbon options
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Project Task Allocation

Using the Project Gantt View, you can review the allocation of work to elements in the project, focusing on either the
elements that require work, or the resources required to perform the work. The view primarily shows information that is
entered through other windows and dialogs, but once a record exists in the view you can edit it and, for example, add to
or change the resources on an element.

Access

Ribbon Construct > Resource Management > Gantt
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The Project Gantt View

In Enterprise Architect, you can visualize elements and assigned project resources in a Gantt Chart format, to review the
breakdown of work for a specific project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that a Project Manager can quickly see
the current project status using the percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted and identified.

You can also access specialized versions of the Project Gantt View from diagrams, Packages and the Personal Tasks list.

Access

Ribbon Construct > Resource Management > Gantt > Project Gantt View

Project Gantt View

This example shows four resources, two of whom are working in different capacities on one task, and two on another
task. The resource names and roles are listed in the left panel of the chart, together with the actual percentage completion
of each person's work on the task. In the right panel of the chart, completed work is indicated by the green section of the
bar, work yet to be completed but not yet due is indicated in blue, and work not completed and overdue is indicated in
red (as a result of the option to highlight overdue work being applied).

) start Page 34 Project Gantt View. x|

August 2015

Resource Status Role or Task Complete
20 n 22 3 24 25 26 7 P

P P £ P
5 # Cathy Ballantine = |
[E Department Costi... Approved  Project Manager 10% [ S ————~]
= };‘ David Jones F 4
Element Test Stat.. Approved Developer 90% | ——
= & Fred Hopkins = -]
Element Test Stat... Approved  Java Programmer 70% || [ —
= ?{‘ Sally Cooper | e |
Department Costi.. Approved VB Programmer EI LR — |

4 4 » »  Resource View ~ Element View Report View

Tabs of the Project Gantt View

The Project Gantt View has three tabs, the first two of which use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)

View Detail
Resource View When you initially open the Project Gantt View, it defaults to the 'Resource View'
tab, in which the focus is on the current commitments of each allocated resource in
the project.
Element View The Element View lists the elements in the project that have resources assigned to

them, and the resources assigned to each element.
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A Resource report shows how your resources are deployed in your project,
displaying a list of all elements that have resources allocated to them.

Report View

Project Gantt View Facilities

The facilities of the Project Gantt View are common to the Resource and Element Views, and in some cases to all three
tabs, as described here.

Option

Display tasks for today
only, or for another day
only

Display the properties of
the element to which a
resource is assigned

Display the Resource
Allocation details for an
element or resource

Display the Resource
Allocation records for an
element

Assign a new resource to
an element

Change the scale of the
display
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Action

Right-click on the display and select the option:

e 'Show Only Active Tasks for Today' - to show only tasks that are in progress
today

e 'Show Only Active Tasks for Other Day' - to show only tasks that were in
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

Right-click on the element entry and select the 'Show Element Properties' option.

The 'Properties' dialog for the element displays.

Right-click on the entry and select the 'Show Task Properties' option.

The 'Assigned Resources' dialog displays; you can edit the details and, if necessary,
change the resource allocated to the element.

(Also available in the Report View.) Right-click on the entry and select either of the
context menu options:

e 'Show Element Resource Allocation window' (if the window is closed or
hidden)

e 'Find Task in Element Resource Allocation window' (if the window is visible
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.

You can edit the details and, if necessary, change the resource allocated to the
element.

Right-click on an element in the display, and select the 'Assign Resource' option.

The 'Assigned Resources' dialog displays; complete this as for the Resource
Allocation window.

By default, the Project Gantt View shows periods of time in units of days of the
month, each date column being approximately one centimetre wide. Weekends have
a darker fill color.

You can change the scale of the date columns by clicking on the column header,
pressing Ctrl and rolling the mouse wheel. As you do this:

e At one extreme the date columns expand to approximately 2.5 centimetres, and
the date header shows the full date in dd/mm/yyyy format

e Rolling to the other extreme changes the scale of the column from date through
week, labeled month, numbered month and labeled year to numbered segments
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of a decade

This allows you to represent a wide range of tasks on a single chart and to condense
or expand the view - in conjunction with filters - to investigate the short term and
longer term work clearly.

You might want to make broad adjustments to the timeline of an event, which you
can easily do on the Project Gantt View itself. For example, the resource is ill, or
another resource has taken over other tasks that the resource was allocated to. In
neither case has the task itself changed, but in the first case the resource needs a
longer elapsed time in which to complete the task, and in the second they have less
other work to do and can finish the task sooner.

To make these adjustments, you simply drag the right end of the time bar further or
back along the chart. This changes the task end date to wherever you drag the time
line to, and adjusts the division into complete and incomplete/overdue work to
maintain the percentage completion value. The work time allocated to the task does
not change.

If you drag the left end of the time line, this moves the whole line without changing
its length or proportions; you are just indicating that the task started earlier or later
and will finish earlier or later by the same amount of time.

A resource is likely to be allocated to several tasks either simultaneously or
consecutively. In the Resource View the tasks assigned to a resource are grouped
under the resource name, and a narrow group bar displays in gray on the chart
against the name, spanning the period from when work is scheduled to begin on the
first task to when work is scheduled to finish on the final task.

Similarly, a body of work, represented by an element, might involve several
resources starting and finishing at different points. The resources are grouped under
the element name and the group bar displays on the chart against the element name,
spanning the period from when the first resource is scheduled to start work to when
the last resource is scheduled to complete work on the task.

If any adjustments are made that impact the initial start point or final completion
point of the work, the end of the group bar automatically adjusts. If any task or
resource in the group is overdue, the group bar turns red to reflect that there is a
potential problem in the allocated work.

(This feature takes effect under your user ID.)
Right-click on the window and select the 'Apply Element Status Filter' option.

The 'Excluded Status Types' dialog displays; select the checkbox against one or
more statuses to exclude elements having those statuses from the list.

You can select every checkbox at once by clicking on the Select All button, and
clear all selections by clicking on the Clear All button.

Click on the OK button to immediately apply the filter, which stays in effect until
you specifically change it.

Right-click on the list and select the 'Show Filter Bar' option.

The Filter Bar displays underneath the heading bar. Type a text string in the field
above a column to immediately filter the list for entries that have the text string in
the values in that column.

To delete a filter string altogether, click on the blue cross at the right of the field.

If you no longer want to use the filter bar, right-click on the list and select the 'Hide
Filter Bar' option.

The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:
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Identify overdue tasks

Display ONLY overdue
tasks

Refresh the report

Reposition the Project
Gantt View to
automatically show the end
date of a selected allocation

Reposition the Project
Gantt View to show the
start date or end date of an
allocation, or today's date

Locate the element in the
Browser window

Send a Model Mail to the
resource

Save an image of the
Project Gantt View to file
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e 'Include Completed Tasks Within the Last ..." - to display incomplete tasks and
tasks completed only within the specified period; you can set this period to 7,
30 or 90 days, or you can include all completed tasks, or hide all completed
tasks

e 'Include Future Tasks Starting in ..." - to display current incomplete tasks and
completed tasks (depending on the setting of the 'Include Completed Tasks
Within the Last ..." option) and future tasks that have been recorded and are due
to start within the next period; you can set this period to 7, 30 or 90 days, or
you can show all tasks that have been recorded but are not yet due to start

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

e 'Show in Red' - to display the uncompleted percentage of the task bars for
overdue items on the Gantt chart in red

e 'Show in Red to Current Date' - to extend the task bars of the overdue items to
today's date, and display them in red

e 'None' - to cancel any overdue item highlighting that has been set

Right-click on the display and select the 'Show Overdue Items Only' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

Right-click on the entry and select the 'Refresh' option.

The content of the display is refreshed and collapsed to element or resource level.

Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation the display adjusts to show the end date of the task in the center of the
chart.

Right-click on the entry and select the required option:

e Go To| Task Start Date

e Go To | Task End Date

e Go To| Today's Date

The display shifts to put the required date in the center of the chart.

(Also available in the Report View.) Right-click on the element name and select the
'Find in Project Browser' option.

The area of the Browser window containing the element is brought into focus and
expanded, and the element is highlighted.

It is possible to send a Model Mail directly from the Project Gantt View to a
selected resource if the resource's Author name matches their:

e Enterprise Architect security user ID (Security has been enabled) or
e  Their workstation login ID (Security has not been enabled)

Right-click on the resource or one of their activities and select the "Post Model
Message' option. This opens a Model Mail message addressed to the resource, for
you to complete and send.

Right-click on the tab and select the 'Save Image to File' option.

The 'Save As Image' dialog displays, on which you specify the file name, location
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Save an image of the
Project Gantt View to the
clipboard

Notes

and graphics file type to save to.
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Right-click on the tab and select the 'Copy Image to Clipboard' option.

You can paste the image from the clipboard into your preferred graphics

application.

e Items in the list pane can be filtered; right-click on the column headings in the list pane to toggle the Filter Bar
between hidden or shown, or to edit the filter
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Resource View

The Resource View' tab shows the current commitments of each allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.

The display initially shows the resources and their overall commitment; click on the 'plus-box' to the left of the name of
the resource to expand the entry to show the elements and the allocation period for each element.

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete allocations one month after the end date. Tasks you can perform
include checking the:

e Dates on which specific resources or all resources are currently allocated
e FElements to which each resource is allocated

e Dates on which a resource is allocated to work on a specific element

e General progress of the resource in completing the work

e  Specific details of the allocation of a resource to an element and task or role

Access

Ribbon Construct > Resource Management > Gantt : Select the 'Resource View' tab
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Element View

The "Element View' tab of the Project Gantt View lists the elements in the project that have resources assigned to them. It
shows the resources assigned to each element as a list of allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or task is assigned but no specific resource has been identified.

The display initially shows the elements and their overall resource commitment; click on the "plus-box' to the left of the
name of the element to expand the entry to show the resources and the allocation period for each resource. You can then:

e  Check the dates on which specific elements have resources currently allocated

e Check which resources are currently allocated to an element

e Assign further resources to the element

e  Check the dates on which a resource is allocated to work on a specific element

e  Check the general progress of the resource in completing the work

e Check the specific details of the allocation of a resource to an element and task or role

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date.

The 'Element View' complements the 'Resource View' and 'Personal Tasks View' of work allocation on the project.

Access
Ribbon Construct > Resource Management > Gantt or
Design > Diagram > Views > Gantt View
Context Menu Browser window | right-click on an open diagram | Switch View | Switch to Gantt

View
In diagram, right-click on background | Switch View | Switch to Gantt View
Browser window | Right-click on Package | Open Package in | Gantt View
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Report View

The Report View shows how your resources are deployed in your project, displaying:
o A list of all elements that have resources allocated to them, and the type of each element
e The resource allocated, and the role played by that resource

e  The start and end dates of the allocation

e  The time allocated, expected and expended

e The percentage completion of the allocation

You can tailor the displayed information by:

e Hiding columns of information

e  Grouping types of information

e  Filtering the data by status

e Filtering the data by start date or end date

e  Filtering any column to show only a specific value

Having displayed the information you require, you can print it.

Access

Ribbon Construct > Resource Management > Gantt : Select the 'Report View' tab

Report View Options

Option Action

Run the report Click on the first icon in the Report View toolbar (the rotating arrows).
The report results display.
If you have the report open for a while, you can update the information; either:
e Run the report again or

e Right-click on the content and select the 'Refresh' option

Adjust column headings Drag and drop column headings into the sequence you require.

Right-click on the column headings and select the 'Field Chooser' option, to add or
remove columns using the 'Field Chooser' dialog.

Group entries by column Right-click on the column headings and select the 'Enable Group Box' option, to

heading cluster the report information according to your preferred hierarchy of column
headings.

Filter columns Either:

e Click on the third toolbar icon from the right (the spy glass), or
e Right-click on the column headings and select the 'Toggle Filter Bar' option
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The filter field displays at the top of every column.

Type in whatever text string you require in the appropriate column to filter the
report to show only entries containing that text string in that column.

Filter by degree of In the first field in the toolbar, click on the drop-down arrow and select one of these
completion values:

e 'All'- Display all entries regardless of degree of completion

e 'Completed' - Display only those entries where the allocation is 100%
completed

e 'Above cut-off' - Display only those entries that are more than a certain
percentage complete

e 'Below cut-off' - Display only those entries that are less than a certain
percentage complete

In the second field in the toolbar, either type a threshold value or increment to the
value using the up/down arrows, to set the percentage completion for the
'Above/Below cut-off' options.

Filter according to start/end Click on the fourth toolbar icon from the right (the funnel).

date The "Resource Filters' dialog displays.

In the 'Start Date' and/or 'End Date' field, click on the drop-down arrow and select
the appropriate qualifier:

o 'After
e 'Before'
e 'Equal To'

e 'Not Equals'

In the date fields, click on the checkbox to activate the fields and either type in the
day, month and year or click on the drop-down arrow to select the date from a
calendar.

The fields have an AND relationship; an entry must satisfy both date criteria before
it is displayed.

Print the report Either:
e  Click on the second toolbar icon from the right (the printer) or
e Right-click on an entry in the report and select the Print' option

The 'Print' dialog displays, on which you specify the printer to use and the
characteristics of the print job.

(c) Sparx Systems 2025 Page 92 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

Progress Bars

Progress bars are horizontal bands that show the degree of completion of a task or process. They give a quick indication
of the current status of, for example, projects, tasks or budgets, which can be useful for checking how close a task or
project is to completion or if a project is coming close to hitting its total allowed budget.

Progress bars can be especially useful in large projects that consist of multiple smaller projects, as you can display within
one element separate bars showing the degree of completion of each sub-project and of the main project, giving you an
overview of progress at a single glance. Separate elements within the diagram can contain further progress bars for the
metrics of the individual projects, adding levels of detail that can, again, be assessed in a brief review.

In Enterprise Architect, progress bars are implemented using Tagged Values on elements. They are automatically added
to elements on a Kanban diagram or Construction diagram, where progress or resource consumption are indicated.

Release 10.2.5

Total Completion
— ] 59%

Budget
Total Cost
—— ] 5270,000

Projects

Project Anubis
(I ——— ]
Project Hades

AN

Project Hades Project Anubis
Cost Cost
IEee—— ] 150,000 s 1 5180,000
Progress Progress
[— 1 37% complete —— ] 32% complete
Tasks Tasks
Deploy Deploy
[ ] I — ]
Design Help Topics
P ————— I ———————— /1
Help Topics
[E—— ]
Implement
I R ]
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Using Progress Bars

You can add progress bars to any element that can show compartments and that can display any numerical value within a
range, when displayed on a diagram.

Progress bars can be used to display things such as:
e The current progress of a task or project
e How much of project's budget has been used

By default a progress bar will display a value between 0 and 100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values required.

This illustration shows an example of a default progress bar:

‘ Project Alpha ‘

(— ]

Progress ‘

Creating a Progress Bar using a new Tagged Value

Follow the steps below to display a progress bar within an element, using a simple Tagged Value.

Step Action

1 On a diagram, create an element that can display compartments (such as a Requirement or Feature) and
add a simple Tagged Value to it.

2 From the 'Tags' tab of the Properties window open the tag's notes and add 'Type=ProgressBar;' (including
the semi-colon) and then click on the OK button.

Tagged Value Note x

Type=ProgressBar;

(o)) Cancel Help

(You can add further options to the Tagged Value, as described in the Additional Progress Bar Options
table.)

3 Click on the element and either press Ctrl+Shift+Y or right-click and select the 'Compartment Visibility'
option. The 'Compartment Visibility' dialog displays.
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4 Select the 'Tags' checkbox in the 'Show Element Compartments' panel, then click on the OK button.
The progress bar will now display on the element on the diagram, with the Tagged Value name above the
bar.

5 In the 'Tags' tab of the Properties window, indicate progress by typing a number between 1 and 100 into

the 'Value' field for the tag. On the diagram, the appropriate length of the progress bar is filled in green.

Creating a Progress Bar from the 'UML Types' dialog
You can also define a progress bar Tagged Value from the 'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.

Step Action

1 Select the 'Settings > Reference Data > UML Types' ribbon option to display the 'UML Types' dialog and
click on the 'Tagged Value Types' tab.

2 In the 'Tag Name' and 'Description’ fields, type a name and description for the Tagged Value. In the

'Detail' field type the option parameters and their values for the Tagged Value. Click on the Save button
and on the Close button.

E' um Types

- Stereotypes

W i Tag Name: Description: Current project completion
- Cardinality Val
ardinality Values Detail
Type=ProgressBar;
Text=#Value#%:;
New Delete
Defined Tag Types:
Type Description
Completion Current project completion

(The option parameters are described in the Additional Progress Bar Options table.)

3 Select the 'Start > Application > Design > Properties' ribbon option to open the Properties window (if it is
not already open) and select the 'Tags' tab.

On a diagram select an element, then on the 'Tags' tab click on the gl (New Tagged Value) button.

In the 'Tag' field of the Tagged Value dialog, click on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.
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4 On the diagram, right-click on the element and select the 'Compartment Visibility' option to display the
'Compartment Visibility' dialog.

5 Select the 'Tags' checkbox and click on the OK button.

6 On the 'Tags' tab, change the number in the value field a few times, clicking off the field each time. Notice
the effect this has on the progress bar.

Creating a Progress Bar using the Custom Drawn Element

Custom-drawn elements allow the use of the element's fill color to represent the progress in the progress bar, so the
element itself becomes the progress bar.

Progress Bar o x
%g Progress Bar. Clasz Diagram Pr-oper-tles 0O x
=-FH b -
ALY ) ﬁ Element Tags
Class1 jg |2 ME X | O B
% Class ((las=s1)
% Progress 25

Tagged Value Note

Type=ProgressBar;
FilElement=true;
FillClr=Green;
BorderClr=elementtext;

Is | Properties

OK Cancel Help

4 .4

To display progress using the element's fill color as the progress bar, setup a Tagged Value for the progress bar as
described in the previous sections, then add the following line to the Tagged Value's Notes: FillElement =true; You
will also need to set the Diagram property "Appearance > Custom Style", by placing a check against that property.

You can set the fill color, background color and border color, by adding further parameters to the Notes of the Tagged
Value.

For example:
e  FillClr=val,
e BackClr=val;

e BorderClr=val;

When setting the colours of a progress bar, 'val' can be supplied in a variety of ways, such as:
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e RGB(0,128,0);
e HSL(300, 50,86);
e #00FFO0;
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Default web colour names such as AliceBlue, Green or Khaki can also be used. Additionally, it is possible to use the
current fill, line, or text color of the element for the properties mentioned above by using ‘elementfill’, ‘elementborder’,

or ‘elementtext’.
For example:
e FillClr=elementfill;

o  BorderClr=elementtext;

Examples of Setting Colors When Displaying Progress Using Element Fill Color

Example

Using Hex Values

Using HSL, RGB and
Default HTML Colors

Using RGB and Current
Element Fill and Border
colors

Using the current element
fill

Tagged Value Note

Type=ProgressBar;
FillElement=true;
FillCIr=#2F4550;
BorderClr=#629677,
BackCIr=#586F7C;

Type=ProgressBar;
FillElement=true;
FillClIr=hsl(210,100,97);
BorderClr=RGB(23,12,202);
BackClr=LightSeaGreen,;

Type=ProgressBar;
FillElement=true;
FillClr=rgb(230,214,239);
BorderClr=elementline;

BackClr=elementfill;

Type=ProgressBar;

FillElement=true;

FillClr=elementfill:s=-30:1=70:;

BorderClr=elementline;
BackClr=elementfill;

e In this example the current element fill is used for both the fill color of the
progress bar as well as the background color. However, the fill color is
modified from the original element fill to be less saturated (30% less) and

brighter (70% increased luminosity):

Additional Progress Bar Options
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A default progress bar will show the Tagged Value name and reflect values in the range 0-100. You can change the range
values if required, and display text to the right of the bar if more information has to be provided. The background, border
and fill colors of the progress bar are, by default, determined by the currently-applied inbuilt diagram theme. However,
you can apply your own colors to one of more of these properties.

Add these parameters to the Notes field of the Tagged Value, to enhance the progress bar.

Parameter

MinVal

MaxVal

Text

Compartment

(c) Sparx Systems 2025

Description

Use the MinVal option to set the lowest allowed value to be represented on the
progress bar.

e Syntax: MinVal=<number>;

A progress bar with the setting MinVal=10; will start at 10. Values lower than 10
will not be shown on it.

If a maximum value (MaxVal) has been defined, the progress bar will show any
values between MinVal and MaxVal (inclusive); otherwise, the maximum value
will default to MinVal + 100. So, if MinVal=10, the progress bar can show values
between 10 and 110 (inclusive).

Use the MaxVal option to set the highest allowed value to be represented on the
progress bar.

e Syntax: MaxVal=<number>;

A progress bar with the setting MaxVal=300; will show values up to and including
300. Values higher than 300 will not be shown.

If a minimum value (MinVal) has been set, the progress bar will show any values
between MinVal and MaxVal (inclusive); otherwise the minimum value will
default to 0. So, if MaxVal=300 the progress bar can show values between 0 and
300 (inclusive).

Use the Text option to define additional text to display on the right hand side of the
progress bar. The text might be a resource name or the current take up of the total
allowed budget of a project.

e Syntax: Text=<text>; - displays the defined text string, such as 'David Brown's
Tasks'

e Syntax: Text=#Value#; - displays the value of the progress bar Tagged Value,
such as '462' (where the Tagged Value name itself might indicate the type of
value or unit)

e Syntax: Text=<text> #Value# <text>; - displays the value of the progress bar
Tagged Value with text before and/or after it, such as '$<value> of $100,000'

This illustration shows a number of examples of using the Text option.

Project Alpha

Development

5150,000 / $300,000

Implement

Terry
Marketing

$250,000 / $300,000
Progress

80% Complete

By default, progress bars in an element display together in a separate compartment
from other types of Tagged Value (provided that the diagram and/or element is set
to display tag compartments).
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BackClr

FillClr

BorderClr
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When there are several progress bars on an element, each relating to a different
factor of the project, it can become harder to distinguish between them. In these
cases it is possible to set the progress bars to display in specific compartments in
order to increase clarity. This also provides an additional level of labeling. So you
might have an element relating to costs, and two or more compartments that
indicate costs of different departments, where the department name is reflected in
the compartment name. Or compartments that each contain two or more progress
bars indicating, say, the costs and percentage completion of tasks in each
department.

e Syntax: Compartment=<name>;

To add multiple progress bars to the same compartment simply give the progress
bars the same compartment name.

This example shows the element from the Text parameter example, but with the use
of compartments to aid in readability.

Project Alpha

Progress
————————— | 20% Complete

Budget
Development
e 1 $150,000 / $300,000
Marketing
e EETE}MYNYNYNYSYSY—1 5250,000/ $300,000

Tasks

Implement
e ———— | Terry

Use the BackClr option to override the color used for the unfilled portion of the
progress bar.

e Syntax: BackClr=<color>;

<color> can be one of a variety of values, such as the RGB value rgh(198,198,198)
for a light gray color.

See the Progress Bar Color Options table for a full list of available values when
setting colors.

Use the FillClr option to override the color used for the filled portion of the
progress bar.

e Syntax: FillClr=<color>;

<color> can be one of a variety of options, such as the hex value #0000ff for a
bright red.

See the Progress Bar Color Options table for a full list of available values when
setting colors.

Use the BorderClr option to override the color that is drawn around the edges of the
progress bar.

e Syntax: BorderClr=<color>;

<color> can be one of a variety of options, such as the keyword elementtext to
select the same color as the current element's text color.

See the Progress Bar Color Options table for a full list of available values when
setting colors.

Page 99 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

Example

The Requirement element 'REQO15 - Process Credit Card Payment' is given a Tagged Value named 'Completion’, with a
value of '66'".

Properties 0o
a = - B

Element Tags

EH R X B
Requirement (REQ015 - Process Credit Card Payment)
Completion EE|

In the Tagged Values Notes, we specify "Type=ProgressBar;' along with display text and color settings.

Tagged Value Note

Type =ProgressBar; Text=#Value #% Complete;
FillCir=rgb(192,255,132); BackClr=rgh{255,128,128);|

0K Cancel Help

The result is the Progress Bar seen here:

m P, ]
REQO15 - Process Credit Card Payment E

Completion

:
o1
[ m— 66% Complete | (R
|

All payments will be via credit card. All major
credit card types will be accepted and approval
time shall be less than 2 minutes except where
fraud checks fail.
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Progress Bar Color Options

This table lists the different types of value that can be used with the options BackClr, FillClr and BorderClr when setting
custom colors for a progress bar.

Value Description

rgb(red,green,blue) Using rgb values you can set the red, green and blue color components to create the
color you require.

Example:

BackClr=rgb(46, 139, 87); //Sets the unfilled portion of the progress bar to a sea
green color.

e The red, green and blue values each have a range of 0 to 255

This option can be useful in conjunction with the color pickers from the 'Layout' tab
as they give an RGB value for the currently selected color.

hsl(hue, saturation, Using hsl is very similar to using rgb. Unlike rgb, however, it is easier to create a
luminosity) lighter or darker version of the same color by simply adjusting the luminosity, or to
increase or decrease the intensity of the color by adjusting the saturation.

Example:

FillClr=hsl(197, 71, 73); //Sets the filled portion of the progress bar to a sky blue
color.

e  The hue value has a range of 0 to 360

e The saturation and luminosity values each have a range of 0 to 100

Hex Values Colors can also be defined using a hex value.
Example:
BorderClr:#000000; //Sets the border color of the progress bar to black.
e Hex values range from #000000 to #{fffff

HTML Color Names It is also possible to use the standard web color names when defining a color for
progress bars.

Example:

fillclr=aliceblue; //Sets the filled portion of the progress bar to the standard color
'aliceblue’

e  Enterprise Architect supports the 140 standard HTML color names.

Element Colors Using ElementFill, ElementLine or ElementText will set the color value to the fill,
line or text color of the currently-selected element (that is, ElementFill will apply
the element's current fill color).

Colors set this way can be further refined by using the modifiers s=<value> and
I=<value> to modify the color's saturation and luminosity, making the color
assigned to the progress bar a slightly altered version of the currently selected
element color.

These settings can be useful if the element is expected to change color (such as
from the use of a Diagram Legend) to keep the progress bars themed correctly with
the element.

Example:
backclr=elementfill:s=-10:1=20:; //Sets the unfilled portion of the progress bar to
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be the same as the element's fill color but with a 10% decrease in the color's
saturation and a 20% increase in the luminosity.

e s and 1 can be any value; however, the results can vary depending on the
currently selected color (for example, a luminosity increase of 20% might not
be as noticeable on a very light color compared to a darker color)

none The none keyword is used to indicate that no color should be applied to the selected
field.

Example:

borderClr=none; //Removes the border from the progress bar.

Progress Bars with MDG Technologies

Progress bars can also be created within MDG Technologies to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks

Using the Personal Tasks view, you can record and manage your personal work within the project. This view displays
information based upon your identity as a defined Author on the project.

Access
Ribbon Start > Personal > My Gantt
Work Category
Category Detail
Allocated Work Presents a Gantt chart on which you record the work that you are currently engaged
in.
Project Tasks Enables you to monitor and maintain the work tasks that have been assigned to you,

or that you have created yourself.
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Review Allocated Work

The 'Allocated Work' tab lists the elements to which your model Author ID has been allocated as a resource, where your
Author ID is the same as:

e  Your Enterprise Architect security user ID, if security has been enabled, or
e Your workstation login ID if security has not been enabled
For each element, the tab:

e In the left-hand panel lists the roles or tasks assigned to you as a resource on that element, for which the 'Complete
%' field value is less than '100'

e In the right hand panel displays a Gantt chart showing your progress in performing each role or task

You can add further work items for an element through the 'Allocated Work' tab; however, you cannot delete any
records. A record is no longer listed when the 'Complete %' field value is '100'".

You or your supervisors can also add records through the Resource Allocation window.

Access

Ribbon Start > Personal > My Gantt > Allocated Work

Select Allocated Work options

Option Action

Review element properties Double-click on the element name.

(Alternatively, right-click on the element name and select the 'Show Element
Properties' option.)

The "Properties’ dialog for the element displays; review the pages as required.

Review resource task Double-click on the task item.
details (Alternatively, either:
e Double-click on the progress bar for the item on the Gantt chart, or

e Right-click on the task or role name and select the 'Show Task Properties'
option)

The 'Assigned Resources' dialog displays, which has the same content, format and
functions as the Resource Allocation window, in 'Ttem' mode.

Should it be necessary to reassign the item to another resource, click on the
drop-down arrow on the 'Resource' field and select the appropriate 'Author ID';
when you save the changes, the item no longer appears in the list of tasks assigned
to you.

Create new task item Right-click on the element name and select the 'Add Resource' option.

The 'Assigned Resources' dialog displays, with your Author ID in the grayed-out
'Resource' field.

Complete the dialog as for the Resource Allocation window.
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Refresh display to
incorporate changes

Display the Resource
Allocation records for the
element

Display tasks for today
only, or for another day
only

Filter the display by Start
or Completion date

Identify overdue tasks
amongst the items

Display ONLY overdue
tasks

Locate the element in the
Browser window

(c) Sparx Systems 2025

2 September, 2025

Your work item can be edited in a number of places in Enterprise Architect, such as
the Project Task Allocation window and the 'Resource Allocation' tab; the element
to which it is assigned can be edited in these and many other areas.

To refresh the display with any changes made elsewhere, right-click on the display
and select the 'Refresh’ option.

Right-click on the entry and select either of the options:

e 'Show Element Resource Allocation window' (if the window is closed or
hidden)

e 'Find Task in Element Resource Allocation window' (if the window is visible
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.

You can edit the details and, if necessary, change the resource allocated to the
element.

Right-click on the display and select the option:

e 'Show only Active tasks for today' - to show only tasks that are in progress
today

e 'Show only Active tasks for another day' - to show only tasks that were in
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:

e 'Include Completed Tasks Within the Last ..." - to display incomplete tasks and
tasks completed only within the last period; you can set this period to 7, 30 or
90 days, or you can include all completed tasks, or hide all completed tasks

e 'Include Future Tasks Starting in ..." - to display current incomplete tasks and
completed tasks (depending on the setting of the 'Include Completed Tasks
Within the Last ..." option) and future tasks that have been recorded and are due
to start within the next period; you can set this period to 7, 30 or 90 days, or
you can show all tasks that have been recorded but are not yet due to start

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

e 'Show in Red' - to display the uncompleted percentage of the task bars for
overdue items on the Gantt chart in red

e 'Show in Red to Current Date' - to extend the task bars of the overdue items to
today's date, and display them in red

e 'None' - to cancel any overdue item highlighting that has been set

Right-click on the display and select the 'Show Overdue Items Only' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

Right-click on either the element or the work item and select the 'Find in Project
Browser' option.

The appropriate Package hierarchy expands in the Browser window, and the
selected element is highlighted.
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Reposition the Gantt chart Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
to automatically show the option.

end date of a selected Whilst this option is selected (with a tick next to it), whenever you click on an

allocation allocation in the 'Allocated Work' tab the display adjusts to show the end date of the
task in the center of the chart.

Expose hidden sections of Some items might operate over a long period of time, and you might not be able to
the work item progress display the complete progress line for the item in the Gantt chart.

To locate the start point, expected end point, or today's date on the progress line for
an item, right-click on either the item or the progress line and select the appropriate
option:

e Go To| Task Start Date
e  Go To| Task End Date
e Go To| Today's Date

The Gantt chart shifts left or right to position the required point in the center of the
display.

Execute Scripts If scripts have been defined for analyzing the task data, click on the 'Scripts' option
to display the list of script names. Click on the appropriate name to execute the
script on the selected item or items.

Filter the work items You can refine the list of work items to show only those containing text that
matches the filter item.

Right-click on the tab and select the 'Show Filter Bar' option.
The filter bar displays at the top of the panel; type in the filter text.

As you type, the items listed and the Gantt chart are filtered to show only items
where the item names match the text string.

The filter does not operate on the element names.

If you do not want to use the filter, right-click on the tab and select the 'Hide Filter

Bar' option.
Capture an image of the Right-click on the tab and select the 'Save Image to File' option.
Allocgted Work data as a The 'Save As Image' dialog displays, on which you specify the file name, location
graphics file and graphics file type to save to.

grap yp

Copy an image of the Right-click on the tab and select the 'Copy Image to Clipboard' option.
Alu(l):ateg Work data to the You can paste the image from the clipboard into your preferred graphics
clipboar

application.
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Monitor Your Tasks

The "Project Tasks' tab lists the tasks that you either:
e Own, or
e  Are assigned to

You can use the tab to review the status and progress of tasks that you are responsible for, and to modify and filter the
display of task information. You can create the tasks through the:

e 'Project Tasks' tab of the My Gantt display itself
e  The Project Management Project Tasks view (of all tasks in the project), or the

e 'Project Tasks view of the Resource Calendar

Access

Ribbon Start > Personal > My Gantt > Project Tasks

Make selections from the options

Option Action

Add or Modify a task You add or modify a task through the 'Task Detail' dialog, which displays when you
double-click on an entry (edit) or blank line (create).

Delete a task Right-click on the message and select the 'Delete’ option.

You are prompted to confirm the deletion.

Select columns Right-click on the column headings and select the 'Field Chooser' option, which
enables you to add or remove specific columns from the display.

You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Reorganize tasks in the list Either:

e  Click on the column heading and click on the arrow head to list items in order
or reverse order, or

e Right-click on the column headings and select the 'Enable Group Box' option
to organize the messages into groups

You can also use the filter bar to filter the display on an appropriate column value,
such as the value 'New' in the 'Status' column; to display or hide the filter bar,
right-click on the column headings and select the 'Toggle Filter Bar' option.

Set persistent Status filter Right-click on the tab and select the 'Set term filter' option.

The 'Filter by Status' dialog displays, which enables you to select to list tasks of any
status or only of one specific status.

The filter you set persists when you close the Personal Tasks window or exit from
Enterprise Architect.
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Print the task list Right-click on the tab and select the 'Print List' option.

The 'Print' dialog displays, on which you specify the local printer and the print
characteristics.
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Project Tools Window

The Project Tools window shows the records of these quantities associated with an element contained in the model:

e Decision - a choice made on a requirement of the element

e Event - an action taken on a requirement of the element

e Issue - a failure of the element to meet a requirement

e Task - an item of work on the element assigned to a resource to meet a requirement

e  Effort - effort expended in work on the element

o  Risks - risk associated with the element

e  Metrics - metrics measured for an element

A separate tab of the Project Tools window or - for Issues and Tasks - report list displays for each of these quantities.

Access

Ribbon

Keyboard Shortcuts

Context Menu Options

Construct > Project Management and as required, one of:
e > Events | Show Events Window

e > Decisions | Show Decisions Window

e > Jssues-Tasks | Project Tasks

e > [ssues-Tasks | Project Issues

e > Effort

e > Risks

e > Metrics

Click on the required Project item on a diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

You can add or delete individual items in any of the tabs of the Project Tools window, using the window context menu

options.

Icon

Add New

Modify Selected

Create as New Element

(c) Sparx Systems 2025

Action

Create a new Decision/Event item, using the '<type> details for <element type>
<element name>' dialog, in the same way as you create Maintenance items.

Create a new Risk/Metric/Effort item, using the '<type>' dialog.
Update the selected Decision/Event item, using the '<type> details for <element
type> <element name>' dialog.

Update the selected Risk/Metric/Effort item, using the '<type>' dialog.

Create a new element based on the Project Decision/Event item, in the same way as
you generate elements from Maintenance items.
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Print List Print the list of items.
Delete Delete the selected item from the list.
Notes

e  C(Click on an element in the Browser window to switch to the project management items for that element in the
Project Tools window

o Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided
in the List Header facilities

e Right-click on the list to view the context menu, which you can use to also add and delete items in the window

e  You can move Decision and Event items between elements; see the Move Decisions/Events Between Elements Help
topic
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Move Decisions/Events Between Elements

A Decision or Event you define for one element might be usefully moved to another if, for example, you are moving
your model through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a Decision or
Event from either the appropriate tab of the Project Tools window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access

From the Browser window, open the diagram containing the target element, then click on the element from which to
move the Decision or Event. It is convenient to have both source and target elements on the same diagram, but it is
possible to select the source element in the Browser window or on a different open diagram.

It is also convenient to have compartments enabled on the target element, with the 'project' compartment selected, so that
you can observe the addition of the moved item. (Right-click on the element and select 'Compartment Visibility', then
select the 'Project’ checkbox.)

Ribbon Start > Application > Design > Browser > Element - expand the 'Project' category
or

Construct > Project Management > Decisions > Show Decisions Window

Construct > Project Management > Events > Show Events Window

Keyboard Shortcuts Alt+2 | Project > Decisions or > Events

Move the Decision or Event to the Target Element

Click on the item that you intend to move, and simply drag it onto the target element. The item name will display in the
'project' compartment of that element. What you would observe might resemble this illustration.

Stage 1 Stage 2
project
Decision
Change Conveyor Mew
Event
Bring conveyor online Mew
£

(c) Sparx Systems 2025 Page 111 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

Stage 1 Stage 2
project
Decision
Change Conveyor MNew
Event
Bring conveyor online MNew
£
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Testing & QA

i,
Lo R

It is important in any project to perform quality control of both the process and the output of the project; Enterprise
Architect provides several facilities for testing and validating your model structure and content, including Integration
with the unit testing tools JUnit and NUnit.

Facilities
Facility Description
Testing Create and manage test scripts for model elements. Explore the Testing user
interface, supporting unit, integration, scenario, system, acceptance and inspection
tests.
Model Validation Check UML elements, diagrams or Packages against known UML rules (identified
I in configuring validation) and constraints defined within the model, using the
Object Constraint Language (OCL). Define your own checks against custom rules
. I " and constraints. See the Model Validation Help topic for more information on
setting up model validation rules.
Testpoint Management Pass or fail application tasks, viewing test results in real time as the program

executes and results are saved. See the Help section on Testpoints for more

. J information on setting up and running automated tests.
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Test Management

Enterprise Architect is not only a UML Modeling environment, it is also a complete Test Management environment.
Using Enterprise Architect you can create and manage test scripts for model elements, developing unit, integration,
scenario, system, acceptance and inspection tests; these can include test cases generated from xUnit testing and Testpoint
Management.

You can also import or move tests from other elements, generate them from scenarios, and generate test documentation
and reports; you can indicate the presence of tests on an element by displaying test information in a compartment of the
element in a diagram.

It is simple to attach even complex tests to any model element. Keeping the model elements and the testing
documentation in one integrated model significantly improves the communication between the test-team and the software
developers and architects.

The system's detailed search facilities make it easy to find failing test cases, test cases not run and test cases that have
been passed; using the testing and search capabilities, it is easy to navigate through the model and quickly locate problem
spots, design flaws and other critical issues.

Test Tasks

Tasks Detail

Create Tests You initially create tests in either the 'Test Details' dialog or the Test Cases
window.

Typically, you create:

e  Unit tests for things that are being built, such as Classes and components
e Integration tests to test how components work together

e System tests to ensure the system meets business requirements

e  Acceptance tests to test user satisfaction

e  Scenario tests to test the end-to-end suitability and functionality of the
application

e Inspection tests for peer review of things that are being built using a well
defined process

These test categories are otherwise referred to as test Classes.

There is also a 'Full Test Suite' tab that displays a read-only list of all the Test items
on the element, grouped by type. If you double-click on an item in this list, the
appropriate tab displays with the item highlighted.

Using Tests Tasks that you might perform via the Test Cases window when working with tests
include:

e  Create and edit test records
e Import a scenario from an element or a Package as a test
e [mport an internal requirement or constraint as a test

e Import a test from another element
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e (Create a maintenance item from a test

e  Move or copy tests between test classes

e  Move a test from one element to another

e  Print the list of tests of the current test class for the element
e Delete the test

Notes

e Most of the listed tasks relate to a tests for a single element

®  You can display the Test Cases window for an element on a diagram, by clicking on the element and pressing the T
key

®  You can make a set of tests available to a number of elements by performing the listed tasks on a Test Case element
and then associating that Test Case with each of the other elements; the Test Case element also helps to make tests
more visible in diagrams, the Browser window, windows and searches
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Create Test Records

When you need to create or edit a test record on an element, for any of the six types of test, you can do so using either:
e The Test Cases window (to quickly set up or change test records, and perform operations on them)

e  The 'Test Details' dialog (To create test records with more Notes information, which you can also add through the
Notes window)

e  The Properties window for Test items (to edit the properties of existing tests - see the Properties Window for Test
Items Help topic)

Whichever type of test you are recording, you complete effectively the same fields.

Access
Ribbon Construct > Test Management > Tests > <test class> : overtype Add new
<testtype> (Test Cases window)
Keyboard Shortcuts Click on the element : Alt+2 > Testing : <test class> : overtype Add new
<testtype> (Test Cases window)
Click on the element on a diagram | Press the T key (Test Cases window)
Other On the Test Cases window, double-click on the Test item to display the 'Test

details' dialog

Create a Test Record in the Test details Dialog
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Test details

Test

Test Ignition Use Case

Auto
Description | Input  Acceptance Criteria  Results
BIUE- == %@
Clean test run

Clazs: Init - Type: Standard =
Run

Fun Date: 164072021 E Run By: Hugh Lovyd = i

Fezult Pass = Checked By Jane Ward -

| 44 | | Fr | e Apply | | (] | | Cloze | | Help
Field/Button Action

Test Type the name of the test. This can be any alphanumeric text string you want to
use.

Auto As an alternative to typing in the name, click on this button to insert predefined
auto-counter text; if you do not have auto-counter text configured, an information
message displays.

If you already have some text in the 'Test' field, it is over-written by the
auto-counter text.

Class This defaults to the class of test you selected in displaying the dialog. If this is not
the class you require, click on the drop-down arrow and select the appropriate
value.

Type Click on the drop-down arrow and select the value indicating the type of test (Load,
Regression or Standard). You cannot type in any alternative types.

Click on the check box and then on the drop-down arrow and select the date on
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Run Date

Run By

Result

Checked By

Description

Input

Acceptance Criteria

Results

Apply

OK

New

left chevron/right chevron

Close
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which the test is to be run (or when it was last run).

Click on the drop-down arrow and select the name of the person who is to run, or
has run, the test. The list selection defaults to your name as the current user.

(Possible values are derived from the Project Author definitions in the 'People’
dialog - select the 'Settings > Reference Data > Model Types > People > Project
Authors' ribbon option.)

Click on the drop-down arrow and select the value indicating the current status of
the test (Not Run, Pass, Fail, Deferred or Canceled). You cannot type in any
alternative values.

If you have provided a Run date, when you click on this field it defaults to your
user name as the current user.

If you have not provided a Run Date, click on the drop-down arrow; the list
selection defaults to your user name as the current user.

If you are not the person who is to check, or has checked, the results of the test,
scroll to and select the name of the relevant person .

Type a description of the test; you can format the text using the Notes toolbar at the
top of the field. The text you type here is also shown in the Notes window, under
the 'Description’ heading.

Type in the input data provided to the test; you can format the text using the Notes
toolbar at the top of the field. The text you type here is also shown in the Notes
window, under the 'Input' heading.

Type the acceptance or test success conditions; you can format the text using the
Notes toolbar at the top of the field. The text you type here is also shown in the
Notes window, under the 'Acceptance Criteria' heading.

Type the results of the last test; you can format the text using the Notes toolbar at
the top of the field. The text you type here is also shown in the Notes window,
under the 'Results' heading.

Click on this button to save the data you have entered and to add the entry to the
Test Cases window and the Browser window, keeping the 'Test details' dialog open.

Click on this button to save all new data and close the 'Test details' dialog.
Click on this button to clear the data entry fields ready for defining another test.

If there are existing tests, click on these buttons to display the details of the
previous test or next test in the sequence.

Click on this button to discard all unsaved data and close the dialog.

Create a Test Record in the Test Cases Window
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Test Cases

* Full Test Suite  * Unit  Inspection Integration System Scenaric Acceptance

Test Status A Type Run By Checked By Description Run Date
Test Ignition Use Case Pass Standard Hugh Layd lane Ward Clean test run 1640772041

Depending on your screen width and the fields you have exposed in the Test Cases window using the 'Field Chooser'
dialog, you might need to scroll the window left and right to see all fields. As it is possible to change the sequence of
fields across the window, the fields might not be in the order as documented.

Field/Button Action
Test Overtype the Add new <test type> text with the name of the new test.
Status Click on the field and on the drop-down arrow, and select the appropriate status.
Type Click on the drop-down arrow and select the appropriate test type - Load,

Regression or Standard.

Run By Click on the drop-down arrow and select the name of the person who ran - or will
run - the test.

You can also start typing the name of the person, until the auto-complete facility
fills in the rest of the name.

Checked By Click on the drop-down arrow and select the name of the person who checked - or
will check - the results of the test.

You can also start typing the name of the person, until the auto-complete facility
fills in the rest of the name.

Description Type in a short description or explanation of the test.
Run Date Type in the date on which the test was last executed, in dd/mm/yyyy format.
Notes

e To delete an item, right-click on it in the Test Cases window and click on the 'Delete’ option in the context menu; in
response to the confirmation prompt, click on the Yes button

e A further possibility for generating and editing Test items is to right-click on the Testing category in the 'Details' tab
of the Inspector window - or the required item within the list - and select menu options to perform the required
operation

e  To change the element for which to create or edit Test items, click on the element in a diagram or the 'Project' tab of
the Browser window

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have
'Manage Tests' permission to add, update and delete Test records
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Show Test Script Compartments

When you have created a Test record, it is useful to make the test visible on its parent element. You can do this by
displaying the test within a Test Script compartment on the element as it displays in a diagram. Any element that is
capable of displaying a compartment, and that has a test assigned to it, can show test scripts in a diagram.

Show the Test Scripts on an Element in a Diagram

Step Action

1 Open a diagram containing the element with the attached test items.

2 Double-click on the diagram background to display the diagram 'Properties’ dialog.
Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, select the 'Testing' checkbox.

4 Click on the OK button to save the setting.

Each test item now appears in the test scripts compartment of the diagram element. Items of each type are
grouped together so that, for example, all Unit tests on the element are grouped under the heading 'Unit’,
and all Integration tests on the element are grouped under the heading 'Integration'.

If you click on a test item, and the Notes window and/or Test Cases window are open, the test details are
immediately displayed in them. If you double-click on the item, the '"Test details' dialog opens, showing
the details of that test.

Example
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CCBookClientPanel

«SM_Activity»
+ CCBookClientPanel
+ GetBook: CBook

~  bookpanel(): CCBookPanel

test scripts

Unit

Valid Inputs Pass
Integration

Pass on output Not Run

maintenance

Issue

Run time New

Triggers New
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Properties Window for Test Items

When the Properties window is open, it displays the properties of the selected object or assigned item, including a Test
record for an element. You might select the Test in the Test Cases window, the fest scripts compartment of an element on
a diagram, or in the 'Details' tab of the Inspector window.

The Properties window identifies the test class of the test just under the toolbar, and shows the current values for the:
e Test name

e Test type

e Run date

e Result

e 'Run by' user, and

e  'Check by' user

You can change the value for each of these fields (except for the 'Test' field), clicking on the drop-down arrow and
selecting a new value. For the 'Run by' and 'Check by' fields, you can also start typing in the user name until the
autocomplete facility provides the rest of the name.

For the 'Test' field, you can either overtype the test name or click on the D icon and apply any autonaming convention
you have configured for test items.

The toolbar options operate on the parent element for the test. Any changes you make are automatically saved and
displayed elsewhere when you click off the field.

(c) Sparx Systems 2025 Page 122 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

Move or Copy Tests Between Test Classes

After you define a test within one test class (Unit, Integration, System, Acceptance, Inspection or Scenario), you might
decide that the test either is better suited to another test class, or forms a good template for tests in other classes. If so,
you can either move or copy the test to the other class lists.

Access

Click on the element containing the test records.

Ribbon Construct > Test Management > Tests > <test class> > Right-click on test to
move/copy
Start > All Windows > Construct > Testing > <test category> > Right-click on test
Keyboard Shortcuts Alt+2 > Testing : right-click on test to move/copy

Move or Copy a Test

Step

1

Notes

Action

Click on the appropriate option - 'Move to' or 'Copy to'.
A list of test classes displays.

Click on the test class to which to move or copy the test.

A confirmatory prompt displays.
Click on the Yes button to confirm the move or copy.

In the Test Cases window, click on the tab for the test class you moved/copied the test into, to check that
the Test has been added.

Double-click on the test to open the 'Test details' dialog, and make any necessary changes to the Test
record.

If you are copying the test to more than one other test class, repeat steps 1 to 4 for the next class to copy
to.

e Ifyou move or copy a test into the Scenario Tests class, some unassociated data could be lost
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Create Maintenance Item From Test

If an element fails a test, one likely consequence is that a Defect (Issue) item has to be raised in model maintenance to
correct the problem. You can generate this Defect item directly from the test that failed.

Access

Select the element containing the failed test, then use one of the methods outlined here to display the Test Cases window
or 'Details' tab of the Inspector window

Ribbon Construct > Test Management > Tests > <test class> > Right-click on test > Create
a Maintenance Defect from this test

Start > All Windows > Construct > Testing > <test class> > Right-click on test >
Create a Maintenance Defect from this test

Design > Element > Properties > General > Element Browser > Testing > <test
class> > Right-click on test > Create a Maintenance Defect from this Test

Keyboard Shortcuts Alt+2 > Testing : <test class> | Right-click on test | Create a Maintenance Defect
from this Test

Create a Maintenance Item from a Test

Step Action

1 The system immediately creates the Defect item and displays a confirmation message box.

Click on the OK button to clear the message.
2 Open the Defects window (the 'Construct > Change Management > Defects > Show Defects Window'
ribbon option).

The window shows a Defect item having the same name as the test.

3 Double-click on the Defect item to open it in the 'Defect details' dialog, and edit the item as necessary -
you might provide values for the 'Reported By', 'Status' and 'Priority’ fields.
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Move Tests Between Elements

A test you define for one element might be usefully moved to another if, for example, you are moving your model
through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a test of any class and type
from either the appropriate tab of the Test Cases window or the 'Details' tab of the Inspector window, onto a different
element on a diagram.

Access

From the Browser window, open the diagram containing the target element, then click on the element from which to
move the tests. It is convenient to have both source and target elements on the same diagram, but it is possible to select
the source element in the Browser window or on a different open diagram.

It is also convenient to have compartments enabled on the target element, with the Testing (test scripts) compartment
selected, so that you can observe the addition of the moved test. (Right-click on the element and select 'Compartment
Visibility', then select the 'Testing' checkbox.)

Ribbon Start > Application > Design > Browser > Element - expand the 'Testing' category
or

Construct > Test Management > Tests | <Test class>

Keyboard Shortcuts Alt+2 | Testing > <test class™> tab

Click on the source element on a diagram : T

Move the Test to the Target Element

Click on the test that you intend to move, and simply drag it onto the target element. The test name will display in the
'test scripts' compartment of that element. What you would observe might resemble this illustration.

Stage 1 Stage 2

test scripts
Unit
UTLinkage Mot Run

System
Table integration Pass

L]
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Stage 1

test scripts
System
Table integration

Pass

I

Stage 2
test scripts
Unit
UTLinkage Mot Run
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Import Test From Other Elements

If you have created useful tests in one element, you can import those tests into any other element through the Test Cases
window or 'Details' tab of the Inspector window, and so avoid having to duplicate the test information manually. You
open the Test Cases window for the empty target element and then select the source element that contains the tests to
import.

Access

Select target element, then:

Ribbon Construct > Test Management > Tests > <test class> | Right-click on test list |
Import Test from other Element (s)

Start > All Windows > Construct > Testing > <test class> > Right-click on test list |
Import Test from other Element(s)

Keyboard Shortcuts Alt+2 > Testing | Right-click on test list | Import Test from other Element(s) or
Alt+9 : Testing > <test class> > Right-click > Import Test from other Element(s)

Import a Test
The Tmport Element Tests' dialog displays.
Field/Button Action

Select element Click on the drop-down arrow and locate and select the source element.

This list identifies elements that have tests that can be imported.

Show related elements only Select this checkbox to restrict the list of selectable elements to those that are
related to the target element.

Limit selection to these If you want to restrict the list of selectable elements to only those of specific types,
Object Types only type in those element types in a comma-separated list.
Refresh Click on this button after changing any of the field values, to refresh the list of

available elements in the 'Select element’ field.
Select items to import Lists the tests defined in the source element. Select the test(s) to import.
If you have not used the 'Select element' field, any tests listed are from the current

element to which this test record belongs. There is no purpose in importing these.

Import As Defaults to the test class of the Test you selected to populate from the other
element. If you need to change this, click on the drop-down arrow and select a
different test class from the list.

All Click on this button to select all tests listed in the 'Select items to import' field.

None Click on this button to clear the selection of tests listed in the 'Select items to
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import' field.

Import Click on this button to import the selected test(s).

Notes

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have
'Manage Tests' permission to add, update and delete test records
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Import Scenario as Test

If you are creating a test for a scenario from either a single element or many elements in a Package, you do not have to
manually re-type the scenario details into the test record. You can generate the test into the 'Scenario Tests' class of one
element from one or more scenarios in any element in the model.

Within the Scenario Test record, the scenario description is copied to the 'Description' tab. If a scenario contains a
specification, its Action steps are also copied to the 'Description' tab under the heading 'Structured Specification'.

Access

Click on the element containing the test records, and use one of the methods identified here to display the 'Tmport
Scenario' dialog.

Ribbon Construct > Test Management > Tests > <test class> > right-click on test list >
Import Element Scenario(s) or

Construct > Test Management > Tests > <test class> > right-click on test list >
Import Package Scenario(s) or

Start > All Windows > Construct > Testing > <test class> > right-click on test list >
Import Element Scenario(s)

Start > All Windows > Construct > Testing > <test class> > right-click on test list >
Import Package Scenario(s)

Keyboard Shortcuts Alt+2 > Testing : right-click on test list | Import Element Scenario(s) or
Alt+2 > Testing : right-click on test list | Import Package Scenario(s)

Import a Scenario from a Single Element

Field/Button Action

Select element If you are copying scenarios from a different element to the target element, click on
the drop-down arrow and select the source element. The list identifies elements that
have scenarios that can be imported.

Otherwise, leave this field blank.

Show related elements only Select this checkbox to restrict the list of selectable elements to those that are
related to the target element.

Limit selection to these If you want to restrict the list of selectable elements to only those of specific types,
Object Types only type in those element types in a comma-separated list.
Refresh Click on this button after changing any of the field values, to refresh the list of

available elements in the 'Select element' field drop-down.

Select items to import Lists the scenarios defined in the source element. Select the scenario(s) to import.

If you do not use the 'Select element' field, any scenarios listed are from the current
element to which this test record belongs.

If you have selected a different element, the scenarios come from that element.
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Import As Defaults to the test class of the Test you selected to populate from the scenario. If
you need to change this, click on the drop-down arrow and select a different test
class from the list.

All Click on this button to select all scenarios listed in the 'Select items to import' field.

None Click on this button to clear the selection of scenarios listed in the 'Select items to
import' field.

Import Click on this button to import the selected scenario(s).

Import Scenarios from the Elements in a Package

Field/Button Action
Limit selection to these If you want to restrict the selected elements to only those of specific types, enter
Object Types only those element types in a comma-separated list.

This version of the Tmport Scenario' dialog lists all scenarios against all elements in
the Package; it does not enable you to select a specific element, but does enable you
to filter the list of scenarios to those from specific types of element.

Refresh Click on this button after changing the 'Limit Selection..." field value, to refresh the
list of available elements in the 'Select items to import' field.

Select Items to import Lists the scenarios defined in the selected elements in the Package. Select the
scenario(s) to import.

All Click on this button to select all scenarios listed in the 'Select items to import' field.

Import As Defaults to the test class of the Test you selected to populate from the scenario. If
you need to change this, click on the drop-down arrow and select a different test
class from the list.

None Click on this button to clear the selection of scenarios listed in the 'Select items to
import' field.

Import Click on this button to import the scenarios from each element as Scenario tests.

Notes

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have
'Manage Tests' permission to add, update and delete test records
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Import Requirement or Constraint as Test

If you are creating a test against an internal requirement or internal constraint of an element, you do not have to manually
re-type the details into the test record in the 'Test details' dialog. You can generate a testing record on the element from
the requirement or constraint.

The test record is generated into the Test Cases window under the currently-selected test class, and the requirement or
constraint description is copied to the 'Description’ for the test record.

Access

Select an element, then use one of the methods outlined here to display the Test Cases window or 'Details' tab of the
Inspector window.

Ribbon Construct > Test Management > Tests > <test class> > Right-click on test list >
Import Element Constraint(s) or Import Element Requirement(s)

Start > All Windows > Construct > Testing > <test class> > Right-click on test list
> Import Element Constraint(s) or Import Element Requirement(s)

Design > Element > Properties > General > Element Browser > Testing > <test
class> > Right-click on test list > Import Element Constraint(s) or Import
Element Requirement(s)

Keyboard Shortcuts Alt+2 > Testing : <test class> | Right-click on test list | Import Element
Constraint(s) or Import Element Requirement(s)

Alt+9 : Testing > <test class> > Right-click > Import Element Constraint(s) or
Import Element Requirement(s)

Import a Requirement or Constraint as a Test

Step Action

1 On the 'Import Constraint' or 'Import Requirements' dialog (the two dialogs are identical) review the list of
internal requirements or constraints in the selected element.

2 Click on one of the items to import as a Test, or press Ctrl+click on more than one to import several.

The Tmport As' field defaults to the test class of the Test into which you are importing the requirement or
constraint details. If you need to change this, click on the drop-down arrow and select a different test
class.

3 Click on the OK button.

Each item is added to the list of tests in the Test Cases window, under the appropriate <test-type>, as a
standard, 'Not Run' test.

Double-click on one item to open the 'Test details' dialog to edit the test details; thereafter, just click once
on the next test item to edit that in the 'Test details' dialog.

Notes
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e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have
'Manage Tests' permission to add, update and delete test records
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Test Documentation

After you have recorded a number of test scripts and results against elements in the model, you can output the
information as a report in Rich Text Format, using the 'Generate Test Documentation' dialog. You can select the types of
test to include or exclude in the report and whether to include child Packages, and enter the file location to which to
generate the report.

Click on the Generate button to produce the report.

You can also run a number of searches to show the results - where generated - of tests:
e Not Run

e Not Checked

e Recently run

e Recently Passed

e  Recently Failed

e Recently Deferred

e Run on recently modified elements

e  Run in the last week

e Run in the last 30 days

Access

Select a Package, then use the ribbon options:

Ribbon Construct > Testing > Outcomes > Report  (to display the 'Generate Test
Documentation' dialog)

Construct > Testing > Not Run
Construct > Testing > Not Checked

Construct > Testing > Outcomes > <report type>
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Changes, Defects & Issues

In the course of your team's work on a model, changes and issues can arise at a number of levels, for problems that apply
system-wide through areas of the model and down to within a specific element. A Change, very broadly, defines an
addition or alteration to a requirement, whilst an Issue identifies either a failure to meet a requirement, or a risk in
meeting the requirement.

There are two mechanisms that can be used to identify a change or issue, and the work required to resolve it:

e  Change and Issue (or Defect) elements - structured comments that identify a problem at system-level, although they
can also be attached to a specific element from which a problem arises; both types of element can be linked by
relationships such as Association, Dependency and Realize to one or more other elements that have to be reviewed,
and for complex problems can form hierarchies or groups

e Maintenance items - properties raised against a specific element and recorded for that element in the Maintenance
window; these provide a distinction between Defects (a failure to meet a requirement) and Issues (a risk factor that
might affect satisfying the requirement) and also include Tasks, which record work items associated with the
element
Maintenance items are very specific, but if an item begins to have a wider impact on other elements or the system in
general, you can translate that item into a Change, Issue, or any other type of element that best identifies the problem
and its solution

Maintenance items are defects, changes, issues, tasks, features and documents that apply at the model element level.
They are properties of individual model elements that can be used to record and capture problems, changes, issues and
tasks as they arise, and document the solution and associated details.

Maintenance Tasks

Task Area Detail

Maintenance Items - You create maintenance items in the Maintenance window. Typically you create:
Element-level e A defect to record a failure to meet a requirement for the current model
q
element
e A change to record a change in requirement for the current model element

e Anissue to record a risk factor that might affect the project being recorded for
the current model element

e A task to record work in progress and work outstanding for the current model
element

e A feature to record a feature in requirement for the current model element

e A document to record supporting documentation such as Help, release notes
and user comments

Creating and Editing Tasks that you might perform when working with maintenance items include:
Maintenance Items e Moving or copying maintenance items between maintenance types
e  Generating new items of one type from an item of a different type
e  (Creating elements from maintenance items

e Showing maintenance items on elements in a diagram
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e Adding a maintenance item directly to an element via in-place editing

e  Generating a report on the status of maintenance items of specific types or all

types
Maintenance - To represent changes, defects and issues that apply to the model you can create
System-level Change and Issue elements with - if necessary - subordinate structures.

To represent issues and tasks that apply to the progress of the project as a whole
and that are not related to model structures, you create Project Issue and Project
Task records in Project Management.

(c) Sparx Systems 2025 Page 135 of 186 Created with Enterprise Architect



Project Build & Deploy 2 September, 2025

Maintenance Overview

If your work in managing a project identifies issues, defects or required changes in the model rather than internal to a
single element, you can represent these using Change, Issue or Defect elements as structured comments with which you
can track and manage the problems.

e A Change element corresponds to a change in requirements for the current system

e An Issue element corresponds to a failure to match the requirements for the current system due to newly arisen
organizational or legal factors such as staffing problems, changes in laws or guidelines, or business unit restructuring

e A Defect element corresponds to a failure to match the requirements for the current system due to a flaw in the
model, system or process, such as a missing element or module, or no inclusion of a necessary actor

You can also define any specific work to be done in researching or resolving the problem using Task elements, and
assign resources to these or directly to the Change, Issue or Defect elements internally, in Resource Allocation, or
externally as Actors.

The use of maintenance elements provides a broad scope for managing changes, defects and issues, providing the facility
to fully define the problem and its resolution with Linked Documents, both internal and external Notes, and Composite
Structure diagrams including Interaction and Activity diagrams.

You can create Change, Defect and Issue elements in various UML diagrams (especially Maintenance diagrams) and
connect them using Realization, Dependency, Aggregation and other relationships to show what model elements each
problem affects and how each is resolved. Within the element 'Properties' dialog for Changes, Defects and Issues you can
identify the problem as the element name and record relevant management details, such as owner and dates.

A useful tool in managing problems and changes is the Relationship Matrix, in which you might - for example - link staff
(Actors) through Realization connectors to Issues. Each highlighted square in the Matrix indicates the responsibility of a
staff member to work on or correct a named Issue.
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Issues

In your modeling, issues concerning the development of the system or model might arise; more formally, you encounter
a failure to meet defined requirements for the current system. You can represent this failure using an Issue element,
which is a structured comment containing information about the issue and the measures taken to manage it. The element
is rendered as shown.

Issue Element [

You can link Issues to model elements that are responsible for the issue, using Realize connectors. You can also create a
hierarchy of related Issues using Aggregation connectors. Each Issue element has a status band at the left end, which is
color coded to visually represent the value of the 'Status' field in the element properties. The element has an identifying 'l
in the top right corner, which you can hide if you prefer not to show it.

1

You can create Issue elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own issue-management diagram as a Custom diagram. You can
add the Issue (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the Browser
window.

Add an Issue to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram to define the problem.
2 From the 'Custom' pages or 'Common' page of the Diagram Toolbox, drag the Issue icon onto the diagram.
3 If the Properties window is not already displayed, press Ctrl+2 on the element. Record the name and

details of the Issue, in the Properties window.

Add an Issue to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the Issue, in the Browser window.

Right-click on this Package and select the 'Add Element' option.

2 Complete the fields on the 'New Element' dialog - in the '"Type' field, click on the drop-down arrow and
select 'Issue'.

3 When you have created the element, record the name and details of the Issue, in the Properties window.

Notes
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e To toggle display of the letter 'I' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Defects

In your modeling, problems in the development of the system or model might arise; more formally, you encounter an
obstacle to meeting defined requirements for the current system, through a defect of the model, system or process. You
can represent this failure using a Defect element, which is a structured comment containing information about the defect
and the measures taken to manage it. The element is rendered as shown.

Defecti b

You can link Defects to model elements that are responsible for the problem, using Realize connectors. You can also
create a hierarchy of related Defects using Aggregation connectors. Each Defect element has a status band at the left end,
which is color coded to visually represent the value of the 'Status' field in the element properties. The element has an
identifying 'D' in the top right corner, which you can hide if you prefer not to show it.

You can create Defect elements on most types of diagram, although the Maintenance diagram is specifically designed for
displaying and managing them. You can also create your own defect-management diagram as a Custom diagram. You
can add the Defect (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Defect to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram to define the problem.
2 From the 'Custom' pages of the Diagram Toolbox, drag the Defect icon onto the diagram.
3 If the Properties window is not already displayed, press Ctrl+2. Record the name and details of the Defect,

in the Properties window.

Add a Defect to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the Defect, in the Browser window.
Right-click on this Package and select the '"Add Element' option.

2 Complete the fields on the 'New Element' dialog - in the "Type' field, click on the drop-down arrow and
select 'Defect'.

3 When you have created the element, record the name and details of the Defect, in the Properties window.

Notes

e To toggle display of the letter 'D' in the top right corner of the element, select or deselect the 'Show stereotype icon
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for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Changes

In your modeling it might become necessary to change an aspect of the system or model; more formally, you need to
request and manage a change in the defined requirements for the current system. You can represent this change request
using a Change element, which is a structured comment containing information about the change and the measures taken
to manage it. The element is rendered as shown.

Change Element L

You can link Changes to model elements that are impacted by the change, using Realize connectors. You can also create
a hierarchy of related Changes using Aggregation connectors. Each Change element has a status band at the left end,
which is color coded to visually represent the value of the Status field in the element properties. The element has an
identifying C in the top right corner, which you can hide if you prefer not to show it.

You can create Change elements on most types of diagram, although the Maintenance diagram is specifically designed
for displaying and managing them. You can also create your own change-management diagram as a Custom diagram.
You can add the Change (and other) elements to the diagram from the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Change to the model using the Toolbox

Step Action

1 Open the Maintenance or Custom (or other) diagram in which to define the problem.
2 From the 'Custom' or 'Common' pages of the Diagram Toolbox, drag the Change icon onto the diagram.
3 If the Properties window is not already displayed, press Ctrl+2. Record the name and details of the

Change, in the Properties window.

Add a Change to the model using the 'New Element' dialog

Step Action

1 Identify the Package in which to record the change, in the Browser window.

Right-click on this Package and select the 'Add Element' option.

2 Complete the fields on the 'New Element' dialog - in the 'Type' field, click on the drop-down arrow and
select 'Change’'.

3 When you have created the element, record the name and details of the Change, in the Properties window.

Notes
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e To toggle display of the letter 'C' in the top right corner of the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog, 'Objects' page
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Maintenance Diagram

A Maintenance diagram is a type of Custom diagram, an extension to the UML model. It is a change management tool,
used to record:

e Requests for change to the model structure or project process, as Change elements
e Issues that impact the development and progress of the project, as Issue elements, and
e  Groups of tests that can be applied to many elements rather than specific elements, as Test Cases

Each Change, Issue or Test Case element can link to other model elements in the project, to illustrate how they
contribute to or are impacted by the item, and how they must be modified, removed, applied or extended to provide a
solution. This includes identifying areas of work, represented by Task elements, to which resources can be allocated as
either external (Actor) elements or internal properties (resource allocation).

You generate Maintenance diagram elements and connectors from the 'Maintenance' pages of the Diagram Toolbox,
although you might also make frequent use of connectors from other pages.

Example Diagram

Example Maintenance Diagram

Maintenance Diagram Element Toolbox Icons

Icon Description

B Package A Package is a namespace as well as an element that can be contained in other
Packages' namespaces.

1 1sue Issue elements represent a failure to meet defined requirements for the current
system.
i1 Change This element represents a change in the defined requirements for the current system

and can be used to request and manage the change process.
[T Task A Task element represents a task that must be performed in relation to an element.

X Test Case A Test Case is a stereotyped Use Case element. You might use it to extend the
facilities of the Test Cases window, by applying element properties and capabilities
to the tests of a feature represented by another element or - more appropriately - set
of elements.

B Entity An Entity is a stereotyped Object that models a store or persistence mechanism that
captures the information or knowledge in a system.

Test A Test element represents a step in the Basic, Alternate and Exception Paths of a
Scenario created in a Use Case or other element.

Defect The defect element represents an obstacle to meeting defined requirements for the
current system.

Review The Review element acts as a focus for performing a formal review of one or more
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‘ ‘ model elements. It defines the parameters of the review.

Maintenance Diagram Connector Toolbox Icons

Icon Description

A Aggregate - An Aggregation connector is a type of association that shows that an element
contains or is composed of other elements.
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Example Maintenance Diagram
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Very simply, this example diagram depicts a request for a change (C) to a process represented by an Activity element
(Transfer WH Receipts to Active Stock). The change currently involves the Task (T) of reviewing the interface between
two recording systems, one of which could be affected by an Issue (I) concerning an external stocktaking system.

Warehouse Receipt/Stocktake Update
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Working with Maintenance Iltems

Creating, viewing and modifying the Maintenance items - changes, issues, defects, tasks, feature and documents -
associated with a particular model element is quick and convenient, using the Maintenance window. If the Maintenance
window is open, when you select an element in a diagram or in the Browser window, the appropriate maintenance items
for that element are immediately listed in the window, and you can select them there to modify. The Maintenance
window provides several facilities for managing the maintenance items.

You can include the maintenance items in the document and web reports generated on your model. The 'Document Setup'
dialog has checkboxes to show or hide element maintenance items.

Access

Click on an element in the Browser window or diagram and select the appropriate option.

Ribbon Construct > Change Management and:
e > Features > Show Features Window
e > Changes > Show Changes Window
e > Documents > Show Documents Window
e > [ssues > Show Issues Window
e > Tasks > Show Tasks Window

e > Defects > Show Defects Window

Keyboard Shortcuts Ctrl+8 | <Required tab>

Select any of the items on a diagram or the 'Details' tab of the Inspector window,
then use Shift+Enter

Facilities
Facility Detail
Maintenance Item Types The six types of Maintenance Item you can create records for are each listed on a

separate tab of the Maintenance window:

e Defects - each recording a failure to meet a requirement for the current model
element

e Changes - each recording a change in requirement for the current model
element

e Issues - each recording a risk factor that might affect the project, associated
with the current model element

e Tasks - each recording work in progress and work outstanding for the current
model element

e Features - each recording a feature in requirement for the current model
element

e Documents - each recording the supporting documentation such as Help,
release notes and user comments

There is also a 'Maintenance Overview' tab that displays a read-only list of all the
Maintenance items on the element, grouped by type. If you double-click on an item
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in this list, the appropriate tab displays with the item highlighted.

Adding New Items To add new items, right-click on the main panel of the Maintenance window and
select the 'Add New' option. The appropriate fields for the item type are displayed
on the '<Maintenance Item Type> details for <element>' dialog, where you create
the item.

The fields you complete for each type of maintenance item are very similar.

Applying Automatic On the '<Maintenance Item Type> details for <element>' dialog, you can apply an

Naming/Numbering automatic naming/numbering convention that you have previously defined, to each
new item record. To do this, simply click on the Auto button next to the 'Detail'
field.

If you already have some text in the 'Detail’ field, it is over-written by the
auto-counter text.

Details tab You can also use the 'Details' tab of the Inspector window to create, select and
display specific items on the '<Maintenance Item Type> details for <element>'
dialog. Select the 'Start > Application > Design > Inspector' ribbon option to open
the Inspector window, select the 'Details' tab and the 'Maintenance > <maintenance
type>' list, and either:

e Double-click on an existing item to show and - if necessary - change the
details, or

e Right-click on the appropriate '<maintenance type>' folder name and select the
'New <item type>' option to create a new item

Move items between You might have a maintenance item on one element that can be usefully moved on
elements to another element. You can move the item very simply, by dragging it from the
Maintenance window or 'Details' tab onto the target element on a diagram.

Notes

e  Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided
in the List Header facilities
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Create Maintenance Items

When you need to create a new maintenance record for an element, you can do so by selecting the 'Add New' context
menu option in the Maintenance window.

Access

Use one of the access paths outlined here to display first the Maintenance window at the appropriate tab for the type of
maintenance item to create, then the '<Maintenance Item Type> details for <element type>' dialog for that item type.

Ribbon Construct > Change Management > Features > Show Features Window >
right-click | Add New

Construct > Change Management > Changes > Show Changes Window >
right-click | Add New

Construct > Change Management > Documents > Show Documents Window >
right-click | Add New

Construct > Change Management > Issues > Show Issues Window > right-click |
Add New

Construct > Change Management > Defects > Show Defects Window > right-click |
Add New

Construct > Change Management > Tasks > Show Tasks Window > right-click |
Add New

Keyboard Shortcuts Ctrl+8 > <required tab> | Right-click | Add New

Select any of the Maintenance items on a diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Create Maintenance items on the Maintenance dialog

Option Action
Detail Type the name or a short description of the feature, change, defect, task, issue or
document.
Auto As an alternative to typing in the name, click on this button to insert predefined

auto-counter text.

If you already have some text in the 'Detail' field, it is over-written by the
auto-counter text.

Reported by / Requested by Click on the drop-down arrow and select the user name of the person who initiated
/ Raised by the maintenance item.

Alternatively, start typing in the user name until the auto-complete facility fills in
the rest of the name.

Date Defaults to today's date as the date on which the maintenance item was raised; if
necessary, change this by clicking on the drop-down arrow and selecting a different
date.
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Status Click on the drop-down arrow and select the appropriate status of the maintenance
item, such as 'New' or 'Complete'.

Priority Click on the drop-down arrow and select the priority for completing the
maintenance item.

Resolved by / Implemented Click on the drop-down arrow and select the user name of the person who
by / Completed by completed and closed the maintenance item.

Alternatively, start typing in the user name until the auto-complete facility fills in
the rest of the name.

Date Select the date on which the maintenance item was completed; click on the
checkbox to select today's date or, if necessary, change the field by clicking on the
drop-down arrow and selecting a different date.

Version / ID Displays the version number assigned to this defect, change, task, issue or
document.

If you want to refer to this maintenance item from another element or document,
click on the Copy button to copy the ID to the clipboard, from where it can be
pasted into the other text.

Description Type a longer description of the maintenance item; you can format the text using
the Notes toolbar at the top of the field. The text you enter here is also displayed
and can be edited in the Notes window.

History Over time, enter any notes on the actions concerning this maintenance item; you
can format the text using the Notes toolbar at the top of the field. The text you enter
here is also displayed and can be edited in the Notes window.

Apply Click on this button to save the record data and keep the dialog open.

OK Click on this button to save the record data and close the dialog.

Close Click on this button to discard the unsaved record data and close the dialog.

New Click on this button to clear the dialog fields ready to define a new maintenance
item.

left chevron/right chevron If there are existing items, click on these buttons to display the details of the

previous item or next item in the sequence.

Create Maintenance Items on the Maintenance Window

An alternative method of creating simple Maintenance items is to display the Maintenance window as indicated in the
Access section, but complete the fields on the window rather than go on to display the 'Maintenance' dialog. In this way
you can quickly create a set of basic Maintenance items at once and then add more detail to individual items as necessary
at a later time.

To create an item:
1. Display the appropriate tab for the type of item.
2. Double click on the Add new <item type> text and type in the name of the item.
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3. Tab to the 'Status' field; the 'Status', 'Priority' and 'Date Reported' fields display default values. If these are acceptable
to you, the Maintenance item is created and available for future editing.

4. If you want to change the field values, click once on the field and once on the drop-down arrow, and select the
appropriate value.

Notes

e To edit an item, double-click on it on the Maintenance window; the item details display in the '<Maintenance Item
Type> details for <element type>' dialog for editing

e To delete an item, right-click on it on the Maintenance window and select the 'Delete’ option; in response to the
confirmation prompt, click on the Yes button

e A further possibility for editing and deleting items is to right-click on items in the 'Details' tab of the Inspector
window and select menu options there; select the 'Start > All Windows > Design' ribbon option and then 'Explore >
Inspector > Details > Maintenance > <maintenance type>'

e To change the element for which to create or edit maintenance items, click on the new element on a diagram or in
the 'Project' tab of the Browser window
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Properties Window for Maintenance ltems

When the Properties window is open, it displays the properties of the selected object or assigned item, including a
Maintenance record for an element. These items include Changes, Issues, Defects, Tasks, Features and Documents.

You might select the item in the appropriate tab of the Maintenance window, the maintenance compartment of an
element on a diagram, or the 'Details' tab of the Inspector window.

The Properties window identifies the type of item just under the toolbar, and shows the current values for the:
e [tem name

e User who raised the item

e Date the item was raised

e  Status

e  User who implemented or resolved the item

e Date that action was completed

e  Priority of the item

e  Version of the item

You can change the value for each of these fields (except for the 'Name' and 'Version' fields), by clicking on the
drop-down arrow and selecting a new value. For the user name fields, you can also start typing in the name until the
auto-complete facility fills in the rest of the name.

For the 'Name' field, you can either overtype the item name or click on the D icon and apply any autonaming
convention you have configured for maintenance items. If you click on the icon for the 'Version/ID' field, that value is
copied to the clipboard to be pasted into a discussion or document.

The toolbar options operate on the parent element for the maintenance item. Any changes you make are automatically
saved and displayed elsewhere when you click off the field.
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Move or Copy Maintenance Items Between Types

After you define a maintenance item of one type (Defect, Change, Issue, Document, Feature or Task), you might decide
that the item either is better suited to another type or forms a good template for items of other types. If so, you can either
move or copy the item to the other types.

Access

Display the Maintenance window using one of the methods outlined here.
In the Maintenance window:
e Right-click on a maintenance item | Move to | <item type> or

e Right-click on a maintenance item | Copy to | <item type>

Ribbon Construct > Change Management > Features > Show Features Window
Construct > Change Management > Changes > Show Changes Window
Construct > Change Management > Documents > Show Documents Window
Construct > Change Management > Issues > Show Issues Window
Construct > Change Management > Tasks > Show Tasks Window

Construct > Change Management > Defects > Show Defects Window

Keyboard Shortcuts Ctrl+8 > <required tab>

Move or copy a maintenance item

Step Action

1 Click on the appropriate option - 'Move to' or 'Copy to'.

A list of maintenance item types displays.

2 Click on the item type to which to move or copy the item.

A confirmatory prompt displays.

3 Click on the Yes button to confirm the move or copy.

4 Switch to the appropriate tab of the Maintenance window to ensure that the item has been added.

5 If you are copying the item to more than one other item type, repeat steps 1 to 4 for the next item type to
copy to.
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When you have created a maintenance item, it is useful to make the record visible on its parent element. You can do this
by displaying the record within a maintenance compartment on the element as it displays in a diagram. Any element that
is capable of displaying a compartment, and that has maintenance items assigned to it, can show the items in a diagram.

Show maintenance items in a diagram

Step Action

1 Open a diagram containing the element with the attached maintenance items.

2 Double-click on the diagram background to display the diagram 'Properties’ dialog.

Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, select the 'Maintenance' checkbox.

4 Click on the OK button to save the setting.

Each maintenance item now appears in the maintenance compartment of the diagram element. Items of
each type are grouped together so that, for example, all Issues on the element are grouped under the
heading 'Issue', and all Tasks on the element are grouped under the heading 'Task'.

If you double-click on a maintenance item, the '<maintenance item type> for <element>' dialog displays
and you can edit the details of the item.

Maintenance Compartment - Example

CCBookClientPanel

«5SM_Activity»
+ CCBookClientPanel
+ GetBook: CBook

~  bookpanel(): CCBookPanel

test scripts
Unit
Valid Inputs Pass
maintenance
Issue
Run time New
Triggers New
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Move Maintenance Items Between Elements

A maintenance item you define for one element might be usefully moved to another if, for example, you are moving your
model through stages in a lifecycle or, indeed, modeling a lifecycle. It is possible to simply drag a maintenance item of
any type from either the appropriate tab of the Maintenance window or the 'Details' tab of the Inspector window, onto a

different element on a diagram.

Access

From the Browser window, open the diagram containing the target element, then click on the element from which to
move the tests. It is convenient to have both source and target elements on the same diagram, but it is possible to select
the source element in the Browser window or on a different open diagram.

It is also convenient to have compartments enabled on the target element, with the Maintenance compartment selected,
so that you can observe the addition of the moved item. (Right-click on the element and select 'Compartment Visibility',
then select the 'Maintenance' checkbox.)

Ribbon

Keyboard Shortcuts

Start > Application > Design > Browser > Element - expand the 'Maintenance'

category or

Construct > Change Management > <item type> | Show <item type> Window

Alt+2 | Maintenance > <item type> tab

Click on the source element on a diagram : T

Move the Item to the Target Element

Click on the maintenance item that you intend to move, and simply drag it onto the target element. The item name will
display in the 'maintenance' compartment of that element. What you would observe might resemble this illustration.

Stage 1

maintenance
Change
Remove account type

Issue
Mot all banks use Account Type

New

New

I

Stage 2
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I

Stage 1 Stage 2
maintenance maintenance
Change Issue
Remaove account type Mew Mot all banks use Account Type New
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A maintenance item identifies a defect, change, issue, task, feature or document concerning an element. The maintenance
item could itself be represented by an element if it has wider implications for the project or identifies - for example - an

actor, activity or action that requires further definition.

You can create one or more elements from any maintenance item, using the Maintenance window. The new element is
connected to the maintenance item's parent element by a Dependency connector. The original maintenance item remains

unchanged as a characteristic of its parent element.

Access

Use one of the methods outlined here to display the Maintenance window appropriate to the maintenance item from

which to create a model element.

In the Maintenance window: Right-click on the maintenance item > Create as New Element

The New Element' dialog displays.

Ribbon Construct > Change Management > Features > Show Features Window

Construct > Change Management > Changes > Show Changes Window

Construct > Change Management > Documents > Show Documents Window

Construct > Change Management > Issues > Show Issues Window

Construct > Change Management > Tasks > Show Tasks Window

Construct > Change Management > Defects > Show Defects Window

Keyboard Shortcuts Ctrl+8 > <required tab for item type>

Select any of the Maintenance items on a diagram or in the 'Details' tab of the

Inspector window, then press Shift+Enter

Create an element from a maintenance item

On the 'New Element' dialog, complete the fields.

Field/Option Action

Toolset The two 'Toolset' fields default to the last-set domain and Perspective. If these are
not appropriate to this task, click on the drop-down arrows and select the correct

domain and Perspective.

Name The 'Name' field defaults to the name of the Maintenance item. If necessary you can
overtype it with a different name, or click on the Auto button to apply a name from

your auto naming and numbering system.

Type Click on the drop-down arrow and select the required element type; you might

create:

e An Issue element for an Issue maintenance item

e A Defect element for a Defect maintenance item

e A Change element for a Change or Feature maintenance item, or
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e A Task for a Task maintenance item

The types are filtered by the Toolset you have selected; if the element type you
require is not listed, you can change the Toolset to provide that type. You can,
therefore, create a wide range of other element types should any of these be more
appropriate.

Stereotype If you require the element type you have selected to be refined by a stereotype,
click on the drop-down arrow and select the stereotype name. The stereotypes are
listed in alphabetical order.

Add Element to Diagram This option is enabled when you have a diagram open. If you want the new element
to be added to a diagram, have that diagram open and select this checkbox.

Save Click on this button to add the new element to the Browser window and, if
appropriate, the diagram.
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Construct History Window

The Construct History window provides a summary of all project management transactions over a given period, with
separate tabs for Tests, Resource Allocations and Maintenance objects (Changes, Features, Issues, Defects, Tasks and
Documents). You can set the period for which the window lists the transactions, and display details of each record in the
appropriate item Properties dialog (in which the record is defined).

Access

Ribbon Start > All Windows > Construct > Resources > Resource - History
Start > All Windows > Construct > Testing > Tests - History

Start > All Windows > Construct > Change > Maintenance - History

Context Menu Options

Right-click on an entry or on the window background to display the options for working on the listed item or on the
display of items in the Construct History window.

You can also adjust the number and position of the columns displayed, and filter the information shown, using the List
Header facilities, as described in the List Header Help topic.

Option Description

Properties For a selected resource, test or maintenance item, displays the properties of that
item in the appropriate create/edit dialog for the item type.

Double-clicking on the item has the same result.

Find Parent in Browser For a selected resource, test or maintenance item, locate and highlight - in the
Browser window - the element to which the item has been assigned.

Find Parent in Diagram For a selected resource, test or maintenance item, locate and highlight - in the
parent diagram - the element to which the item has been assigned. If the element is
present in more than one diagram, the 'Element Usage' dialog displays, from which
you select the diagram to open.

Visible Timeframe - Click anywhere in the window and select this option to display a submenu. Select
Resources one of these options:

e 'Today' to list resources with today as the task Start Date or End Date

e 'Today +X' to list resources with a task Start Date or End Date of today or up to
3, 7 or 30 days after today

e 'Today -X' to list resources with a task Start Date or End Date of today or up to
3, 7 or 30 days prior to today

e 'Today +/-X' to list resources with a task Start Date or End Date of today or up
to 3, 7 or 30 days either side of today; for example,
'"Today +/-30' lists resources with a task Start Date or End Date within the
61-day period between 30 days prior to today and 30 days after today

Visible Timeframe - Tests Click anywhere in the window and select this option to display a submenu. Select
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one of these options:
e 'Today' to list tests with today as the Run Date

e 'Today X Days' to list tests with a Run Date of today or up to 7, 30 or 90 days
prior to today

Visible Timeframe - Click anywhere in the window and select this option to display a submenu. Select
Maintenance one of these options:

e 'Today' to list maintenance items with today as the Reported Date or Resolved
Date

e 'Today X Days' to list maintenance items with the Reported Date or Resolved
Date of today or up to 7, 30 or 90 days prior to today

Check for Update Every Click anywhere in the window and select this option to display a submenu, then
select 'Minute', "2 minutes', 'S minutes' or '10 minutes' to automatically refresh the
list of items at that interval and display any new items that now match the selection
options.

Refresh Click anywhere in the window and select this option to manually refresh the display
immediately, to display any new items that now match the selection options.

Set This Tab as Default Select this option to set the Construct History window at the current tab to
automatically redisplay when you log back in to the model in a new work session.
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The Construct View

The Construct View is an aid to Project Management, helping you to quickly review the resources and maintenance
items of the elements in any Package (including a View, but not a Root node) or its diagrams in the model. You can
filter the view to show resources, or a single category or all categories of Maintenance item; that is:

e  Features

e Changes
e Issues
e Defects

e Tasks and/or
e  Documents

You can also manipulate what data to show for each item, using the 'Field Chooser' dialog and the Filter Bar. (See the
List Header Help topic.)

As you select individual items in the View, they become the focus of various Enterprise Architect windows such as the
Notes window, 'Details' tab of the Inspector window, and the Properties window.

Access

Ribbon Select an open diagram in the Browser window or right click on the diagram
background, then Design > Diagram > Views > Construct View

Context Menu In the 'Project' tab of the Browser window, right-click on the View or Package |
Open Package in | Construct View
In a diagram, right-click on the diagram background | Switch View | Switch to
Construct View

Other Right-click on the diagram tab for the diagram | Switch to Construct View

Context Menu Facilities

To select and display the information in the Construct View, you select options on the View's context menu. Right-click
anywhere on the View display.

Option Description

Load Resources Select this option to display the status and activity details of the resources assigned
to each element in the Package or on the diagram. This option is mutually exclusive
with 'Load Maintenance'.

Load Maintenance Select this option to display the details of either all Maintenance items on the
elements in the Package or diagram, or all those of a particular type - Features,
Changes, Defects, Issues, Tasks or Documents. This option is mutually exclusive
with "Load Resources'.

Refresh Select this option to update the display after changes have been made, to ensure that
they are reflected in the data fields for every view, dialog and window as well as
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the Construct View.
Clear Window Select this option to remove all data from the window.

Collapse All / Expand All The display initially shows the data in an expanded hierarchy of elements, child
elements and maintenance items or resources. Select the 'Collapse All' option to
show just the top-level elements with no data, and select the 'Expand All' option to
reveal the full hierarchy again.

Display as flat list Select this option to display only those elements that have resources or maintenance
items, with those items. The elements are listed in alphabetical order at the same
level, regardless of where they occur in the model hierarchy.
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The Construction Diagram

A Construction diagram is a graphical version of the 'Details' tab of the Inspector window. It shows the assigned
characteristics and features of the selected element, where these features have been created. Each type of feature is
shown in a separate element compartment.

To access a Construction diagram for an element, either:

e Inadiagram, right-click on the element | New Child Diagram | Construction Diagram, or

e In the 'Project' or 'Context' tab of the Browser window, right-click on the element | Add | Construction Diagram
To create a new Construction diagram for multiple elements:

e Select a Package in the Browser

e Select New Diagram' from the Browser context menu

e  Set the Perspective to 'ALL Perspectives'

o Select 'Extended' in the 'Select From' pane

e Select 'Construction' in the 'Diagram Types' pane.

The Construction diagram for the element displays a 'C' in the bottom right corner of the element, indicating that it is the
Construction rendition of the element. The list of potential properties displayed in compartments on an element include:

e Tags

e Requirements

e  Constraints

e Testing

e  Maintenance

e  Discussions

e Reviews

e  Resources

e  Projects for Decisions, Events, Issues and Tasks
e Notes

e Package Contents
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Transaction
test scripts
Acceptance
Transaction Analysis Mot Run
maintenance
Issue
Requires details on GST tax requirements Mew
Task
Write code for transactions Mew
FESOUICes
Linus
——— ] Application Analyst
Sam
[ —— ] C#+ Programmer
The Transaction is dependent on the Account setting to ensure the
Country of Origin and used to determine any need for VAT or G5T.
&

The visibility of compartments is dependent on there being detail in the specific features.

The possible compartments shown on the element are user-selectable from a range of element compartments. To alter
this;

e  Click on the diagram (or press F5)

e In the Properties window, select 'Elements'

e  Tick the options in the 'Show Compartments' group.

An example of a Construction diagram with multiple elements.

Transaction Account
test scripts tags
Acceptance KeyClass = true
Transaction Analysis Not Run -
maintenance
maintenance Issue
|ssue Program the detail code VAT & GST sp... New
Requires details on GST tax requirements Mew Task
Task Program the detail code New
Write code for transactions Mew |-history -account
FESOUICEs
FESOUICES Leon Major
Linus [— 1 Developer
— 1 Application Ana... discussions
am scussions
| G+ Programmer Leon: Construction has been started but there is an

issue on the Transaction requirements cover...
The Transaction is dependent on the Account setting to
ensure the Country of Crigin and used to determine any
need for VAT or G5T.

Leon: Started howewver awaiting a finalization on
[ the Transaction requirements for VAT

Note that an Actor element defaults to the Rectangular Notation on a Construction diagram.
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Project Issues

You can record and review issues - events, occurrences and situations that impact on project development and delivery -
against the current project using the Project Issues view and its 'Issue Detail' dialog . For each Issue, you record the
description, date, owner and status. You can also generate a document report on the issue items.

Access

Ribbon Construct > Project Management > Issues-Tasks > Project Issues

Operations

Operation

Add, delete and modify Issues using the 'Issue Details' dialog.

Generate and view a rich text format report of your issue list

Notes

®  You can transport these issue definitions between models, using the 'Settings > Model > Transfer > Export
Reference Data' and 'ITmport Reference Data' ribbon options

e To print out the currently displayed items, select the 'Print List' context menu option
e You can re-organize the display of the listed tasks using the List Header facilities for reported information

e In the Corporate, Unified and Ultimate Editions of Enterprise Architect, if security is enabled you must have
'Manage Issues' permission to update and delete Issues records
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Add, Delete and Modify Issues

You can maintain project issue records using the 'Issue Detail' dialog from the Project Issues view.

Access

Ribbon Construct > Project Management > Issues-Tasks > Project Issues

Maintain Project Issues

Step Action

1 If creating a new issue, double-click in a blank area to display the Tssue Detail' dialog and complete the
blank fields.

If editing an existing item, double-click on the item to display the 'Issue Detail' dialog and edit the fields.

2 Enter or update these issue details, selecting a value from the field's drop-down list where appropriate:
e The issue name

e Automatic naming - if you have set up automatic naming conventions, click on the Auto button to
insert the predefined element name and counter text; if you already have some text in the Name'
field, it is over-written by the automatic naming text

e  The issue priority

e The date the issue was raised

e  The issue status

e  The issue owner

e A description of the issue

e The date on which the issue was resolved (select the checkbox to activate the date)
e  The name of the person who resolved the issue

e  Any comments on the resolution

3 Click on the Apply button.

4 If the issue is closed (and all the 'Resolution' fields are completed), click on the Close Issue button.

5 To create another entry click on the New button or, to close, click on the OK button.

6 To delete an issue in the Project Issue view, right-click on the entry and select the 'Delete’ option, then

click on the Yes button on the confirmation prompt.

Notes
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®  You can filter the list of issues by status, to show all issues or just Open, Closed or Under Review issues, using the
'Set term filter' context menu option
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You can generate a document report on your project issue records from the Project Issue view.

Access

Ribbon Construct > Project Management> Issues-Tasks > Project Issues > Right-click on

Issues list > Create Report

The 'Save As' dialog displays.

Generate your project issues report

Step Action

1 Browse for and select the appropriate file location.

In the 'File name' field, type the file name for the report.

2 Click on the Save button.

A status message displays when the report has been generated.

3 Click on the OK button and then on the View RTF button.

The report displays in your default viewer.
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Report Output Sample

This is an example of the output of an Issues report.

List of Project Issues: 24-Jul-2010 9:47:00 AM

Issue

Date/Owner

Description

Resolution

Test servers will be delaved

24/07/2014 Eloise Norman

The test server builds have been delayed
because the particular (unusual) memory
requirements to match the customer's site
are not available on shore. They are being
sourced from Singapore but it will delay the
builds and delivery of the machines.

Closed: 24/07/2014 Geoffrey
Sparks

The machines will be built and
delivered using standard memory
and the proprietary memory will
be added later. All performance
tests will be delaved untl the
memory is available.

downloaded different versions of a number
of the compilers. This has lead to
unpredictable builds impacting on testing.

Public Holidays 24/07/2014 Joanna Stoat The schedule includes staff working on Open: 24/07/2014
public holidays. A mumber of staff have
indicated that contrarv to what they stated
earlier they are not available.
Compiler Version disparity  |24/07/2014 Eloise Norman | A number of the developers have Under Review: 24/07/2014
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Project Tasks

The Project Tasks view provides a convenient 'To Do' list of major project work items that are not recorded elsewhere. It
can be used to track events such as requests or corrections.

Access

Ribbon Construct > Project Management > Issues-Tasks > Project Tasks

Notes

e Right-click on the list to view the context menu, and select to add, modify or delete tasks, or to set a status filter
e You can re-organize the display of the listed tasks using the List Header facilities for reported information
e To print out the currently displayed items, select the 'Print List' context menu option

®  You can transport task definitions between models using the 'Settings > Model > Transfer > Export Reference Data'
and 'ITmport Reference Data' options

e You can add or work on an item in the Project Tasks view by right-clicking (context menu) or double-clicking on
the blank or completed item line

e  The Project Tasks view context menu has options for filtering tasks and issues by status; you can also re-arrange the
sort-order by clicking in the title bar of the column that the items are to be indexed on
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Add, Modify and Delete Tasks

To add, edit and delete project tasks you can work in either the Project Tasks view, or the Project Calendar.

Access

Ribbon

Construct > Project Management > Issues - Tasks > Project Tasks

Start > Collaborate > Calendar > Project Tasks mode

Maintain Tasks

Step Action

1 If creating a new task:

Double-click in a blank area of the Project Tasks view, or on a cell of the Calendar

If editing an existing item:

Double-click on the item on the Project Tasks view or Calendar

The 'Task Detail' dialog displays.

2 Enter or update these details of the task, selecting a value from the field's drop-down list where
appropriate:

The task name

Automatic naming - if you have set up automatic naming conventions, click on the Auto button to
insert the predefined element name and counter text; if you already have some text in the Name'
field, it is over-written by the automatic naming text

The task type

The task owner

The expected start and end date for the task (select the checkboxes to activate the dates)
The current status of the task

The person this task has been assigned to

The task priority, such as high, medium, low or undetermined

The expected total time for the task and the actual time expended (in complete units; the type of unit
must be agreed across the project)

The percentage completion

The phase associated with this task

A description of the task

Any progress history appropriate to the task

3 Click on the Apply button.
4 To create another entry click on the New button or, to close, click on the OK button.
5 To delete a task, in the Project Tasks view:
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1. Right-click on the task and select the 'Delete’ option

2. Click on the Yes button on the confirmation prompt

Notes

e 'Owner' and 'Assigned' fields are filled from the Project Authors, Resources and Project Clients
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Update Package Status

Often a complete Package structure moves from one status to another (such as for release) in one operation. To help
facilitate this, Enterprise Architect supports a 'bulk' update of Package and element Status, Phase, and Version, which
also provides the option of defining the scope of the update.

Access

Ribbon Design > Package > Manage > Update Status

Update Status across a Package

Field Action
New Status Type in or select the new status of the Package.
New Phase Type the new phase.

New Version
Modified Date

Set Date

Recursively update all
child packages

Include Elements

Include Element
Requirements

Include Element
Constraints

OK

(c) Sparx Systems 2025

Type the new version.
System set; you cannot change this field.

Defaults to selected to apply the Modified Date; if necessary, deselect to ignore the
date stamp on the change.

Select to apply the changes through all child Packages of the selected Package;
deselect to apply the changes to only the selected Package.

Defaults to selected; if the changes are to apply only to Package elements, deselect
the checkbox.

Defaults to selected, to update the element requirements' 'Status' field; deselect to
ignore this field.

Defaults to selected, to update the constraints' 'Status' field; deselect to ignore this
field.

Click on this button to update all required elements to the new status.
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Monitor Change Events

You can automatically monitor work events in your project, using the Model Views facility.

Guide
Aspect Detail
Model Views This facility enables you to:
e Automatically refresh a search in a View at an interval that you define
e Notify you if the results of the search change between two consecutive
searches
You can therefore use Model Views to monitor various events in the development
project, depending on how you set up the search in a View.
Example You could set up a search to detect:
e Change items, or Issue items, so that Enterprise Architect would notify you as
new items were created
e Element Status, Type, Phase, Version, Priority and/or date of last update, so
that Enterprise Architect would notify you as items were progressed to:
- Fall in to the level of work represented by the search categories
- Move out of the categories into the next level of work
e Tagged Values, so that - again - as items were changed to satisfy the criteria of
a sequence of searches, the progression of items through a set of stages could
be checked and managed
Personalization People responsible for different stages in a process could have their own Model
View searches so that:
e Asadevelopment, validation or authorization task falls due the responsible
person is automatically notified, and
e When the work is complete both the next person in line and the overseeing
manager are notified
Notes

e  This facility is available in the Enterprise Architect Corporate, Unified and Ultimate Editions
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Model Watches

Enterprise Architect provides you with the facility to watch for a range of activities linked to your user ID, across not just
one project but any or all of those to which you have access. This helps you to stay up to date with changes,
developments and conversations in the projects in which you are working or have an interest.

Specifically, you can set up a Watchlist to notify you of:
e New model chats

e New model messages

e Recent element discussions

e  Recent team reviews

e Recently flagged watched items
e Recently modified diagrams

e Recently modified elements

e Active tasks

e Tasks ending today, and/or

e Tasks overdue

You can monitor for these events in the project or projects from a specific date onwards, or over a rolling interval of time
such as the previous seven days.

Access

Other Start page > Recent drop-down arrow > Configure Watched Models

Configure a Watchlist

Manage Models

Showing Activity From:  3L/08/2017 =
Relative Time
Connections New Configure Delete
Enabled Connection Name User Name Password
b test
5.4 Cancel Help
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Step Description

1 In the 'Showing Activity From' field, click on the drop-down arrow and select the date from which to start
monitoring events.

If you want to accumulate information over time, leave the 'Relative Time' checkbox unselected to collect
the data starting from the set date as the absolute date.

If you want to show information gathered only over the previous fixed interval, select the checkbox. The
system then calculates the interval between the set date and today, displaying the length of that interval
next to the date field. Adjust the selected date to give you the interval you require. The system will then
provide information gathered only during that interval, rolling forward.

2 Click on the New button to add a project to the Watchlist. A short menu displays, offering options to
access the project through a:

e Local file path - a browser displays through which you locate and select the project file

e  Connection Wizard - the Windows 'Data Link Connection' dialog displays through which you can
open a model on a DBMS

e Cloud Connection - the 'Cloud Connection' dialog displays; ensure that all the connection details are
correct

e  Connection string that you have copied - the 'Connection String' dialog displays; paste the copied
string into the 'Enter Value' field and click on the OK button

The name of the project displays in the 'Connections' panel, with the 'Enabled' checkbox automatically
selected. At any point, if you want to drop the project out of the watch, you can simply de-select the
'Enabled' checkbox.

In the 'User Name' and '"Password' fields, type the login parameters necessary for the system to open the
watched model under your ID.

3 Click on the connection name and then on the Configure button. The 'Model Watchlist' dialog displays.

Model Watch List X

Check each item you wish to view.

Display -
Mew model chats

Mew model messages

Recent element discussions
Recent team reviews

Recent watched items

Recently modified diagram
Recently modified elements

Tasks active

05 1 1A IS [S 1A 18] (S

Tasks ending today

Select All | Clear All

DK Cancel

Click on each checkbox to select the items to monitor, or to clear selected items as required. You can also
use the Select All button or Clear All button to act on all items at once, and then select or clear individual
items. When you have made your selection, click on the OK button to save the changes.

On the 'Manage Models' dialog, click on the OK button to save the model Watch and close the dialog.

To check for any events picked up by your Watchlist, on the Start page click on the 'Models' drop-down
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4 arrow and select the 'Watched' option. The list of recently-accessed projects is updated to show just those
included in your Watchlist.

The message 'Querying watched models' displays, followed by a login prompt for each project that has
controlled access. Type in your login parameters.

Under each project name, a summary list of the watched items and events is displayed.

)

ritie

cently modined element|s

You can review the flagged items by clicking on the watched model name and running the appropriate
Model Search or displaying the Discussions window. This closes the original project in which you
checked the Watchlist.

5 After you have checked the Watched projects, and if necessary, you can click on the "Models' drop-down
arrow and select the 'Configure Watched Models' option to update the Watchlist configuration, as in steps
1,2 and 3.

If it is necessary to remove a project entirely from the Watchlist, on the 'Manage Models' dialog click on
the project name and on the Delete button.

If you have finished working with the Watchlist, click on the 'Models' drop-down arrow and select the
'Recently Used' option to restore the model list to the full list of recently-accessed models.
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Use Case Estimation

Project estimation is the task of working out how much time and effort is required to build and deploy a solution.

The Use Case metrics facility in Enterprise Architect provides a starting point for estimating project effort; using this
facility you can get a rough measure of the complexity of a system and some indication of the effort required to
implement the model. Like all estimation techniques, Use Case metrics requires some experience with previous projects
to 'calibrate' the process.

There is additional information available on Use Case metrics on the Sparx Systems website.

Access
Ribbon Settings > Reference Data > Model Types > Estimation Factors
Processes
Process Description
Calibrating These values must be carefully calibrated in order to gain the best possible
estimates:
e Technical Complexity Factors, which are values that attempt to quantify the
difficulty and complexity of the work in hand
e  Environment Complexity Factors, which are values that attempt to quantify
non-technical complexities such as team experience and knowledge
e Default Hour Rate, which sets the number of hours per Use Case point
Estimating Once you have entered all the calibration values, you can estimate the project

timescale through the 'Use Case Metrics' tab of the QA Reports View.

The estimation process also draws on information on Use Cases recorded on the
'Resource Allocation' tab.
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Technical Complexity Factors

Technical Complexity Factors (TCFs) are used in the Use Case Metrics estimation technique.

The EABase.qea and EABase.cap model contains a default set of TCFs, which you can add to or modify using the
'Estimation Factors' dialog. This set of factors should include all factors that could affect the technical complexity of the
project environment.

Access

Ribbon Settings > Reference Data > Model Types > Estimation Factors > Technical
Complexity Factors

Maintain Technical Complexity Factors

Step Action

1 On the 'Technical Complexity Factors' tab, either:
e  (Click on the New button to add another TCF, or
e  Click on the required factor in the 'Defined Technical Types' list to edit it (go to step 3)

2 In the 'Factor Number' field, type the appropriate TCF number.
3 In the 'Description’ field, type or edit the TCF description.
4 In the 'Weight' field, type or edit the technical complexity weighting.

This indicates how much technical complexity you assign to a factor; for example, 'the system is to be
developed in ADA' might warrant a higher weight than 'the system is to be a shell script'.

5 In the 'Value' field, type or edit a value representing the degree of influence the factor has on the project.
As a suggested gauge:
e 0 indicates no influence
e 3 indicates average influence

e 5 indicates strong influence

6 Click on the Save button.
7 Examine the 'Defined Technical Types' list, and scroll across it to show the 'Ex Value' column (Weight x
Value).

The summed Ex Values yield the 'Unadjusted TCF value' (at the bottom of the dialog).

The "Unadjusted TCF value' is combined with the Environment Complexity Factors to skew the overall
complexity up or down, depending on the level of technical complexity and the corresponding level of
environmental support.
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Notes

e The TCF Weight evaluates its respective factor, but is irrelevant to a project; the 'Value' field assesses each factor's
role within a project and, for most purposes, is the only field requiring adjustment

e The supplied factors and their associated weights are defined by the Use Case Points Method, although they can be
adjusted to suit a project's specific requirements

e You can transport the Technical Complexity Factors between models, using the 'Settings > Model > Transfer >
Export Reference Data' and 'Import Reference Data' ribbon options
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Environment Complexity Factors

Environment Complexity Factors (ECFs) are used in the Use Case Metrics estimation technique.

The EABase.qea and EABase.cap models contain a default set of ECFs, which you can add to or modify using the
'Estimation Factors' dialog. This set of factors should include all factors that could affect the general design and
development environment, including team experience and knowledge, team size, expertise and other non-functional
environmental factors.

Access

Ribbon

Settings > Reference Data > Model Types > Estimation Factors > Environment
Complexity Factors

Maintain Environment Complexity Factors

Step

1

Action

On the 'Environment Complexity Factors' tab, either:
e  (Click on the New button to add another ECF, or
e  Click on the required factor in the 'Defined Environment Types' list to edit it (go to step 3)

In the 'Factor Number' field, type the appropriate ECF number.
In the 'Description' field, type or edit the ECF description.

In the 'Weight' field, type or edit the environment complexity weighting.

This indicates how much complexity you assign to a factor.

In the 'Value' field, type or edit a value representing the degree of influence the factor has on the project.
As a suggested gauge:

e 0 indicates no influence

e 3 indicates average influence

e 5 indicates strong influence
Click on the Save button.

Examine the 'Defined Environment Types' list, and scroll across it to show the 'Ex Value' column (Weight
x Value).

The summed Ex Values yield the 'Unadjusted ECF' value (at the bottom of the dialog).

The Unadjusted ECF value is combined with the Technical Complexity Factors to skew the overall
complexity up or down, depending on the level of technical complexity and the corresponding level of
environmental support.
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Notes

e The ECF Weight evaluates its respective factor, but is irrelevant to a project; the 'Value' field assesses each factor's
role within a project and, for most purposes, is the only field requiring adjustment

e The supplied factors and their associated weights are defined by the Use Case Points Method, although they can be
adjusted to suit a project's specific requirements

e  You can transport the Environment Complexity Factors between models, using the 'Settings > Model > Transfer >
Export Reference Data' and 'Import Reference Data' ribbon options
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Default Hours

Setting an hourly rate is the most difficult factor in an accurate estimation. Typical ranges can vary from 10 to 30 hours
per Use Case point.

Studying the Use Case Points Method, from which this variable is defined, can help you to understand its role in the
estimation and facilitate selection of a suitable initial value.

The best way to estimate this value is through analysis of previous completed projects. By calculating the project
estimation on a completed project for which the Use Cases and environment are configured within Enterprise Architect,
you can adjust the hour rate to render an appropriate value for your unique work environment.

Access

Ribbon Settings > Reference Data > Model Types > Estimation Factors > Default Hour
Rate

Set the default hour rate per adjusted Use Case point

Step Action

1 In the 'Duration' field, type the number of hours per Use Case Point.
2 In the 'Hourly Rate' field, type the cost per hour.
3 Click on the Close button.

Notes

e  The values you enter are stored as local settings on your computer only

e This option is also active in the 'Lite', read-only version of Enterprise Architect
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Estimating Project Size

Enterprise Architect uses a simple estimation technique based on the established:
e Number of Use Cases to be built

e Difficulty level of those Use Cases

e  Project environment factors and

e  Build parameters

This technique is of value only once you have developed a couple of known projects to use as a baseline. Please DO
NOT use the provided 'guesstimates' as a real world measure until you have some real world base lines to measure
against.

Access

Ribbon Click on the required Package in the Browser window, then:

Construct > Project Management > QA > QA Reports > Use Case Metrics

Complete a Use Case Metrics Estimation

Field Action

Root Package Confirm the root Package in the hierarchy.
All Use Cases under this Package could potentially be included in the report.

Reload Re-run the load from the selected Package, usually after you change the filter
criteria.
Phase like Include Use Cases with a phase that matches the wildcard value in the field.

Use * to match any characters; for example, 1.* for 1.1 and 1.2.

Keyword like Include Use Cases with a keyword that matches the wildcard value in the field.

Use * to match any characters.
Bookmarked Include all Use Cases, or only those that are tagged, or those that are not tagged.

Use Cases Check the total count of Use Cases in the estimate.

The Use Cases and their parameters are listed in the panel underneath this field.

Include Actors Select to include Actors in the estimate.
Technical Complexity Review the parameters that describe the degree of technical complexity of the
Factor project.

While the 'Unadjusted TCF Value' comes from the 'Technical Complexity Factors'
tab of the 'Estimation Factors' dialog, the other values compose the Use Case Points
Method formula.
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Modify these fields with caution.
The final project estimate is directly proportional to the TCF.

Environment Complexity Review the parameters that calculate the degree of environmental complexity of the
Factor project, from factors such as programmer motivation or experience.

The listed parameters compose the formula calculating the ECF, defined by the Use
Case Points Method; the only parameter affected by the project is the Unadjusted
ECF Value, derived from the 'Environment Complexity Factors' tab of the
'Estimation Factors' dialog.

The final project estimate is directly proportional to the ECF.

Unadjusted Use Case Check the sum of the Use Case complexity numbers.

Points (UUCP)

Ave Hours per Use Case Check the average number of hours assigned to easy, medium and difficult Use
Cases.

You cannot change these figures.

Total Estimate Review the detailed breakdown of the final figure.

You must tailor the hours per Use Case Point figure to the level that matches your
type of project and capability based on known previous project outcomes.

Default Rate Set the default number of hours to be fed into the final calculation.

Re-Calculate Re-run the estimate, usually after you change the hours or Use Case point number.
Report Produce a rich text formatted report from the current estimate.

View Report Display the last-generated report.
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